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C H A P T E R 1
Introduction

• Introduction, on page 1

Introduction

Integration Description
Cisco\\ Unity Connection supports PIMG integrations with the following phone systems.

Table 1: Supported Phone Systems for PIMG Integrations

Supported PIMG UnitsIntegration TypePhone System

Analog PIMG units (PIMG80LS
or DMG1008LS)

DTMF (analog)Alcatel 4400

Analog PIMG units (PIMG80LS
or DMG1008LS)

Serial (SMDI, MCI, or MD-110)Any phone system that provides a
serial data link (SMDI, MCI, or
MD-110 protocol) to the master
PIMG unit

Digital PIMG units
(PIMG80PBXDNI or
DMG1008DNI)

DigitalAvaya Definity G3

Digital PIMG units
(PIMG80PBXDNI or
DMG1008DNI)

DigitalAvaya Definity ProLogix

Digital PIMG units
(PIMG80PBXDNI or
DMG1008DNI)

DigitalAvaya S8300, Avaya S8500, and
Avaya S8700

Digital Mitel PIMG units
(PIMG80MTLPBXDNI or
DMG1008MTLDNI)

DigitalMitel SX-200

PIMG Integration Guide for Cisco Unity Connection Release 12.X
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Supported PIMG UnitsIntegration TypePhone System

Digital Mitel PIMG units
(PIMG80MTLPBXDNI or
DMG1008MTLDNI)

DigitalMitel SX-2000

Digital PIMG units
(PIMG80PBXDNI or
DMG1008DNI)

DigitalNEC NEAX 2400

Digital PIMG units
(PIMG80PBXDNI or
DMG1008DNI)

DigitalNortel Meridian 1 (includes
Succession and SL 1)

Digital Rolm PIMG units
(PIMB80RLMPBXDNI or
DMG1008RLMDNI)

DigitalRolm 9751 9005

Digital Rolm PIMG units
(PIMB80RLMPBXDNI or
DMG1008RLMDNI)

DigitalRolm 9751 9006

Analog PIMG units (PIMG80LS
or DMG1008LS)

DTMF (analog)Siemens Hicom 150

Analog PIMG unit (PIMG80LS or
DMG1008LS)

DTMF (analog)Siemens Hicom 300 E (European)

Digital PIMG units
(PIMG80PBXDNI or
DMG1008DNI)

DigitalSiemens Hicom 300-series E
(North American)

Analog PIMG units (PIMG80LS
or DMG1008LS)

DTMF (analog)Siemens Hipath 3550

Analog PIMG units (PIMG80LS
or DMG1008LS)

DTMF (analog)Siemens Hipath 4000

Digital Integration with Digital PIMG Units
The phone system sends call information, MWI requests, and voice connections through the digital lines,
which connect the phone system to the PIMG units (media gateways). The PIMG units communicate with
the Unity Connection server through the LAN or WAN using Session Initiation Protocol (SIP). Figure 1-1
shows the required connections for a digital integration using digital PIMG units.
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Figure 1: Figure 1-1 Connections for a Digital Integration by Using Digital PIMG Units

DTMF Integration with Analog PIMG Units
The phone system sends call information, MWI requests, and voice connections through the analog lines,
which connect the phone system to the PIMG units (media gateways). The PIMG units communicate with
the Unity Connection server through the LAN or WAN using Session Initiation Protocol (SIP). Figure 1-2
shows the required connections for a DTMF integration using analog PIMG units.
Figure 2: Figure 1-2 Connections for a DTMF Integration by Using Analog PIMG Units

Serial (SMDI, MCI, or MD-110) Integration with Analog PIMG Units
The phone system sends call information and MWI requests through the data link, which is an RS-232 serial
cable that connects the phone system and the master PIMG unit (media gateway). Voice connections are sent
through the analog lines between the phone system and the PIMG units. The PIMG units communicate with
the Unity Connection server through the LAN or WAN using Session Initialization Protocol (SIP). Figure
1-3 shows the required connections for a serial integration using analog PIMG units.
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Figure 3: Figure 1-3 Connections for a Serial (SMDI, MCI, or MD-110) Integration by Using Analog PIMG Units

Call Information
The phone system sends the following information with forwarded calls:

• The extension of the called party

• The extension of the calling party (for internal calls) or the phone number of the calling party (if it is an
external call and the system uses caller ID)

• The reason for the forward (the extension is busy, does not answer, or is set to forward all calls)

Unity Connection uses this information to answer the call appropriately. For example, a call forwarded to
Unity Connection is answered with the personal greeting of the user. If the phone system routes the call without
this information, Unity Connection answers with the opening greeting.

Serial integrations send requests to turn on and turn off MWIs through the data link.Note

Integration Functionality
The PIMG integration provides the following integration features:

• Call forward to personal greeting

• Call forward to busy greeting

• Caller ID

• Easy message access (a user can retrieve messages without entering an ID because Unity Connection
identifies the user based on the extension from which the call originated; a password may be required)

• Identified user messaging (Unity Connection identifies the user who leaves a message during a forwarded
internal call, based on the extension from which the call originated)

PIMG Integration Guide for Cisco Unity Connection Release 12.X
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• Message waiting indication (MWI)

Integrations with Multiple Phone Systems
Unity Connection can be integrated with two or more phone systems at one time. For information on the
maximum supported combinations and instructions for integrating Unity Connection with multiple phone
systems, see theMultiple Phone System Integration Guide for Cisco\\ Unity Connection Release 12.x at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/integration/guide/multiple_integration/b_cuc12xintmultiple.html.

Centralized Voice Messaging
Unity Connection supports centralized voice messaging through the phone system, which supports various
inter-phone system networking protocols including proprietary protocols such as Avaya DCS, Nortel MCDN,
or Siemens CorNet, and standards-based protocols such as QSIG or DPNSS. Note that centralized voice
messaging is a function of the phone system and its inter-phone system networking, not voicemail. Unity
Connection supports centralized voice messaging as long as the phone system and its inter-phone system
networking are properly configured. For details, see the “Centralized Voice Messaging” section in the
“Integrating Cisco Unity Connection with the Phone System” chapter of the Design Guide for Cisco Unity
Connection Release 12.x at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/design/guide/b_12xcucdg.html.
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C H A P T E R 2
Planning the Usage of Voice Messaging Ports

See the following sections in this chapter:

• Planning the Voice Messaging Ports, on page 7

Planning the Voice Messaging Ports

Planning the Port Setup
Before programming the phone system, you need to plan how the voicemessaging ports are used by CiscoUnity
Connection. The following considerations affect the programming for the phone system (for example, setting
up the hunt group or call forwarding for the voice messaging ports):

• The number of voice messaging ports installed.

For a Unity Connection cluster, each server must have enough ports to handle all voice messaging traffic in
case the other server stops functioning.

• The number of voice messaging ports that answer calls.

• The number of voice messaging ports that only dial out, for example, to send message notification, to
set message waiting indicators (MWIs), and to make telephone record and playback (TRAP) connections.

To configure settings for the voice messaging ports in Unity Connection, navigate to Cisco Unity Connection
Administration, expand Telephony Integrations and select Ports. Select an applicable port and modify the
settings on Port Basics page. For more information on configuring ports, see the “Configuring Ports” section
of the “Telephony Integration” chapter of the System Administration Guide for Cisco Unity Connection,
Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/administration/guide/b_12xcucsag.html.

Determining the Number of Voice Messaging Ports
The following tasks describe the process for determining the number of voice messaging ports for Cisco Unity
Connection to install, answer call and dial out calls:

• For determining the number of voice messaging ports to Install, see Voice Messaging Ports to Install.

PIMG Integration Guide for Cisco Unity Connection Release 12.X
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• For determining the number of voice messaging ports to Answer Calls, see Voice Messaging Ports to
Answer Calls.

• For determining the number of voice messaging ports to Dial Out, see Voice Messaging Ports that Dial
Out.

Voice Messaging Ports to Install
The number of voice messaging ports to install depends on numerous factors, including:

• The number of calls Unity Connection answers when call traffic is at its peak.

• The expected length of each message that callers record and users listen to.

• The number of users.

• The number of ports set to dial out only.

• The number of calls made for message notification.

• The number of MWIs activated when call traffic is at its peak.

• The number of TRAP connections needed when call traffic is at its peak. (TRAP connections are used
by Unity Connection web applications to play back and record over the phone.)

• The number of calls that use the automated attendant and call handlers when call traffic is at its peak.

• Whether a Unity Connection cluster is configured. For considerations, see the Considerations for a Unity
Connection Cluster.

It is best to install only the number of voice messaging ports that are needed so that system resources are not
allocated to unused ports.

Voice Messaging Ports to Answer Calls
The calls that the voice messaging ports answer can be incoming calls from unidentified callers or from users.
Typically, the voice messaging ports that answer calls are the busiest.

You can set voice messaging ports to both answer calls and to dial out (for example, to send message
notifications). However, when the voice messaging ports perform more than one function and are very active
(for example, answering many calls), the other functions may be delayed until the voice messaging port is
free (for example, message notifications cannot be sent until there are fewer calls to answer). For best
performance, dedicate certain voice messaging ports for only answering incoming calls, and dedicate other
ports for only dialing out. Separating these port functions eliminates the possibility of a collision, in which
an incoming call arrives on a port at the same time that Unity Connection takes the port off-hook to dial out.

If your system is configured for a Unity Connection cluster, see the Considerations for a Unity Connection
Cluster.

Voice Messaging Ports that Dial Out
Ports that only dial out and not answer calls can do one or more of the following:

• Notify users by phone, pager, or email of messages that have arrived.

PIMG Integration Guide for Cisco Unity Connection Release 12.X
8

Planning the Usage of Voice Messaging Ports
Voice Messaging Ports to Install



• Turn MWIs on and off for user extensions.

• Make a TRAP Unity Connection so that users can use the phone as a recording and playback device in
Unity Connection web applications.

Typically, these voice messaging ports are the least busy ports.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Send MWI Requests, do not send calls to it.

Caution

Considerations for a Unity Connection Cluster
If your system is configured for a Unity Connection cluster, consider how the voice messaging ports are used
in different scenarios.

When Both Unity Connection Servers are Functioning
• The number of ports provisioned on the phone system is the same as the number of voice messaging
ports on each Unity Connection server.

• The PIMG units are configured to send incoming calls first to the subscriber server, then to the publisher
server if no answering ports are available on the subscriber server.

• The PIMG units are configured to balance the voice messaging traffic between the Unity Connection
servers.

• Both Unity Connection servers are active and handle voice messaging traffic for the system.

• The number of voice messaging ports on each Unity Connection server must be sufficient to handle all
of the voice messaging traffic for the system (answering calls and dialing out) when the other Unity
Connection server stops functioning.

If both Unity Connection servers must be functioning to handle the voice messaging traffic, the system do
not have sufficient capacity when one of the servers stops functioning.

• Each Unity Connection server must have voice messaging ports that answer calls and that can dial out
(for example, to set MWIs).

When Only One Unity Connection Server is Functioning
• PIMG units send all calls to the functioning Unity Connection server.

• The functioning Unity Connection server receives all voice messaging traffic for the system.

• The number of voice messaging ports that are assigned to the functioning Unity Connection server must
be sufficient to handle all of the voice messaging traffic for the system (answering calls and dialing out).

• The functioning Unity Connection server must have voice messaging ports that answer calls and that
can dial out (for example, to set MWIs).

PIMG Integration Guide for Cisco Unity Connection Release 12.X
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If the functioning Unity Connection server does not have voice messaging ports for answering calls, the system
cannot answer incoming calls. Similarly, if the functioning Unity Connection server does not have voice
messaging ports for dialing out, the system cannot dial out (for example, to set MWIs).

PIMG Integration Guide for Cisco Unity Connection Release 12.X
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C H A P T E R 3
Setting Up an Alcatel 4400 Analog PIMG
Integration

For detailed instructions for setting up an Alcatel 4400 analog PIMG integration with Cisco Unity Connection,
see the following sections in this chapter:

• Setting Up Alcatel 4400 Analog PIMG Integration, on page 11

Setting Up Alcatel 4400 Analog PIMG Integration

Task List for Alcatel 4400 PIMG Integration
Before doing the following tasks to integrate Unity Connection with the Alcatel 4400 phone system using
PIMG units (media gateways), confirm that the Unity Connection server is ready for the integration after
completing the server installation, following the tasks in the “Installing Cisco Unity Connection” chapter of
the Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Unity Connection
server requirements have been met. See the Requirements section.

2. Plan how the voice messaging ports are used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports, on page 7 chapter.

3. If you have a legacy voice messaging system, clear the MWIs for subscribers who are migrating to Unity
Connection. See the Clearing MWIs from a Legacy Voice Messaging System section.

4. Program the Alcatel 4400 phone system and extensions. See the Programming Alcatel 4400 Phone System
for Integration section.

5. Set up the PIMG units.

6. Create the integration. See the Configuring Unity Connection for Integration with the Alcatel 4400 Phone
System, on page 29 section.

7. Test the integration. See the Testing the Integration, on page 401 chapter.

8. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Adding New User Templates for Multiple Integrations, on page 407 chapter.
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Requirements
This integration supports configurations of the following components:

Phone System
• Alcatel 4400.

• Software version 3.1 or later.

• The following features are enabled:

• VPS (option 21; the value must equal the number of voice messaging ports in the hunt group for
Cisco Unity Connection)

• CLIonVPS_SL (option 121; the value must equal the number of voice messaging ports in the hunt
group for Unity Connection)

• One or more of the applicable PIMG units. For details, see the Introduction, on page 1 chapter.

• The voice messaging ports in the phone system connected by analog lines to the ports on the PIMG units.

You should connect the voice messaging ports on the phone system to the ports on the PIMG units in a planned
manner to simplify troubleshooting. For example, the first phone system voice messaging port connects to
the first port on the first PIMG unit, the second phone system voice messaging port connects to the second
port on the first PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.

Clearing MWIs from a Legacy Voice Messaging System
If users do not have existing voicemail on a legacy voice messaging system, skip this section and continue
with the next section.

If users have existing voicemail on a legacy voice messaging system, do the following procedure.
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Step 1 Have all users who are migrating to Unity Connection delete or listen to their voice messages on the legacy voice messaging
system.

Step 2 Confirm that all MWIs for the subscribers migrating to Unity Connection are turned off.

Programming Alcatel 4400 Phone System for Integration
The following programming instructions are provided as an example only. The specific programming for your
phone system may vary depending on its configuration.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Send MWI Requests, do not send calls to it.

Caution

•

Programming through the Command Line Interface (CLI)

Step 1 On the Alcatel 4400 console, sign in to the configuration interface.
Step 2 In the Generic Configuration Software window, go to Categories > Phone Facilities Category.
Step 3 Select the category that you use and select Edit.
Step 4 Under Local Services, confirm the following settings and select OK.

Table 2: Settings for Phone Facility

SettingField

1Consult Message

1Switch Off Message LED

Step 5 In the Generic Configuration Software window, go to Translator > 1 > Prefix Plan and select Create.
Step 6 In the Prefix Plan dialog box, enter the following settings to turn MWIs on, and select OK.

Table 3: Settings for Turning MWIs On

SettingField

<the code that turns MWIs on>Number

Local FeaturesPrefix Meaning

Consult MessageLocal Features

Step 7 In the Prefix Plan dialog box, enter the following settings to turn MWIs off, and select OK.
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Table 4: Settings for Turning MWIs Off

SettingField

<the code that turns MWIs off>Number

Local FeaturesPrefix Meaning

Switch Off Message LEDLocal Features

Step 8 In the Prefix Plan dialog box, select Close.
Step 9 In the Generic Configuration Software window, go to Users and select Create.
Step 10 In the Users dialog box, enter the following settings for the first voice messaging port and all other settings required

for the configuration of the phone system.

Table 5: Settings for the Voice Messaging Port

SettingField

<the extension number of the voice messaging port>Directory Number

4620 (VPS + CLIP)Set Type

Step 11 In the Users dialog box, select OK.
Step 12 Repeat Step Step 1 and Step Step 2 for all remaining voice messaging ports.
Step 13 In the Generic Configuration Software window, go to Groups > 1 > Hunting Group, and select Create.
Step 14 In the Hunting Group dialog box, enter the following settings.

Table 6: Settings for the Hunt Group

SettingField

<the pilot number of the hunting group for the voice
messaging ports>

Directory Number

RSVP Hunting GroupType of Hunting Group

SequentialSearch Type

Step 15 Scroll down to the Dir. No Allocated to the Group field (in the middle of the dialog box), and select the magnifying
glass icon.

Step 16 In the Set of Dir. No Allocated to the Group dialog box, enter the extension number of the first voice messaging port
in the hunting group and select Add.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot answer
calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port is set only to
Send MWI Requests, do not send calls to it.

Step 17 Repeat Step 16 for all remaining voice messaging ports that you want to include in the hunting group, and select OK.
Step 18 In the Hunting Groups dialog box, select OK.
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Step 19 Program each phone to forward calls to the pilot number assigned to the voice messaging ports, based on one of the
Unity Connection call transfer types shown in Table 3-6.

Table 7: Call Transfer Types

UsageTransfer Types

Program the phone to forward calls to the pilot number
when:

• The extension is busy

• The call is not answered

Release transfer (blind transfer)

Program the user station to forward calls to the pilot
number only when the call is not answered (on the phone
system, the number of rings before forwarding must be
more than the number of rings to supervise the call).
Confirm that call forwarding is disabledwhen the extension
is busy.

Supervised transfer

Setting Up the Analog PIMG Units for a DTMF Integration
Do the following procedures to set up the analog PIMG units connected to the Alcatel 4400 phone system for
a DTMF integration.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the PIMG units using analog lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the PIMG units.

Downloading the PIMG Firmware Update Files for Analog PIMG Units
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.
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To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

1. In the tree control on the Downloads Home page, expand Unified Communications> Unified
Communications Applications > Messaging > Cisco Unity and select Cisco Unity Telephony
Integration.

2. On the Log In page, enter your username and password and select Log In.

3. On the Select a Release page, under Latest Releases, select the most recent release.

4. In the right column, select the version of the firmware for analog PIMG units.

5. On the Download Image page, select Download.

6. On the Supporting Document(s) page, select Agree.

7. In the File Download dialog box, select Save.

8. In the Save As dialog box, browse to theWindows workstation that have access the PIMG units, browse
to a directory where you want to save the file, and select Save.

9. In the Download Complete dialog box, select Open. The window for extracting the PIMG firmware
update files appears and select Extract.

10. In the Extract dialog box, browse to the directory where you want the extracted files and selectExtract.

11. Close the window for the extracting application.

Note

On a Windows workstation that have access to the PIMG units, go to the following link:

Setting Up the Analog PIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the PIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 2 Connect a PIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.
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Table 8: Sign-in Settings

SettingsField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
Step 7 On the Upgrade page, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted PIMG firmware

update files.
Step 9 Select Ls_<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.

Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file installation fails.
Restarting the PIMG unit at this step may prevent the PIMG unit from functioning correctly.

Step 12 Repeat Step 6 through Step 11 for the file Run_<xx > .dsp.
Step 13 On the System menu, select Upgrade.
Step 14 On the Upgrade page, under Import, select Browse.
Step 15 In the Choose File dialog box, browse to the file Ls_<xx > .fsh.
Step 16 Select Ls_<xx > .fsh, and select Open.
Step 17 On the Upgrade page, select Install File.
Step 18 After the file is installed, a message prompting you to restart the PIMG unit appears. Select OK.
Step 19 In the web browser, go to http://10.12.13.74.
Step 20 To sign in, enter the following case-sensitive settings.

Table 9: Sign-in Settings

SettingsField

Enter admin.Username

Enter IpodAdmin.Password

Step 21 Select OK.
Step 22 If your Unity Connection systemmust have an RTP port range of 16384 to 32767, do the following substeps. Otherwise,

continue to Step 23.

Youmust set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to 32767. Otherwise,
Unity Connection cannot answer calls and callers hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. SomeUnity Connection configurations require
a different RTP port range.

Note

a) On the Configuration menu, select Import/Export.
b) On the Import/Export page, under Export Files, select Export All Settings.
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c) In the File Download dialog box, select Save.
d) In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units, browse to a

directory where you want to save the file, and select Save.
e) In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you saved.
f) Locate the line with the following parameter:

gwRTPStartPort

g) Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384

h) Locate the line with the following parameter:

gwRTPEndPort

i) Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

j) Save the file, and exit Notepad.
k) On the Configuration menu of the PIMG unit, select Import/Export.
l) On the Import/Export page, under Browse for Import Settings, select Browse.
m) In the Choose File dialog box, browse to the file Config.ini that you saved.
n) Select Config.ini, and select Open.
o) On the Import/Export page, select Import File.
p) When prompted to restart the PIMG unit, select OK.
q) When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.
r) To sign in, enter the following case-sensitive settings.

Table 10: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

s) Select OK.

Step 23 On the System menu, select Password.
Step 24 On the Change Password page, enter the following settings.

Table 11: Change Password Page Settings

SettingsField

Enter IpodAdmin.

(This setting is case sensitive.)

Old Password
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SettingsField

Enter your new password.

(This setting is case sensitive.)

New Password

Enter your new password.

(This setting is case sensitive.)

Confirm Password

Step 25 Select Change.
Step 26 On the Configuration menu, selectMgmt Protocols.
Step 27 On the Management Protocols page, enter the following settings.

Table 12: Management Protocols Page Settings

SettingsField

Select No.E-mail Alarms Enabled

Select No.SNMP Traps Enabled

Step 28 Select Submit.
Step 29 On the Configuration menu, select Routing Table.
Step 30 On the Routing Table page, under Router Configuration, select VoIP Host Groups.
Step 31 Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 13: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name of
the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select True.

Fault-Tolerant

Step 32 For Unity Connection without a cluster, under Under Host List, enter the host name or IP address of the Unity Connection
server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, confirm that field contains the host name or IP address
of the publisher server (the first Unity Connection server that you installed) and the server port in the format <host
name or IP address>:5060.

Step 33 For Unity Connection without a cluster, continue to Step 36. For Unity Connection with a cluster configured, under
Host List, enter the host name or IP address of the subscriber server (the second Unity Connection server that you
installed) and the server port in the format <host name or IP address>:5060.

Step 34 Select Add Host.
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Step 35 In the second field, enter the host name or IP address of the publisher server and the server port in the format <host
name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the Unity Connection
cluster may not function correctly.

Step 36 Select Submit.
Step 37 Under Router Configuration, select TDM Trunk Groups.
Step 38 Under TDM Trunk Groups, select Add Trunk Group.
Step 39 Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.

Table 14: First TDM Trunk Group Settings (Inbound Calls)

SettingsField

Enter Inbound_PBX_Calls or another unique name.

This TDM trunk group handles all incoming calls from
the phone system.

Name

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports that handle inbound
calls. For example, enter “*” for all PIMG ports, or enter
“1-6” for the first six PIMG ports.

Port/Channel Content

Step 40 Under TDM Trunk Groups, select Add Trunk Group.
Step 41 Enter the following settings for the second TDM trunk group.

Table 15: Second TDM Trunk Group Settings (MWIs)

SettingsField

EnterMWIs or another unique name.

This TDM trunk group handles outbound MWI calls
(where applicable).

Name

Select Ascending.Selection Direction

Select Cyclic.Selection Mode

Enter the numbers of the PIMG ports that dial out MWIs.
For example, enter “*” for all PIMG ports, or enter “7,8”
for the last two PIMG ports.

Port/Channel Content

Step 42 Under TDM Trunk Groups, select Add Trunk Group.
Step 43 Enter the following settings for the third TDM trunk group.
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Table 16: Third TDM Trunk Group Settings (Outbound Calls)

SettingsField

Enter Outbound_PBX_Calls or another unique name.

This TDM trunk group handles all outbound calls from
Unity Connection.

Name

Select Descending.Selection Direction

Select Linear.Selection Mode

Enter * for all channels in all ports.

Enter the numbers of the PIMG ports that handle outbound
(dialout) calls. For example, enter “*” for all PIMG ports,
or enter “7,8” for the last two PIMG ports.

Port/Channel Content

Step 44 Select Submit.
Step 45 Under Router Configuration, select Inbound VoIP Rules.
Step 46 Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.
Step 47 Select Add Rule.
Step 48 Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 17: First New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable

EnterMWI_Calls or another name.

This inbound VoIP rule handles all MWI calls from Unity
Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address

Step 49 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.

Table 18: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name
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SettingsField

Enter *.Redirect Number

Enter *.Redirect Name

Step 50 Under Outbound Routes, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.

Table 19: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for MWIs in Step 41. For example, select “MWIs.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 51 Under Inbound VoIP Rules, select Add Rule.
Step 52 Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.

Table 20: Second New Inbound VoIP Rule Settings (Outbound Calls)

SettingsField

Check this check box.Enable

Enter Outbound_UC_Calls or another name.

This inbound VoIP rule handles all outbound calls from
Unity Connection.

Rule Label

Select Call.Request Type
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SettingsField

Enter *.Originating VoIP Host Address

Step 53 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 52 must be selected. Otherwise, any changes you make apply to another rule.

Table 21: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 54 Under Outbound Routes, enter the following settings.

The rule that you created in Step 52 must be selected. Otherwise, any changes you make apply to another rule.

Table 22: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for outbound calls in Step 43. For example, select
“Outbound_PBX_Calls.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route
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SettingsField

Select Primary.Primary

Step 55 Select Submit.
Step 56 Under Router Configuration, select Inbound TDM Rules.
Step 57 Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.

Table 23: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule handles all incoming calls from
the phone system.

Rule Label

Select Call.Request Type

Select the name of the TDM trunk group that you created
for incoming calls from the phone system in Step 39. For
example, select “Inbound_PBX_Calls.”

Trunk Group

Step 58 Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 57 must be selected. Otherwise, any changes you make apply to another rule.

Table 24: Inbound TDM Request Matching Settings

SettingsField

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Name

Step 59 Under Outbound Routes, enter the following settings.

The rule that you created in Step 57 must be selected. Otherwise, any changes you make apply to another rule.
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Table 25: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination

Select the name of the VoIP host group that you created
for Unity Connection in Step 31.

Host Group

CPID Manipulation

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 60 If you want to create more Inbound TDM rules, under Inbound TDM Rules, select Add Rule. Otherwise, continue to
Step 62.

Step 61 Repeat Step 57 through Step 60 for all remaining inbound TDM rules that you want to create.
Step 62 Select Submit.
Step 63
Step 64
Step 65
Step 66 On the Configuration menu, select TDM > General.
Step 67 On the TDM General Settings page, enter the following settings.

Table 26: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)
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SettingsField

Enter 2000.Maximum Call Party Delay (msecs)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Enter the code that turns MWIs on.Turn MWI On FAC

Enter the code that turns MWIs off.Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Step 68 Select Submit.
Step 69 On the Configuration menu, select TDM > Port Enable.
Step 70 On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.
Step 71 Confirm that Yes is selected for all other ports on the PIMG unit.
Step 72 Select Submit.
Step 73 On the Configuration menu, select VoIP > General.
Step 74 On the VoIP General Settings page, enter the following settings.

Table 27: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that the
PIMG unit use.

DNS Server Address

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)
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SettingField

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Proxy

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Monitoring

Select No.Monitor Call Connections

Step 75 Select Submit.
Step 76 On the Configuration menu, select VoIP > Media.
Step 77 On the VoIP Media Settings page, enter the following settings.

Table 28: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size
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SettingsField

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Step 78 Select Submit.
Step 79 On the Configuration menu, select VoIP > QOS.
Step 80 On the VoIP QOS Configuration page, enter the following settings.

Table 29: VoIP QOS Configurative Page Settings

SettingsField

Enter 104.Call Control QOS Byte

Enter 184.RTP QOS Byte

Step 81 Select Submit.
Step 82 On the Configuration menu, select IP.
Step 83 On the IP Settings page, enter the following settings.

Table 30: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units uses.

Default Network Gateway Address

Select No.BOOTP Enabled

Step 84 Select Submit.
Step 85 On the Configure menu, select Tone Detection.
Step 86 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select Busy and do the

following substeps to verify that the tone is correct.
a) From an available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
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c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.

Step 87 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 86c. from the
third phone.

Step 88 Select Learn.
Step 89 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 90 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 89a.
Step 91 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, selectRingback and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 92 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 91a.
Step 93 Select Learn.
Step 94 Select Submit.
Step 95 Hang up the phones that you used in Step 86.
Step 96 On the Configure menu, select Restart.
Step 97 On the Restart page, select Restart Unit Now.
Step 98 Repeat Step 2 through Step 97 on all remaining PIMG units.

Configuring Unity Connection for Integration with the Alcatel 4400 Phone
System

After ensuring that the Alcatel 4400 phone system, the PIMG units, and Unity Connection are ready for the
integration, do the following procedure to set up the integration and to enter the port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.
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Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
Step 6 Select Save.
Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 31: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 32: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled
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ConsiderationsField

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.

Table 33: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification
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ConsiderationsField

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note

Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 34: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From
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SettingField

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is

checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

Table 35: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
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Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone
system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.
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C H A P T E R 4
Setting up Alcatel 4400 Digital PIMG Integration
with Cisco Unity Connection

• Setting Up an Alcatel 4400 Digital PIMG Integration with Cisco Unity Connection, on page 35

Setting Up an Alcatel 4400 Digital PIMG Integration with
Cisco Unity Connection

Task List for Alcatel 4400 Digital PIMG Integration
Before doing the following tasks to integrate Cisco Unity Connection with the Alcatel 4400 phone system by
using PIMG units (media gateways), confirm that the Cisco Unity Connection server is ready for the integration
by completing the applicable tasks in the “Installing Cisco Unity Connection” chapter of the Install, Upgrade,
and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Cisco Unity
Connection server requirements have been met. See the Requirements, on page 12 section.

2. Plan how the voice messaging ports will be used by Cisco Unity Connection. See Planning the Usage of
Voice Messaging Ports, on page 7 section.

3. Program the Alcatel 4400 phone system and extensions. See the Programming the Alcatel 4400 Digital
PIMG Phone System, on page 36 section.

4. Set up the PIMG units. See the Setting Up the Digital PIMG Units section.

5. Create the integration. See the Configuring Unity Connection for Integration with the Alcatel 4400 Digital
Phone System, on page 54 section.

6. Test the integration. See Testing the Integration, on page 401 chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See Adding New User Templates for Multiple Integrations, on page 407 section.
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Requirements
This integration supports configurations of the following components:

Phone System
• Alcatel 4400 phone system. The voice messaging ports that connect to the PIMG units must be compatible
with the 7434ND, 8434, 8434D, or 8434DX digital phones.

You must use 2-wire line cards for these voice messaging ports. Otherwise, the voice messaging ports
will not be compatible with the 7434ND, 8434, 8434D, or 8434DX digital phones.

• One or more of the applicable PIMG units. For details, see Introduction, on page 1

• The voice messaging ports in the phone system connected by digital lines to the ports on the PIMG units.

To simplify troubleshooting, we recommend that you connect the voice messaging ports on the phone system
to the ports on the PIMG units in a planned manner. For example, connect the first phone system voice
messaging port to the first port on the first PIMG unit, connect the second phone system voice messaging port
to the second port on the first PIMG unit, and so on. Alternatively, if you have multiple PIMG units, you can
reduce answer times in the event of a PIMG unit failure by connecting the phone system ports to the PIMG
units in a round-robin fashion. For example, connect the first phone system voice messaging port to the first
port on the first PIMG unit, connect the second phone system voice messaging port to the first port on the
second PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

• The phone system ready for the integration, as described in the documentation for the phone system.

Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.

Programming the Alcatel 4400 Digital PIMG Phone System
The following programming instructions are provided as an example only. The specific programming for your
phone system may vary depending on its configuration.
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In programming the phone system, do not send calls to voice messaging ports in Cisco Unity Connection that
cannot answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging
port is set only to Send MWI Requests, do not send calls to it.

Caution

Programming the Alcatel 4400 Phone System

Step 1 Create a coverage path which contains the PIMG unit hunt group number as the coverage point.
Step 2 Assign the coverage path that you created in Step 1 to the user stations that must forward to the voice messaging ports

on the PIMG units when calls are not answered or when the user station is busy, based on one of the Unity Connection
call transfer types shown in Table 36: Call Transfer Types.

Table 36: Call Transfer Types

UsageTransfer Type

Program the user station to forward calls to the pilot number
when:

• The extension is busy.

• The call is not answered.

Release transfer

(blind transfer)

Program the user station to forward calls to the pilot number
only when the call is not answered (on the phone system,
the number of rings before forwarding must be more than
the number of rings to supervise the call). Confirm that call
forwarding is disabled when the extension is busy.

Supervised transfer

Step 3 Use the Add Station <extension number> command (for example, Add Station 2999) to assign an extension number for
each voice messaging port, which is a digital line that connects to the PIMG unit. Set the voice messaging port options
(Table 37: Voice Messaging Port Options for All Lines) and button assignments (Table 38: Button Assignments for All
Lines), and press Enter.

We recommend that you distribute the voice messaging ports among multiple phone system line cards so that
call processing can continue even if a line card becomes inactive.

Note

Table 37: Voice Messaging Port Options for All Lines

SettingOption

Enter the extension number of the digital line.Extension
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SettingOption

Enter 7434ND (recommended).

You can also use the following settings. However, you must
include the extension with each subscriber name when
programming the phone system (for example, “3001 Jane
Doe”). Otherwise, the integration will not function correctly.

• 8434

• 8434D

• 8434DX

If the setting that you want is not available,
contact the phone system manufacturer.

Note

Type

Entermsa.LWC Reception

Enter y.LWC Activation?

Enter y.Restrict Last Appearance?

Enter y.Display Module

Table 38: Button Assignments for All Lines

SettingButton Assignment

Enter call-appr.1

Enter call-appr.2

Enter lwc-store.9

Enter lwc-cancel.10

Step 4 Use the Add Hunt <hunt group number> command (for example, Add Hunt 1) to assign a the voice messaging ports to
a hunt group. Set the following options.

Table 39: Hunt Group Options

SettingOption

Enter the hunt group number.Group Number

Enter the pilot number for the hunt group.Group Extension

Enter ucd.Group Type

Enter the display name for the hunt group.Group Name

Enter N.Queue?
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Step 5 Enter the group member assignments for the voice messaging ports that will answer calls and press Enter.

If you plan to set the voice messaging ports to either answer calls or to dial out (for example, to set MWIs), make sure
that you include in the hunt group only the voice messaging ports that will be set to answer calls.

For smaller systems, include in the hunt group all voice messaging ports when the ports will be set to both answer calls
and dial out (for example, to set MWIs).

Setting Up the Digital PIMG Units
Do the following procedures to set up the digital PIMG units that are connected to the Alcatel 4400 phone
system.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the PIMG units by using digital lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the PIMG units.

Downloading the PIMG Firmware Update Files for Digital PIMG Units

Step 1 On a Windows workstation with a high-speed Internet connection that will have access to the PIMG units, go to the
Voice and Unified Communications Downloads page at
http://tools.cisco.com/support/downloads/pub/Redirect.x?mdfid=278875240.

To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

Note

Step 2 In the tree control on the Downloads page, expandUnified Communications Applications > VoiceMail andUnified
Messaging > Cisco Unity, and select Cisco Unity Telephony Integration.

Step 3 On the Log In page, enter your username and password, then select Log In.
Step 4 On the Select a Release page, under Latest Releases, select the most recent release.
Step 5 In the right column, select the version of the firmware for digital PIMG units.

Step 6 On the Download Image page, select Download.
Step 7 On the Supporting Document(s) page, select Agree.
Step 8 In the File Download dialog box, select Save.
Step 9 In the Save As dialog box, browse to the Windows workstation that will have access the PIMG units, browse to a

directory where you want to save the file, and select Save.
Step 10 In the Download Complete dialog box, selectOpen. The window for extracting the PIMG firmware update files appears.
Step 11 Select Extract.
Step 12 In the Extract dialog box, browse to the directory where you want the extracted files, and select Extract.
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Step 13 Close the window for the extracting application.

Setting Up the Digital PIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the PIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 2 Connect a PIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.

Table 40: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
Step 7 On the Upgrade page, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted PIMG firmware

update files.
Step 9 Select Ami<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.

Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file installation fails.
Restarting the PIMG unit at this step may prevent the PIMG unit from functioning correctly.

Step 12 Repeat Step 6 through Step 11 for each of the following files:

• Ami_<xx>.fsh

• Run<xx>FskEcho.dsp

• iNim<xx>.ibt

• iNim<xx>.ilc

• iNim<xx>.iap
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Step 13 On the Configuration menu, select Import/Export.
Step 14 On the Import/Export page, select Browse.
Step 15 In the Choose File dialog box, browse to the file DNI_Cfg_Lucent.ini.
Step 16 Select DNI_Cfg_Lucent.ini, and select Open.
Step 17 On the Import/Export page, select Import File.
Step 18 After the file is imported, a message prompting you to restart the PIMG unit appears. Select OK.
Step 19 In the web browser, go to http://10.12.13.74.
Step 20 To sign in, enter the following case-sensitive settings.

Table 41: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 21 Select OK.
Step 22 Do the following substeps to configure an RTP port range of 16384 to 32767.

Youmust set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to 32767. Otherwise,
Unity Connection will not be able to answer calls, and callers will hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. SomeUnity Connection configurations require
a different RTP port range.

Note

a) On the Configuration menu, select Import/Export.
b) On the Import/Export page, under Export Settings, select Export All Settings.
c) In the File Download dialog box, select Save.
d) In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units, browse to a

directory where you want to save the file, and select Save.
e) In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you saved.
f)
g)
h) Locate the line with the following parameter:

gwRTPStartPort

i) Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384

j) Locate the line with the following parameter:

gwRTPEndPort

k) Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

l) Save the file, and exit Notepad.
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m) On the Configuration menu of the PIMG unit, select Import/Export.
n) On the Import/Export page, under Browse for Import File, select Browse.
o) In the Choose File dialog box, browse to the file Config.ini that you saved.
p) Select Config.ini, and select Open.
q) On the Import/Export page, select Import File.
r) When prompted to restart the PIMG unit, select OK.
s) When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.
t) To sign in, enter the following case-sensitive settings.

Table 42: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

u) Select OK.

Step 23 On the System menu, select Password.
Step 24 On the Change Password page, enter the following settings.

Table 43: Change Password Page Settings

SettingField

Enter IpodAdmin.

(This setting is case sensitive.)

Old Password

Enter your new password.

(This setting is case sensitive.)

New Password

Enter your new password.

(This setting is case sensitive.)

Confirm Password

Step 25 Select Change.
Step 26 On the Configuration menu, select Routing Table.
Step 27 On the Routing Table page, under Router Configuration, select VoIP Host Groups.
Step 28 Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 44: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name of
the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select False.

Load-Balanced
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SettingsField

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select True.

Fault-Tolerant

Step 29 For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity Connection
server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, enter the host name or IP address of the subscriber
server (the second Cisco Unity Connection server that you installed) and the server port in the format <host name or
IP address>:5060.

Step 30 For Unity Connection without a cluster, continue to Step 32. For Unity Connection with a cluster configured, select
Add Host.

Step 31 In the second field, enter the host name or IP address of the publisher server (the first Unity Connection server that you
installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the Unity Connection
cluster may not function correctly.

Step 32 Select Submit.
Step 33 Under Router Configuration, select TDM Trunk Groups.
Step 34 Under TDM Trunk Groups, select Add Trunk Group.
Step 35 Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.

Table 45: First TDM Trunk Group Settings (Inbound Calls)

SettingsField

Enter Inbound_PBX_Calls or another unique name.

This TDM trunk group will handle all incoming calls from
the phone system.

Name

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports that will handle
inbound calls. For example, enter “*” for all PIMG ports,
or enter “1-6” for the first six PIMG ports.

Port/Channel Content

Step 36 Under TDM Trunk Groups, select Add Trunk Group.
Step 37 Enter the following settings for the second TDM trunk group.

Table 46: Second TDM Trunk Group Settings (MWIs)

SettingsField

EnterMWIs or another unique name.

This TDM trunk group will handle outbound MWI calls
(where applicable).

Name
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SettingsField

Select Ascending.Selection Direction

Select Cyclic.Selection Mode

Enter the numbers of the PIMG ports that will MWIs. For
example, enter “*” for all PIMG ports, or enter “7,8” for
the last two PIMG ports.

Port/Channel Content

Step 38 Under TDM Trunk Groups, select Add Trunk Group.
Step 39 Enter the following settings for the third TDM trunk group.

Table 47: Third TDM Trunk Group Settings (Outbound Calls)

SettingsField

Enter Outbound_PBX_Calls or another unique name.

This TDM trunk group handles all outbound calls from
Unity Connection.

Name

Select Descending.Selection Direction

Select Linear.Selection Mode

Enter * for all channels in all ports.

Enter the numbers of the PIMG ports that will handle
outbound (dialout) calls. For example, enter “*” for all
PIMG ports, or enter “7,8” for the last two PIMG ports.

Port/Channel Content

Step 40 Select Submit.
Step 41 Under Router Configuration, select Inbound VoIP Rules.
Step 42 Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.
Step 43 Select Add Rule.
Step 44 Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 48: First New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable

EnterMWI_Calls or another name.

This inbound VoIP rule will handle all MWI calls from
Unity Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address
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Step 45 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make will apply to another inbound
VoIP rule.

Table 49: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 46 Under Outbound Routes, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make will apply to another rule.

Table 50: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for MWIs in Step 37. For example, select “MWIs.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 47 Under Inbound VoIP Rules, select Add Rule.
Step 48 Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.
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Table 51: Second New Inbound VoIP Rule Settings (Outbound Calls)

SettingsField

Check this check box.Enable

Enter Outbound_UC_Calls or another name.

This inbound VoIP rule will handle all outbound calls from
Unity Connection.

Rule Label

Select Call.Request Type

Enter *.Originating VoIP Host Address

Step 49 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make will apply to another rule.

Table 52: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 50 Under Outbound Routes, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make will apply to another rule.

Table 53: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for outbound calls in Step 39. For example, select
“Outbound_PBX_Calls.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name
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SettingsField

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 51 Select Submit.
Step 52 Under Router Configuration, select Inbound TDM Rules.
Step 53 Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.

Table 54: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule will handle all incoming calls from
the phone system.

Rule Label

Select Call.Request Type

Select the name of the TDM trunk group that you created
for incoming calls from the phone system in Step 35. For
example, select “Inbound_PBX_Calls.”

Trunk Group

Step 54 Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make will apply to another rule.

Table 55: Inbound TDM Request Matching Settings

SettingsField

Enter the applicable matching rule that will be used. For
example, enter “*” for all.

Calling Number

Enter the applicable matching rule that will be used. For
example, enter “*” for all.

Calling Name

Enter the applicable matching rule that will be used. For
example, enter “*” for all.

Called Number

Enter the applicable matching rule that will be used. For
example, enter “*” for all.

Called Name
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SettingsField

Enter the applicable matching rule that will be used. For
example, enter “*” for all.

Redirect Number

Enter the applicable matching rule that will be used. For
example, enter “*” for all.

Redirect Name

Step 55 Under Outbound Routes, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make will apply to another rule.

Table 56: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination

Select the name of the VoIP host group that you created
for Unity Connection in Step 28.

Host Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 56 If you want to create more Inbound TDM rules, under Inbound TDM Rules, select Add Rule. Otherwise, continue to
Step 58.

Step 57 Repeat Step 53 through Step 56 for all remaining inbound TDM rules that you want to create.
Step 58 Select Submit.
Step 59 On the Configuration menu, select TDM > Digital.
Step 60 On the Digital Telephony page, in the Telephony Switch Type field, select Lucent.
Step 61 Select Submit.
Step 62 On the Configuration menu, select TDM > General.
Step 63 On the TDM General Settings page, enter the following settings.
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Table 57: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Leave this field blank.Turn MWI On FAC

Leave this field blank.Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the CiscoUnity Connection voice
messaging ports.

Hunt Group Extension

Select No.Disconnect on Fax Cleardown Tone

Step 64 Select Submit.
Step 65 On the Configuration menu, select TDM > Port Enable.
Step 66 On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.
Step 67 Confirm that Yes is selected for all other ports on the PIMG unit.
Step 68 Select Submit.
Step 69 On the Configuration menu, select VoIP > General.
Step 70 On the VoIP General Settings page, enter the following settings.

Table 58: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Select No.SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)

Server
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SettingField

Enter the IP Address of the Domain Name Server that the
PIMG unit will use.

DNS Server Address

Select No.DNS Translation of Phone Numbers

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Enter 30.TCP Inactivity Timer (sec)

TLS

Select No.TLS Transport Enabled

Enter 5061.TLS Server Port

Select SSLv3 TLSv1.SSL TLS Protocol

Select Yes.Mutual TLS Authentication Required

Enter 30.TLS Inactivity Timer (sec)

Select Yes.Verify TLS Peer Certificate Date

Select Yes.Verify TLS Peer Certificate Trust

Proxy

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Enter 5000.T4 Time (ms)
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SettingField

Monitoring

Select No.Monitor Call Connections

Call Monitor Interval (sec)

Monitor VoIP Hosts

VoIP Host Monitor Interval (sec)

Step 71 Select Submit.
Step 72 On the Configuration menu, select VoIP > Media.
Step 73 On the VoIP Media Settings page, enter the following settings.

Table 59: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select RFC2833.RTP Fax/Modem Tone Relay Mode

Select Off.RTP Source IP Address Validation

Select Off.RTP Source UDP Port Validation

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select On Demand.RFC 3960 Early Media Support

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting will result in recorded
messages containing nothing but silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting will result in recorded
messages containing nothing but silence.

Frames Per Packet
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SettingsField

Fax

Fax IP-Transport Mode

SRTP

Select RTP Only.SRTP Preference

Select Yes.MKI on Transmit Stream

Select Yes.Key Derivation Enable

Enter 16.Key Derivation Rate

Enter 64.Anti-replay Window Size Hint

Select AES_Counter_Mode.Cipher Mode

Select SHA1.Authentication Type

Select SHA1_80_bit.Authentication Tag Length

Step 74 Select Submit.
Step 75 On the Configuration menu, select VoIP > QOS.
Step 76 On the VoIP QOS Configuration page, enter the following settings.

Table 60: VoIP QOS Configurative Page Settings

SettingsField

Enter 104.Call Control QOS Byte

Enter 184.RTP QOS Byte

Step 77 Select Submit.
Step 78 On the Configuration menu, select IP.
Step 79 On the IP Settings page, enter the following settings.

Table 61: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask
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SettingsField

Enter the IP address of the default network gateway router
that the PIMG units will use.

Default Network Gateway Address

Select No.BOOTP Enabled

SNTP Server IP Address

Step 80 Select Submit.
Step 81 On the Configuration menu, select Tone Detection.
Step 82 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select Busy and do the

following substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.

Step 83 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 82c. from the
third phone.

Step 84 Select Learn.
Step 85 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 86 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 85a.
Step 87 Select Learn.
Step 88 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, selectRingback and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 89 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 88a.
Step 90 Select Learn.
Step 91 Select Submit.
Step 92 Hang up the phones that you used in Step 82.
Step 93 On the System menu, select Restart.
Step 94 On the Restart page, select Restart Unit Now.
Step 95 Repeat Step 2 through Step 94 on all remaining PIMG units.
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Configuring Unity Connection for Integration with the Alcatel 4400 Digital
Phone System

After ensuring that the Alcatel 4400 Digital phone system, the PIMG units, and Unity Connection are ready
for the integration, do the following procedure to set up the integration and to enter the port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
Step 6 Select Save.
Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 62: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name
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SettingField

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 63: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.
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Table 64: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note
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Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 65: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is

checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

PIMG Integration Guide for Cisco Unity Connection Release 12.X
57

Setting up Alcatel 4400 Digital PIMG Integration with Cisco Unity Connection
Creating an Integration



Table 66: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone

system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.
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C H A P T E R 5
Setting Up an Avaya Definity G3 Digital PIMG
Integration with Cisco Unity Connection

• Setting Up an Avaya Definity G3 Digital PIMG Integration, on page 59

Setting Up an Avaya Definity G3 Digital PIMG Integration

Task List for Avaya Definity G3 Integration
Before doing the following tasks to integrate Unity Connection with the Avaya Definity G3 phone system
using PIMG units (media gateways), confirm that the Unity Connection server is ready for the integration
after completing the server installation, following the tasks in the “Installing Cisco Unity Connection” chapter
of the Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Unity Connection
server requirements have been met. See the Requirements, on page 12 section.

2. Plan how the voice messaging ports are used by Cisco Unity Connection. See the "Planning the Usage of
Voice Messaging Ports” chapter.

3. Program the Avaya Definity G3 phone system and extensions. See the Programming Avaya Definity G3
Phone System for Integration section.

4. Set up the PIMG units. See the Setting Up the Digital PIMG Units section.

5. Create the integration. See the Configuring Unity Connection for Integration with the Avaya Definity G3
Phone System section.

6. Test the integration. See the “Testing the Integration” chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the “Adding New User Templates for Multiple Integrations” chapter.

Requirements
This integration supports configurations of the following components:
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Phone System
• Avaya Definity G3 phone system. The voice messaging ports that connect to the PIMG units must be
compatible with the 7434ND, 8434, 8434D, or 8434DX digital phones.

You must use 2-wire line cards for these voice messaging ports. Otherwise, the voice messaging ports
cannot be compatible with the 7434ND, 8434, 8434D, or 8434DX digital phones.

• Software version 4 or later.

• One or more of the applicable PIMG units. For details, see the Introduction, on page 1 chapter.

• The voice messaging ports in the phone system connected by digital lines to the ports on the PIMG units.

To simplify troubleshooting, you should connect the voice messaging ports on the phone system to the ports
on the PIMG units in a planned manner. For example, connect the first phone system voice messaging port
to the first port on the first PIMG unit, connect the second phone system voice messaging port to the second
port on the first PIMG unit, and so on. Alternatively, if you have multiple PIMG units, you can reduce answer
times in the event of a PIMG unit failure by connecting the phone system ports to the PIMG units in a
round-robin fashion. For example, connect the first phone system voice messaging port to the first port on
the first PIMG unit, connect the second phone system voice messaging port to the first port on the second
PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.

Programming Avaya Definity G3 Phone System for Integration
The following programming instructions are provided as an example only. The specific programming for your
phone system may vary depending on its configuration.
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In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Send MWI Requests, do not send calls to it.

Caution

Programming the Avaya Definity G3 Phone System

Step 1 Create a coverage path which contains the PIMG unit hunt group number as the coverage point.
Step 2 Assign the coverage path that you created in Step 1 to the user stations that must forward to the voice messaging ports

on the PIMG units when calls are not answered or when the user station is busy, based on one of the Unity Connection
call transfer types shown in Table 67: Call Transfer Types.

Table 67: Call Transfer Types

UsageTransfer Type

Program the user station to forward calls to the pilot number
when:

• The extension is busy.

• The call is not answered.

Release transfer

(blind transfer)

Program the user station to forward calls to the pilot number
only when the call is not answered (on the phone system,
the number of rings before forwarding must be more than
the number of rings to supervise the call). Confirm that call
forwarding is disabled when the extension is busy.

Supervised transfer

Step 3 Use the Add Station <extension number> command (for example, Add Station 2999) to assign an extension number for
each voice messaging port, which is a digital line that connects to the PIMG unit. Set the voice messaging port options
(Table 68: Voice Messaging Port Options for All Lines) and button assignments (Table 69: Button Assignments for All
Lines), and press Enter.

You should distribute the voice messaging ports among multiple phone system line cards so that call processing
can continue even if a line card becomes inactive.

Note

Table 68: Voice Messaging Port Options for All Lines

SettingOption

Enter the extension number of the digital line.Extension
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SettingOption

Enter 7434ND

You can also use the following settings. However, you must
include the extension with each subscriber name when
programming the phone system (for example, “3001 Jane
Doe”). Otherwise, the integration cannot function correctly.

• 8434

• 8434D

• 8434DX

If the setting that you want is not available,
contact the phone system manufacturer.

Note

Type

Entermsa.LWC Reception

Enter y.LWC Activation?

Enter y.Restrict Last Appearance?

Enter y.Display Module

Table 69: Button Assignments for All Lines

SettingButton Assignment

Enter call-appr.1

Enter call-appr.2

Enter lwc-store.9

Enter lwc-cancel.10

Step 4 Use the Add Hunt <hunt group number> command (for example, Add Hunt 1) to assign a the voice messaging ports to
a hunt group. Set the following options.

Table 70: Hunt Group Options

SettingOption

Enter the hunt group number.Group Number

Enter the pilot number for the hunt group.Group Extension

Enter ucd.Group Type

Enter the display name for the hunt group.Group Name

Enter N.Queue?

PIMG Integration Guide for Cisco Unity Connection Release 12.X
62

Setting Up an Avaya Definity G3 Digital PIMG Integration with Cisco Unity Connection
Programming the Avaya Definity G3 Phone System



Step 5 Enter the group member assignments for the voice messaging ports that answer calls and press Enter.

If you plan to set the voice messaging ports to either answer calls or to dial out (for example, to set MWIs), make sure
that you include in the hunt group only the voice messaging ports are set to answer calls.

For smaller systems, include in the hunt group all voice messaging ports when the ports are set to both answer calls and
dial out (for example, to set MWIs).

Setting Up the Digital PIMG Units
Do the following procedures to set up the digital PIMG units that are connected to the Avaya Definity G3
phone system.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the PIMG units using digital lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the PIMG units.

Downloading the PIMG Firmware Update Files for Digital PIMG Units
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.
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To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

1. In the tree control on the Downloads Home page, expand Unified Communications> Unified
Communications Applications > Messaging > Cisco Unity and select Cisco Unity Telephony
Integration.

2. On the Log In page, enter your username and password, then select Log In.

3. On the Select a Release page, under Latest Releases, select the most recent release.

4. In the right column, select the version of the firmware for digital PIMG units.

5. On the Download Image page, select Download.

6. On the Supporting Document(s) page, select Agree.

7. In the File Download dialog box, select Save.

8. In the Save As dialog box, browse to theWindows workstation that have access the PIMG units, browse
to a directory where you want to save the file, and select Save.

9. In the Download Complete dialog box, select Open. The window for extracting the PIMG firmware
update files appears and select Extract.

10. In the Extract dialog box, browse to the directory where you want the extracted files and selectExtract.

11. Close the window for the extracting application.

Note

On a Windows workstation that have access to the PIMG units, go to the following link:

Setting Up the Digital PIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the PIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 2 Connect a PIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.
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Table 71: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
Step 7 On the Upgrade page, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted PIMG firmware

update files.
Step 9 Select Ami<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.

Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file installation fails.
Restarting the PIMG unit at this step may prevent the PIMG unit from functioning correctly.

Step 12 Repeat Step 6 through Step 11 for each of the following files:

• Ami_<xx>.fsh

• Run<xx>FskEcho.dsp

• iNim<xx>.ibt

• iNim<xx>.ilc

• iNim<xx>.iap

Step 13 On the Configuration menu, select Import/Export.
Step 14 On the Import/Export page, select Browse.
Step 15 In the Choose File dialog box, browse to the file DNI_Cfg_Lucent.ini.
Step 16 Select DNI_Cfg_Lucent.ini, and select Open.
Step 17 On the Import/Export page, select Import File.
Step 18 After the file is imported, a message prompting you to restart the PIMG unit appears. Select OK.
Step 19 In the web browser, go to http://10.12.13.74.
Step 20 To sign in, enter the following case-sensitive settings.

Table 72: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 21 Select OK.
Step 22 Do the following substeps to configure an RTP port range of 16384 to 32767.
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Youmust set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to 32767. Otherwise,
Unity Connection cannot answer calls and callers hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. SomeUnity Connection configurations require
a different RTP port range.

Note

a) On the Configuration menu, select Import/Export.
b) On the Import/Export page, under Export Settings, select Export All Settings.
c) In the File Download dialog box, select Save.
d) In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units, browse to a

directory where you want to save the file, and select Save.
e) In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you saved.
f)
g)
h) Locate the line with the following parameter:

gwRTPStartPort

i) Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384

j) Locate the line with the following parameter:

gwRTPEndPort

k) Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

l) Save the file, and exit Notepad.
m) On the Configuration menu of the PIMG unit, select Import/Export.
n) On the Import/Export page, under Browse for Import File, select Browse.
o) In the Choose File dialog box, browse to the file Config.ini that you saved.
p) Select Config.ini, and select Open.
q) On the Import/Export page, select Import File.
r) When prompted to restart the PIMG unit, select OK.
s) When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.
t) To sign in, enter the following case-sensitive settings.

Table 73: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

u) Select OK.

Step 23 On the System menu, select Password.
Step 24 On the Change Password page, enter the following settings.
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Table 74: Change Password Page Settings

SettingField

Enter IpodAdmin.

(This setting is case sensitive.)

Old Password

Enter your new password.

(This setting is case sensitive.)

New Password

Enter your new password.

(This setting is case sensitive.)

Confirm Password

Step 25 Select Change.
Step 26 On the Configuration menu, select Routing Table.
Step 27 On the Routing Table page, under Router Configuration, select VoIP Host Groups.
Step 28 Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 75: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name of
the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select True.

Fault-Tolerant

Step 29 For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity Connection
server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, enter the host name or IP address of the subscriber
server (the second Unity Connection server that you installed) and the server port in the format <host name or IP
address>:5060.

Step 30 For Unity Connection without a cluster, continue to Step 32. For Unity Connection with a cluster configured, select
Add Host.

Step 31 In the second field, enter the host name or IP address of the publisher server (the first Unity Connection server that you
installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the Unity Connection
cluster may not function correctly.

Step 32 Select Submit.
Step 33 Under Router Configuration, select TDM Trunk Groups.
Step 34 Under TDM Trunk Groups, select Add Trunk Group.
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Step 35 Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.

Table 76: First TDM Trunk Group Settings (Inbound Calls)

SettingsField

Enter Inbound_PBX_Calls or another unique name.

This TDM trunk group handles all incoming calls from
the phone system.

Name

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports that handle inbound
calls. For example, enter “*” for all PIMG ports, or enter
“1-6” for the first six PIMG ports.

Port/Channel Content

Step 36 Under TDM Trunk Groups, select Add Trunk Group.
Step 37 Enter the following settings for the second TDM trunk group.

Table 77: Second TDM Trunk Group Settings (MWIs)

SettingsField

EnterMWIs or another unique name.

This TDM trunk group handles outbound MWI calls
(where applicable).

Name

Select Ascending.Selection Direction

Select Cyclic.Selection Mode

Enter the numbers of the PIMG ports that dial out MWIs.
For example, enter “*” for all PIMG ports, or enter “7,8”
for the last two PIMG ports.

Port/Channel Content

Step 38 Under TDM Trunk Groups, select Add Trunk Group.
Step 39 Enter the following settings for the third TDM trunk group.

Table 78: Third TDM Trunk Group Settings (Outbound Calls)

SettingsField

Enter Outbound_PBX_Calls or another unique name.

This TDM trunk group handles all outbound calls from
Unity Connection.

Name

Select Descending.Selection Direction

Select Linear.Selection Mode
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SettingsField

Enter * for all channels in all ports.

Enter the numbers of the PIMG ports that handle outbound
(dialout) calls. For example, enter “*” for all PIMG ports,
or enter “7,8” for the last two PIMG ports.

Port/Channel Content

Step 40 Select Submit.
Step 41 Under Router Configuration, select Inbound VoIP Rules.
Step 42 Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.
Step 43 Select Add Rule.
Step 44 Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 79: First New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable

EnterMWI_Calls or another name.

This inbound VoIP rule handles all MWI calls from Unity
Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address

Step 45 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another inbound VoIP
rule.

Table 80: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 46 Under Outbound Routes, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another rule.
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Table 81: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for MWIs in Step 37. For example, select “MWIs.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 47 Under Inbound VoIP Rules, select Add Rule.
Step 48 Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.

Table 82: Second New Inbound VoIP Rule Settings (Outbound Calls)

SettingsField

Check this check box.Enable

Enter Outbound_UC_Calls or another name.

This inbound VoIP rule handles all outbound calls from
Unity Connection.

Rule Label

Select Call.Request Type

Enter *.Originating VoIP Host Address

Step 49 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.
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Table 83: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 50 Under Outbound Routes, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.

Table 84: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for outbound calls in Step 39. For example, select
“Outbound_PBX_Calls.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 51 Select Submit.
Step 52 Under Router Configuration, select Inbound TDM Rules.
Step 53 Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.

PIMG Integration Guide for Cisco Unity Connection Release 12.X
71

Setting Up an Avaya Definity G3 Digital PIMG Integration with Cisco Unity Connection
Setting Up the Digital PIMG Units (Firmware Version 6.x)



Table 85: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule handles all incoming calls from
the phone system.

Rule Label

Select Call.Request Type

Select the name of the TDM trunk group that you created
for incoming calls from the phone system in Step 35. For
example, select “Inbound_PBX_Calls.”

Trunk Group

Step 54 Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another rule.

Table 86: Inbound TDM Request Matching Settings

SettingsField

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Name

Step 55 Under Outbound Routes, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another rule.

Table 87: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination
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SettingsField

Select the name of the VoIP host group that you created
for Unity Connection in Step 28.

Host Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 56 If you want to create more Inbound TDM rules, under Inbound TDM Rules, select Add Rule. Otherwise, continue to
Step 58.

Step 57 Repeat Step 53 through Step 56 for all remaining inbound TDM rules that you want to create.
Step 58 Select Submit.
Step 59 On the Configuration menu, select TDM > Digital.
Step 60 On the Digital Telephony page, in the Telephony Switch Type field, select Lucent.
Step 61 Select Submit.
Step 62 On the Configuration menu, select TDM > General.
Step 63 On the TDM General Settings page, enter the following settings.

Table 88: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Leave this field blank.Turn MWI On FAC

Leave this field blank.Turn MWI Off FAC
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SettingsField

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Select No.Disconnect on Fax Cleardown Tone

Step 64 Select Submit.
Step 65 On the Configuration menu, select TDM > Port Enable.
Step 66 On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.
Step 67 Confirm that Yes is selected for all other ports on the PIMG unit.
Step 68 Select Submit.
Step 69 On the Configuration menu, select VoIP > General.
Step 70 On the VoIP General Settings page, enter the following settings.

Table 89: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Select No.SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that the
PIMG unit uses.

DNS Server Address

Select No.DNS Translation of Phone Numbers

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port
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SettingField

Enter 30.TCP Inactivity Timer (sec)

TLS

Select No.TLS Transport Enabled

Enter 5061.TLS Server Port

Select SSLv3 TLSv1.SSL TLS Protocol

Select Yes.Mutual TLS Authentication Required

Enter 30.TLS Inactivity Timer (sec)

Select Yes.Verify TLS Peer Certificate Date

Select Yes.Verify TLS Peer Certificate Trust

Proxy

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Enter 5000.T4 Time (ms)

Monitoring

Select No.Monitor Call Connections

Call Monitor Interval (sec)

Monitor VoIP Hosts

VoIP Host Monitor Interval (sec)

Step 71 Select Submit.
Step 72 On the Configuration menu, select VoIP > Media.
Step 73 On the VoIP Media Settings page, enter the following settings.
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Table 90: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select RFC2833.RTP Fax/Modem Tone Relay Mode

Select Off.RTP Source IP Address Validation

Select Off.RTP Source UDP Port Validation

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select On Demand.RFC 3960 Early Media Support

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Fax

Fax IP-Transport Mode

SRTP

Select RTP Only.SRTP Preference

Select Yes.MKI on Transmit Stream

Select Yes.Key Derivation Enable

Enter 16.Key Derivation Rate

Enter 64.Anti-replay Window Size Hint

Select AES_Counter_Mode.Cipher Mode
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SettingsField

Select SHA1.Authentication Type

Select SHA1_80_bit.Authentication Tag Length

Step 74 Select Submit.
Step 75 On the Configuration menu, select VoIP > QOS.
Step 76 On the VoIP QOS Configuration page, enter the following settings.

Table 91: VoIP QOS Configurative Page Settings

SettingsField

Enter 104.Call Control QOS Byte

Enter 184.RTP QOS Byte

Step 77 Select Submit.
Step 78 On the Configuration menu, select IP.
Step 79 On the IP Settings page, enter the following settings.

Table 92: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

SNTP Server IP Address

Step 80 Select Submit.
Step 81 On the Configuration menu, select Tone Detection.
Step 82 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select Busy and do the

following substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
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e) Hang up the third phone but leave the handsets for the other two phones off.

Step 83 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 82c. from the
third phone.

Step 84 Select Learn.
Step 85 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 86 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 85a.
Step 87 Select Learn.
Step 88 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, selectRingback and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 89 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 88a.
Step 90 Select Learn.
Step 91 Select Submit.
Step 92 Hang up the phones that you used in Step 82.
Step 93 On the System menu, select Restart.
Step 94 On the Restart page, select Restart Unit Now.
Step 95 Repeat Step 2 through Step 94 on all remaining PIMG units.

Configuring Unity Connection for Integration with the Avaya Definity G3 Phone
System

After ensuring that the Avaya Definity G3 phone system, the PIMG units, and Unity Connection are ready
for the integration, do the following procedure to set up the integration and to enter the port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
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Step 6 Select Save.
Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 93: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 94: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled
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ConsiderationsField

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.

Table 95: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification
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ConsiderationsField

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note

Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 96: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From
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SettingField

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is

checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

Table 97: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
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Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone
system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.
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C H A P T E R 6
Setting Up an Avaya S8300/S8500/S8700 Digital
PIMG Integration with Cisco Unity Connection

• Setting Up an Avaya S8300/S8500/S8700 Digital PIMG Integration, on page 85

SettingUpanAvayaS8300/S8500/S8700DigitalPIMGIntegration

Task List for Avaya S8300/S8500/S8700 PIMG Integration
Before doing the following tasks to integrate Unity Connection with the Avaya S8300/S8500/S8700 phone
system using PIMGunits (media gateways), confirm that the Unity Connection server is ready for the integration
after completing the server installation, following the tasks in the “Installing Cisco Unity Connection” chapter
of the Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Unity Connection
server requirements have been met. See the Requirements, on page 12 section.

2. Plan how the voice messaging ports are used by Cisco Unity Connection. See the Planning the Usage of
Voice Messaging Ports, on page 7 chapter.

3. Program the Avaya S8300/S8500/S8700 phone system and extensions. See the Programming Avaya
S8300/S8500/S8700 PIMG Phone System for Integration section.

4. Set up the PIMG units. See the Setting Up the Digital PIMG Units section.

5. Create the integration. See the Configuring Unity Connection for Integration with the Avaya
S8300/S8500/S8700 Phone System section.

6. Test the integration. See the Testing the Integration, on page 401 chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Adding New User Templates for Multiple Integrations, on page 407 chapter.

Requirements
This integration supports configurations of the following components:
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Phone System
• An Avaya S8300, Avaya S8500, or Avaya S8700 phone system. The voice messaging ports that connect
to the PIMG units must be compatible with the 7434ND, 8434, 8434D, or 8434DX digital phones.

You must use 2-wire line cards for these voice messaging ports. Otherwise, the voice messaging ports
are not compatible with the 7434ND, 8434, 8434D, or 8434DX digital phones.

• Software version Communication Manager 2.0.

• One or more of the applicable PIMG units. For details, see the Introduction, on page 1 chapter.

• The voice messaging ports in the phone system connected by digital lines to the ports on the PIMG units.

To simplify troubleshooting, we recommend that you connect the voice messaging ports on the phone system
to the ports on the PIMG units in a planned manner. For example, connect the first phone system voice
messaging port to the first port on the first PIMG unit, connect the second phone system voice messaging port
to the second port on the first PIMG unit, and so on. Alternatively, if you have multiple PIMG units, you can
reduce answer times in the event of a PIMG unit failure by connecting the phone system ports to the PIMG
units in a round-robin fashion. For example, connect the first phone system voice messaging port to the first
port on the first PIMG unit, connect the second phone system voice messaging port to the first port on the
second PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.

Programming Avaya S8300/S8500/S8700 PIMG Phone System for Integration
The following programming instructions are provided as an example only. The specific programming for your
phone system may vary depending on its configuration.
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In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Send MWI Requests, do not send calls to it.

Caution

Programming the Avaya S8300/S8500/S8700Phone System

Step 1 Create a coverage path which contains the PIMG unit hunt group number as the coverage point.
Step 2 Assign the coverage path that you created in Step 1 to the user stations that must forward to the voice messaging ports

on the PIMG units when calls are not answered or when the user station is busy, based on one of the Unity Connection
call transfer types shown in Table 98: Call Transfer Types.

Table 98: Call Transfer Types

UsageTransfer Type

Program the user station to forward calls to the pilot number
when:

• The extension is busy.

• The call is not answered.

Release transfer

(blind transfer)

Program the user station to forward calls to the pilot number
only when the call is not answered (on the phone system,
the number of rings before forwarding must be more than
the number of rings to supervise the call). Confirm that call
forwarding is disabled when the extension is busy.

Supervised transfer

Step 3 Use the Add Station <extension number> command (for example, Add Station 2999) to assign an extension number for
each voice messaging port, which is a digital line that connects to the PIMG unit. Set the voice messaging port options
(Table 99: Voice Messaging Port Options for All Lines) and button assignments (Table 100: Button Assignments for All
Lines), and press Enter.

We recommend that you distribute the voice messaging ports among multiple phone system line cards so that
call processing can continue even if a line card becomes inactive.

Note

Table 99: Voice Messaging Port Options for All Lines

SettingOption

Enter the extension number of the digital line.Extension
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SettingOption

Enter 7434ND (recommended).

You can also use the following settings. However, you must
include the extension with each subscriber name when
programming the phone system (for example, “3001 Jane
Doe”). Otherwise, the integration cannot function correctly.

• 8434

• 8434D

• 8434DX

If the setting that you want is not available,
contact the phone system manufacturer.

Note

Type

Enter y.LWC Activation?

Enter y.Restrict Last Appearance?

Enter y.Display Module

Table 100: Button Assignments for All Lines

SettingButton Assignment

Enter call-appr.1

Enter call-appr.2

Enter lwc-store.9

Enter lwc-cancel.10

Step 4 Use the Add Hunt <hunt group number> command (for example, Add Hunt 1) to assign a the voice messaging ports to
a hunt group. Set the following options.

Table 101: Hunt Group Options

SettingOption

Enter the hunt group number.Group Number

Enter the pilot number for the hunt group.Group Extension

Enter ucd.Group Type

Enter the display name for the hunt group.Group Name

Enter N.Queue?

Step 5 Enter the group member assignments for the voice messaging ports that answer calls and press Enter.
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If you plan to set the voice messaging ports to either answer calls or to dial out (for example, to set MWIs), make sure
that you include in the hunt group only the voice messaging ports that are set to answer calls.

For smaller systems, include in the hunt group all voice messaging ports when the ports are set to both answer calls and
dial out (for example, to set MWIs).

Setting Up the Digital PIMG Units
Do the following procedures to set up the digital PIMG units that are connected to the Avaya
S8300/S8500/S8700 phone system.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the PIMG units using digital lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the PIMG units.

Downloading the PIMG Firmware Update Files for Digital PIMG Units
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.
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To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

1. In the tree control on the Downloads Home page, expand Unified Communications> Unified
Communications Applications > Messaging > Cisco Unity and select Cisco Unity Telephony
Integration.

2. On the Log In page, enter your username and password, then select Log In.

3. On the Select a Release page, under Latest Releases, select the most recent release.

4. In the right column, select the version of the firmware for digital PIMG units.

5. On the Download Image page, select Download.

6. On the Supporting Document(s) page, select Agree.

7. In the File Download dialog box, select Save.

8. In the Save As dialog box, browse to the Windows workstation that access the PIMG units, browse to
a directory where you want to save the file, and select Save.

9. In the Download Complete dialog box, select Open. The window for extracting the PIMG firmware
update files appears and select Extract.

10. In the Extract dialog box, browse to the directory where you want the extracted files, and selectExtract.

11. Close the window for the extracting application.

Note

On aWindows workstation with a high-speed Internet connection that access to the PIMG units, go to the following link:

Setting Up the Digital PIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the PIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 2 Connect a PIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.
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Table 102: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
Step 7 On the Upgrade page, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted PIMG firmware

update files.
Step 9 Select Ami<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.

Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file installation fails.
Restarting the PIMG unit at this step may prevent the PIMG unit from functioning correctly.

Step 12 Repeat Step 6 through Step 11 for each of the following files:

• Ami_<xx>.fsh

• Run<xx>FskEcho.dsp

• iNim<xx>.ibt

• iNim<xx>.ilc

• iNim<xx>.iap

Step 13 On the Configuration menu, select Import/Export.
Step 14 On the Import/Export page, select Browse.
Step 15 In the Choose File dialog box, browse to the file DNI_Cfg_Lucent.ini.
Step 16 Select DNI_Cfg_Lucent.ini, and select Open.
Step 17 On the Import/Export page, select Import File.
Step 18 After the file is imported, a message prompting you to restart the PIMG unit appears. Select OK.
Step 19 In the web browser, go to http://10.12.13.74.
Step 20 To sign in, enter the following case-sensitive settings.

Table 103: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 21 Select OK.
Step 22 Do the following substeps to configure an RTP port range of 16384 to 32767.
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Youmust set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to 32767. Otherwise,
Unity Connection cannot answer calls and callers hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. SomeUnity Connection configurations require
a different RTP port range.

Note

a) On the Configuration menu, select Import/Export.
b) On the Import/Export page, under Export Settings, select Export All Settings.
c) In the File Download dialog box, select Save.
d) In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units, browse to a

directory where you want to save the file, and select Save.
e) In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you saved.
f)
g)
h) Locate the line with the following parameter:

gwRTPStartPort

i) Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384

j) Locate the line with the following parameter:

gwRTPEndPort

k) Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

l) Save the file, and exit Notepad.
m) On the Configuration menu of the PIMG unit, select Import/Export.
n) On the Import/Export page, under Browse for Import File, select Browse.
o) In the Choose File dialog box, browse to the file Config.ini that you saved.
p) Select Config.ini, and select Open.
q) On the Import/Export page, select Import File.
r) When prompted to restart the PIMG unit, select OK.
s) When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.
t) To sign in, enter the following case-sensitive settings.

Table 104: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

u) Select OK.

Step 23 On the System menu, select Password.
Step 24 On the Change Password page, enter the following settings.
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Table 105: Change Password Page Settings

SettingField

Enter IpodAdmin.

(This setting is case sensitive.)

Old Password

Enter your new password.

(This setting is case sensitive.)

New Password

Enter your new password.

(This setting is case sensitive.)

Confirm Password

Step 25 Select Change.
Step 26 On the Configuration menu, select Routing Table.
Step 27 On the Routing Table page, under Router Configuration, select VoIP Host Groups.
Step 28 Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 106: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name of
the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select True.

Fault-Tolerant

Step 29 For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity Connection
server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, enter the host name or IP address of the subscriber
server (the second Unity Connection server that you installed) and the server port in the format <host name or IP
address>:5060.

Step 30 For Unity Connection without a cluster, continue to Step 32. For Unity Connection with a cluster configured, select
Add Host.

Step 31 In the second field, enter the host name or IP address of the publisher server (the first Unity Connection server that you
installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the Unity Connection
cluster may not function correctly.

Step 32 Select Submit.
Step 33 Under Router Configuration, select TDM Trunk Groups.
Step 34 Under TDM Trunk Groups, select Add Trunk Group.
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Step 35 Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.

Table 107: First TDM Trunk Group Settings (Inbound Calls)

SettingsField

Enter Inbound_PBX_Calls or another unique name.

This TDM trunk group handles all incoming calls from
the phone system.

Name

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports that handle inbound
calls. For example, enter “*” for all PIMG ports, or enter
“1-6” for the first six PIMG ports.

Port/Channel Content

Step 36 Under TDM Trunk Groups, select Add Trunk Group.
Step 37 Enter the following settings for the second TDM trunk group.

Table 108: Second TDM Trunk Group Settings (MWIs)

SettingsField

EnterMWIs or another unique name.

This TDM trunk group handle outboundMWI calls (where
applicable).

Name

Select Ascending.Selection Direction

Select Cyclic.Selection Mode

Enter the numbers of the PIMG ports that dial out MWIs.
For example, enter “*” for all PIMG ports, or enter “7,8”
for the last two PIMG ports.

Port/Channel Content

Step 38 Under TDM Trunk Groups, select Add Trunk Group.
Step 39 Enter the following settings for the third TDM trunk group.

Table 109: Third TDM Trunk Group Settings (Outbound Calls)

SettingsField

Enter Outbound_PBX_Calls or another unique name.

This TDM trunk group handles all outbound calls from
Unity Connection.

Name

Select Descending.Selection Direction

Select Linear.Selection Mode
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SettingsField

Enter * for all channels in all ports.

Enter the numbers of the PIMG ports that handle outbound
(dialout) calls. For example, enter “*” for all PIMG ports,
or enter “7,8” for the last two PIMG ports.

Port/Channel Content

Step 40 Select Submit.
Step 41 Under Router Configuration, select Inbound VoIP Rules.
Step 42 Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.
Step 43 Select Add Rule.
Step 44 Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 110: First New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable

EnterMWI_Calls or another name.

This inbound VoIP rule handles all MWI calls from Unity
Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address

Step 45 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another inbound VoIP
rule.

Table 111: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 46 Under Outbound Routes, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another rule.
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Table 112: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for MWIs in Step 37. For example, select “MWIs.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 47 Under Inbound VoIP Rules, select Add Rule.
Step 48 Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.

Table 113: Second New Inbound VoIP Rule Settings (Outbound Calls)

SettingsField

Check this check box.Enable

Enter Outbound_UC_Calls or another name.

This inbound VoIP rule handle all outbound calls from
Unity Connection.

Rule Label

Select Call.Request Type

Enter *.Originating VoIP Host Address

Step 49 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.
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Table 114: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 50 Under Outbound Routes, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.

Table 115: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for outbound calls in Step 39. For example, select
“Outbound_PBX_Calls.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 51 Select Submit.
Step 52 Under Router Configuration, select Inbound TDM Rules.
Step 53 Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.
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Table 116: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule handles all incoming calls from
the phone system.

Rule Label

Select Call.Request Type

Select the name of the TDM trunk group that you created
for incoming calls from the phone system in Step 35. For
example, select “Inbound_PBX_Calls.”

Trunk Group

Step 54 Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another rule.

Table 117: Inbound TDM Request Matching Settings

SettingsField

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Name

Step 55 Under Outbound Routes, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another rule.

Table 118: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination
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SettingsField

Select the name of the VoIP host group that you created
for Unity Connection in Step 28.

Host Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 56 If you want to create more Inbound TDM rules, under Inbound TDM Rules, select Add Rule. Otherwise, continue to
Step 58.

Step 57 Repeat Step 53 through Step 56 for all remaining inbound TDM rules that you want to create.
Step 58 Select Submit.
Step 59 On the Configuration menu, select TDM > Digital.
Step 60 On the Digital Telephony page, in the Telephony Switch Type field, select Lucent.
Step 61 Select Submit.
Step 62 On the Configuration menu, select TDM > General.
Step 63 On the TDM General Settings page, enter the following settings.

Table 119: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Leave this field blank.Turn MWI On FAC

Leave this field blank.Turn MWI Off FAC
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SettingsField

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Select No.Disconnect on Fax Cleardown Tone

Step 64 Select Submit.
Step 65 On the Configuration menu, select TDM > Port Enable.
Step 66 On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.
Step 67 Confirm that Yes is selected for all other ports on the PIMG unit.
Step 68 Select Submit.
Step 69 On the Configuration menu, select VoIP > General.
Step 70 On the VoIP General Settings page, enter the following settings.

Table 120: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Select No.SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that the
PIMG unit uses.

DNS Server Address

Select No.DNS Translation of Phone Numbers

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port
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SettingField

Enter 30.TCP Inactivity Timer (sec)

TLS

Select No.TLS Transport Enabled

Enter 5061.TLS Server Port

Select SSLv3 TLSv1.SSL TLS Protocol

Select Yes.Mutual TLS Authentication Required

Enter 30.TLS Inactivity Timer (sec)

Select Yes.Verify TLS Peer Certificate Date

Select Yes.Verify TLS Peer Certificate Trust

Proxy

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Enter 5000.T4 Time (ms)

Monitoring

Select No.Monitor Call Connections

Call Monitor Interval (sec)

Monitor VoIP Hosts

VoIP Host Monitor Interval (sec)

Step 71 Select Submit.
Step 72 On the Configuration menu, select VoIP > Media.
Step 73 On the VoIP Media Settings page, enter the following settings.
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Table 121: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select RFC2833.RTP Fax/Modem Tone Relay Mode

Select Off.RTP Source IP Address Validation

Select Off.RTP Source UDP Port Validation

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select On Demand.RFC 3960 Early Media Support

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Fax

Fax IP-Transport Mode

SRTP

Select RTP Only.SRTP Preference

Select Yes.MKI on Transmit Stream

Select Yes.Key Derivation Enable

Enter 16.Key Derivation Rate

Enter 64.Anti-replay Window Size Hint

Select AES_Counter_Mode.Cipher Mode
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SettingsField

Select SHA1.Authentication Type

Select SHA1_80_bit.Authentication Tag Length

Step 74 Select Submit.
Step 75 On the Configuration menu, select VoIP > QOS.
Step 76 On the VoIP QOS Configuration page, enter the following settings.

Table 122: VoIP QOS Configurative Page Settings

SettingsField

Enter 104.Call Control QOS Byte

Enter 184.RTP QOS Byte

Step 77 Select Submit.
Step 78 On the Configuration menu, select IP.
Step 79 On the IP Settings page, enter the following settings.

Table 123: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

SNTP Server IP Address

Step 80 Select Submit.
Step 81 On the Configuration menu, select Tone Detection.
Step 82 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select Busy and do the

following substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
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e) Hang up the third phone but leave the handsets for the other two phones off.

Step 83 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 82c. from the
third phone.

Step 84 Select Learn.
Step 85 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 86 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 85a.
Step 87 Select Learn.
Step 88 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, selectRingback and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 89 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 88a.
Step 90 Select Learn.
Step 91 Select Submit.
Step 92 Hang up the phones that you used in Step 82.
Step 93 On the System menu, select Restart.
Step 94 On the Restart page, select Restart Unit Now.
Step 95 Repeat Step 2 through Step 94 on all remaining PIMG units.

ConfiguringUnityConnectionforIntegrationwiththeAvayaS8300/S8500/S8700
Phone System

After ensuring that the Avaya S8300/S8500/S8700 phone system, the PIMG units, and Unity Connection are
ready for the integration, do the following procedure to set up the integration and to enter the port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
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Step 6 Select Save.
Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 124: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 125: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled
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ConsiderationsField

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.

Table 126: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification
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ConsiderationsField

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note

Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 127: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From
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SettingField

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is

checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

Table 128: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
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Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone
system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.
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C H A P T E R 7
Setting Up a Mitel SX-200 Digital PIMG
Integration with Cisco Unity Connection

• Setting Up a Mitel SX-200 Digital PIMG Integration, on page 111

Setting Up a Mitel SX-200 Digital PIMG Integration

Task List for Mitel SX-200 PIMG Phone System Integration
Before doing the following tasks to integrate Unity Connection with the Mitel SX-200 phone system using
PIMG units (media gateways), confirm that the Unity Connection server is ready for the integration after
completing the server installation, following the tasks in the “Installing Cisco Unity Connection” chapter of
the Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Unity Connection
server requirements have been met. See the Requirements, on page 12 section.

2. Plan how the voice messaging ports are used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports, on page 7 chapter.

3. Program the Mitel SX-200 phone system and extensions. See the Programming Mitel SX-200 PIMG
Phone System for Integration section.

4. Set up the PIMG units. See the Setting Up the Digital Mitel PIMG Units section.

5. Create the integration. See the Configuring Unity Connection for Integration with Mitel SX-200 Phone
System section.

6. Test the integration. See the Testing the Integration, on page 401 chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Adding New User Templates for Multiple Integrations, on page 407 chapter.

Requirements
This integration supports configurations of the following components:
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Phone System
• Mitel SX-200.

• Software level Lightware 19 or later.

• A DNI Line MC330 line card to support the two-wire station interface.

• One or more of the applicable PIMG units. For details, see the “Introduction” chapter.

• The voice messaging ports in the phone system connected by digital lines to the ports on the PIMG units.

To simplify troubleshooting, we recommend that you connect the voice messaging ports on the phone system
to the ports on the PIMG units in a planned manner. For example, connect the first phone system voice
messaging port to the first port on the first PIMG unit, connect the second phone system voice messaging port
to the second port on the first PIMG unit, and so on. Alternatively, if you have multiple PIMG units, you can
reduce answer times in the event of a PIMG unit failure by connecting the phone system ports to the PIMG
units in a round-robin fashion. For example, connect the first phone system voice messaging port to the first
port on the first PIMG unit, connect the second phone system voice messaging port to the first port on the
second PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.

Programming Mitel SX-200 PIMG Phone System for Integration
The following programming instructions are provided as an example only. The specific programming for your
phone system may vary depending on its configuration.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Send MWI Requests, do not send calls to it.

Caution
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Programming the Mitel SX-200 Phone System

Step 1 On the phone system console, go to the Main menu and select Select Forms.
Step 2 On the Select Forms screen, select Class of Service Options Assignment.
Step 3 On the Class of Service Options Assignment screen, build a class of service template for the ports that connect to the

PIMG units. The following is an example of a class of service template.

CLASS OF SERVICE OPTIONS ASSIGNMENT
Class of service number : 1
Comments :
Option Select
-------------------------------------------------------------
Account Code Verified. . . . . . . . . . . . . . . . . . No
ACD Silent Monitoring - Accept . . . . . . . . . . . . . No
ACD Silent Monitoring - Allowed. . . . . . . . . . . . . No
ACD Silent Monitoring - Notification . . . . . . . . . . No
ANI/DNIS/ISDN Number Delivery Trunk . . . . . . . . . . Yes
Auto Answer Allowed. . . . . . . . . . . . . . . . . . . Yes
Brokers Call . . . . . . . . . . . . . . . . . . . . . . No
Busy Override Security . . . . . . . . . . . . . . . . . No
Call Announce Line . . . . . . . . . . . . . . . . . . . Yes
Call Forwarding - Accept . . . . . . . . . . . . . . . . Yes
Call Forwarding (External Destination) . . . . . . . . . Yes
Call Forwarding (Internal Destination) . . . . . . . . . Yes
Call Forwarding - Override . . . . . . . . . . . . . . . No
Call Hold. . . . . . . . . . . . . . . . . . . . . . . . Yes
Call Hold - Remote Retrieve. . . . . . . . . . . . . . . Yes
Call Hold - Retrieve with Hold Key . . . . . . . . . . . No
Call Pickup - Dialed : Accept. . . . . . . . . . . . . . Yes
Call Pickup - Directed : Accept. . . . . . . . . . . . . Yes
Call Privacy . . . . . . . . . . . . . . . . . . . . . . No
Call Reroute after CFFM to busy destination. . . . . . . No
Call Waiting - Swap. . . . . . . . . . . . . . . . . . . No
Calling Name Display - Internal . ONS. . . . . . . . . . Yes
Calling Number Display - Internal . ONS. . . . . . . . . Yes
Camp-on Tone Security. . . . . . . . . . . . . . . . . . No
Check COR after PSTN Dial Tone . . . . . . . . . . . . . No
Clear All Features Remote. . . . . . . . . . . . . . . . No
Conference Call. . . . . . . . . . . . . . . . . . . . . Yes
COV/ONS/E&M Voice Mail Port. . . . . . . . . . . . . . . No
DASS II OLI/TLI Provided . . . . . . . . . . . . . . . . No
Dialed Night Service . . . . . . . . . . . . . . . . . . Yes
Disable Call Reroute Chaining On Diversion . . . . . . . No
Disable Send Message . . . . . . . . . . . . . . . . . . No
Display ANI/ISDN Calling Number Only . . . . . . . . . . No
Display ANI/DNIS/ISDN Calling/Called Number. . . . . . . Yes
Display Caller ID on multicall/keylines. . . . . . . . . Yes
Display DNIS/Called Number Before Digit Modification . . Yes
Display Dialed Digits during Outgoing Calls. . . . . . . Yes
Display Held Call ID on Transfer . . . . . . . . . . . . No
Do Not Disturb . . . . . . . . . . . . . . . . . . . . . Yes
Do Not Disturb - Access to Remote Phones . . . . . . . . Yes
Do Not Disturb - Permanent . . . . . . . . . . . . . . . No
Emergency Call Notification - Audio. . . . . . . . . . . No
Emergency Call Notification - Visual . . . . . . . . . . No
Enable Call Duration Limit on External Calls . . . . . . No
Enable Call Duration Limit on Internal Calls . . . . . . No
Executive Busy Override. . . . . . . . . . . . . . . . . No
External Trunk Standard Ringback . . . . . . . . . . . . No
Flexible Answer Point. . . . . . . . . . . . . . . . . . No
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Follow 2nd Alternate Reroute for Recall to Busy ACD Agent No
Forced Verified Account Code . . . . . . . . . . . . . . No
Forced Non-Verified Account Code . . . . . . . . . . . . No
Group Call Forward Follow Me - Accept. . . . . . . . . . No
Group Call Forward Follow Me - Allow . . . . . . . . . . No
Group Page - Accept. . . . . . . . . . . . . . . . . . . No
Group Page - Allow . . . . . . . . . . . . . . . . . . . No
Handset Volume Adjustment - Saved. . . . . . . . . . . . No
Handsfree AnswerBack Allowed . . . . . . . . . . . . . . Yes
HCI/CTI/TAPI Call Control Allowed. . . . . . . . . . . . No
HCI/CTI/TAPI Monitor Allowed . . . . . . . . . . . . . . No
Head Set Switch Mute . . . . . . . . . . . . . . . . . . No
Hot Desk Remote Logout Enabled . . . . . . . . . . . . . No
Hot Desk Login Accept. . . . . . . . . . . . . . . . . . No
Hotel Room Extension . . . . . . . . . . . . . . . . . . No
Hotel Room Monitor Setup Allowed . . . . . . . . . . . . No
Hotel Room Monitoring Allowed. . . . . . . . . . . . . . No
Hotel/Motel Room Personal Wakeup Call Allowed. . . . . . No
Hotel/Motel Room Remote Wakeup Call Allowed. . . . . . . No
Individual Trunk Access. . . . . . . . . . . . . . . . . Yes
Keep TelDir Entry on Check Out . . . . . . . . . . . . . No
Local Music On Hold source . . . . . . . . . . . . . . . No
Loudspeaker Pager Override . . . . . . . . . . . . . . . Yes
Loudspeaker Pager Equivalent Zone Override Security. . . No
Message Waiting. . . . . . . . . . . . . . . . . . . . . Yes
Message Waiting - Audible Tone Notification. . . . . . . Yes
Message Waiting - Deactivate On Off-Hook . . . . . . . . No
Message Waiting - Inquire. . . . . . . . . . . . . . . . Yes
Multiline Set Loop Test. . . . . . . . . . . . . . . . . No
Multiline Set Message Center Remote Read Allowed . . . . No
Multiline Set Music. . . . . . . . . . . . . . . . . . . No
Multiline Set On Hook Dialing. . . . . . . . . . . . . . Yes
Multiline Set Phonebook Allowed. . . . . . . . . . . . . Yes
Multiline Set Voice Mail Callback Message Erasure Allowed No
Name Suppression on outgoing Trunk Call. . . . . . . . . No
Non-DID Extension. . . . . . . . . . . . . . . . . . . . No
Non-Prime Public Network Identity. . . . . . . . . . . . No
Non-Verified Account Code. . . . . . . . . . . . . . . . Yes
Off-Hook Voice Announce Allowed. . . . . . . . . . . . . No
ONS CLASS/CLIP: Message Waiting Activate/Deactivate. . . No
ONS CLASS/CLIP: Set. . . . . . . . . . . . . . . . . . . No
ONS CLASS/CLIP: Visual Call Waiting. . . . . . . . . . . Yes
ONS/OPS Internal Ring Cadence for External Callers . . . No
Override Interconnect Restriction on Transfer. . . . . . No
Pager Access - All Zones . . . . . . . . . . . . . . . . Yes
Pager Access - Individual Zones. . . . . . . . . . . . . No
Privacy Released . . . . . . . . . . . . . . . . . . . . No
Public Network Access via DPNSS. . . . . . . . . . . . . Yes
Public Network Identity Provided . . . . . . . . . . . . Yes
Public Network To Public Network Connection Allowed. . . Yes
Public Trunk . . . . . . . . . . . . . . . . . . . . . . Yes
R2 Call Progress Tones . . . . . . . . . . . . . . . . . No
Record-A-Call Active . . . . . . . . . . . . . . . . . . No
Record-A-Call - Start Recording Automatically. . . . . . No
Record-A-Call - Save Recording on Hang-up. . . . . . . . No
Recorded Announcement Device . . . . . . . . . . . . . . No
Recorded Announcement Device - Advanced. . . . . . . . . No
Redial Facilities. . . . . . . . . . . . . . . . . . . . Yes
Ringing Line Select. . . . . . . . . . . . . . . . . . . No
SC1000 Attendant Basic Function Key (Yes/NO) . . . . . . No
SMDR - External. . . . . . . . . . . . . . . . . . . . . No
SMDR - Internal. . . . . . . . . . . . . . . . . . . . . No
Speak@Ease Preferred . . . . . . . . . . . . . . . . . . No
Suite Services Enabled . . . . . . . . . . . . . . . . . No
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Suppress Simulated CCM after ISDN Progress . . . . . . . No
Third Party Call Forward Follow Me - Accept. . . . . . . Yes
Third Party Call Forward Follow Me - Allow . . . . . . . Yes
Timed Reminder Allowed . . . . . . . . . . . . . . . . . Yes
Trunk Calling Party Identification . . . . . . . . . . . Yes
Trunk Flash Allowed. . . . . . . . . . . . . . . . . . . No
Use Held Party Device for Call Re-routing. . . . . . . . Yes
Use Called Party Call Hold Timer . . . . . . . . . . . . No
Voice Mail Softkey . . . . . . . . . . . . . . . . . . . No
Timer Options / Account Code Length Value
Account Code Length (2-12) . . . . . . . . . . . . . . . 12
After Answer Display Time(0-60 secs, Blank=off). . . . .
ANSWER PLUS - Delay To Message Timer (0-300 secs). . . . 20
ANSWER PLUS - Expected Offhook Timer (0-255 secs). . . . 30
ANSWER PLUS - Message Length Timer (0-120 secs). . . . . 10
ANSWER PLUS - System Reroute Timer (0-720 secs). . . . . 0
Attendant Busy-out Timer (1-1440 mins) . . . . . . . . . 10
Auto Camp-on Timer (0-30 secs, Blank for Off). . . . . . 10
Busy Tone Timer ( 1-120 secs). . . . . . . . . . . . . . 30
Call Duration (2-120 mins) . . . . . . . . . . . . . . . 10
Call Duration Forced Cleardown Timer (0-10 mins) . . . . 0
Call Forward - Delay (0-125 secs). . . . . . . . . . . . 0
Call Forward No Answer Timer (0-125 secs). . . . . . . . 15
Call Hold Timer (10-600 secs). . . . . . . . . . . . . . 30
Camp-on Recall Timer (0-180 secs). . . . . . . . . . . . 110
Delay Ring Timer (5-60 secs) . . . . . . . . . . . . . . 10
Dialing Conflict Timer (2-5 secs). . . . . . . . . . . . 3
Emergency Call - Audio Level for Set(Ringer/Medium/High) Ringer
First Digit Timer (5-60 secs). . . . . . . . . . . . . . 15
Inter-Digit Timer (3-60 secs). . . . . . . . . . . . . . 10
Lockout Timer ( 1-60 secs) . . . . . . . . . . . . . . . 45
ACD 2000 Logout Agent No Answer Timer (0-125 secs) . . . 15
Message Waiting Ringing Start Time (00:00 to 23:59). . . :
Message Waiting Ringing Stop Time (00:00 to 23:59) . . .
No Answer Recall Timer (0-125 secs). . . . . . . . . . . 17
ONS VMail-Delay Dial Tone Timer (5-20 secs). . . . . . . 5
Ringing Timer (60-300 secs). . . . . . . . . . . . . . . 180
Work Timer (0-600 secs). . . . . . . . . . . . . . . . . 0
DTMF Key Assignments Value
Key A. . . . . . . . . . . . . . . . . . . . . . . . . .
Key B. . . . . . . . . . . . . . . . . . . . . . . . . .
Key C. . . . . . . . . . . . . . . . . . . . . . . . . .
Key D. . . . . . . . . . . . . . . . . . . . . . . . . .

Step 4 On the Select Forms screen, selectMultiline Set Forms.
Step 5 On the Multiline Set Forms screen, selectMultiline Set Assignment.
Step 6 On the Multiline Set Assignment screen, select DNI Circuit Assignment.
Step 7 On the DNI Circuit Assignment screen, enter the following settings for each wiring address used by the ports connecting

to the PIMG units.

Table 129: Settings for DNI Circuit Assignment Screen

SettingField

Enter the cabinet for the DNI Line MC330 line card.Cabinet

Enter the shelf for the DNI Line MC330 line card.Shelf

Enter the slot for the DNI Line MC330 line card.Slot
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SettingField

Enter the circuit for the DNI Line MC330 line card.Circuit

Select DNI Line.Card Type

Select Superset 430.Device Type: Channel #1

Step 8 Return to the Multiline Set Forms screen.
Step 9 On the Multiline Set Forms screen, selectMultiline Set Key Assignment.
Step 10 On theMultiline Set Key Assignment screen, assign each wiring address to an individual digital station set and directory

number as shown in the following table.

Table 130: Settings for Multiline Set Key Assignment Screen

SettingField

Enter the directory number for the station.Prime Directory Number

Select ring.Prime Ring Type

Select single line.Prime Line Type

For each key number, select not assigned.Line Type

Step 11 On the Main menu, select Station Service Set Forms.
Step 12 On the Station Service Set Forms screen, select Station Service Assignment.
Step 13 On the Station Service Assignment screen, attach each individual digital station set to the class of service template that

you built in Step 3. The following example shows a digital station attached to a class of service template.

STATION SERVICE ASSIGNMENT

Directory|Intercept| Class of Service |Class of Restriction| Default |COMP
Number | Number |___________________|____________________| Account |Zone

|DAY| NIGHT1| NIGHT2| DAY| NIGHT1| NIGHT2|Code Index | ID
______________________________________________________________________________
501 | 1 | 1| 1 | 1 | 1 | 1 | 1 | 1
502 | 1 | 1| 1 | 1 | 1 | 1 | 1 | 1
503 | 1 | 1| 1 | 1 | 1 | 1 | 1 | 1
504 | 1 | 1| 1 | 1 | 1 | 1 | 1 | 1
505 | 1 | 1| 1 | 1 | 1 | 1 | 1 | 1
506 | 1 | 1| 1 | 1 | 1 | 1 | 1 | 1
507 | 1 | 1| 1 | 1 | 1 | 1 | 1 | 1
508 | 1 | 1| 1 | 1 | 1 | 1 | 1 | 1

Step 14 On the Main menu, select Group Forms.
Step 15 On the Group Forms screen, select Hunt Group Assignment.
Step 16 On the Hunt Group Assignment screen, enter the following settings to make a hunt group to act as a central inbound

route for calls.
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Table 131: Settings for Hunt Group Assignment Screen

SettingField

Enter the pilot number for Unity Connection.Pilot Number

Enter PIMG hunt group or another name.Name

Select the hunt mode that you want to use:

• Circular

• Linear

Hunt Mode

Select Voice.Group Type

Step 17 In the Hunt Group Assignment table of the Hunt Group Assignment screen, assign the directory number for each port
connecting to the PIMG units as follows.

Table 132: Hunt Group Assignment Table

NameDirectory NumberMember

Enter PIMG Port 1.<the directory number of the first port>1

Enter PIMG Port 2.<the directory number of the second
port>

2

Enter PIMG Port 3.<the directory number of the third
port>

3

Enter PIMG Port 4.<the directory number of the next
port>

4

Enter PIMG Port 5.<the directory number of the next
port>

5

Enter PIMG Port 6.<the directory number of the next
port>

6

Enter PIMG Port 7.<the directory number of the next
port>

7

Enter PIMG Port 8.<the directory number of the next
port>

8

. . .<directory numbers of additional
ports>

. . .

Enter PIMG Port <n>.<the directory number of the last port><last member>

Step 18 Program each phone to forward calls to the pilot number hunt group, based on one of the following Unity Connection
call transfer types.
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Table 133: Call Transfer Types

UsageTransfer Types

Program the phone to forward calls to the pilot number
when:

• The extension is busy

• The call is not answered

Release transfer (blind transfer)

Program the user station to forward calls to the pilot
number only when the call is not answered (on the phone
system, the number of rings before forwarding must be
more than the number of rings to supervise the call).
Confirm that call forwarding is disabledwhen the extension
is busy.

Supervised transfer

Setting Up the Digital Mitel PIMG Units
Do the following procedures to set up the digital Mitel PIMG units that are connected to the Mitel SX-200
phone system.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the digital Mitel PIMG units using digital lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the PIMG units.

Downloading the PIMG Firmware Update Files for Digital Mitel PIMG Units
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.
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To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

1. In the tree control on the Downloads Home page, expand Unified Communications> Unified
Communications Applications > Messaging > Cisco Unity and select Cisco Unity Telephony
Integration.

2. On the Log In page, enter your username and password, then select Log In.

3. On the Select a Release page, under Latest Releases, select the most recent release.

4. In the right column, select the version of the firmware for digital Mitel PIMG units.

5. On the Download Image page, select Download.

6. On the Supporting Document(s) page, select Agree.

7. In the File Download dialog box, select Save.

8. In the Save As dialog box, browse to theWindows workstation that have access the PIMG units, browse
to a directory where you want to save the file, and select Save.

9. In the Download Complete dialog box, select Open. The window for extracting the PIMG firmware
update files appears and select Extract.

10. In the Extract dialog box, browse to the directory where you want the extracted files, and selectExtract.

11. Close the window for the extracting application.

To Set Up the Digital Mitel PIMG Units (Firmware Version 6.x)
12. On the Windows workstation, add a temporary route to enable access to the PIMG units.

1. On the Windows Start menu, select Run.

2. Enter cmd, and press Enter. The Command Prompt window appears.

3. At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press
Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add
10.12.13.74<space>198.1.3.25” in the Command Prompt window.

4. Close the Command Prompt window.

13. Connect a PIMG unit to the network.

14. In the web browser, go to http://10.12.13.74.

15. To sign in, enter the following case-sensitive settings.

Note
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Table 134: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

1. Select OK.

2. On the System menu, select Upgrade.

3. On the Upgrade page, select Browse.

4. In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted
PIMG firmware update files.

5. SelectMtl_<xx > .app (where <xx> is multiple digits), and select Open.

6. On the Upgrade page, select Install File.

7. After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.

Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file
installation fails. Restarting the PIMG unit at this step may prevent the PIMG unit from functioning
correctly.

8. Repeat Step 6 through Step 11 for each of the following files:

• Mtl_<xx>.fsh

• Run<xx>FskEcho.dsp

• Mtl<xx>.lca

9. On the Configuration menu, select Import/Export.

10. On the Import/Export page, select Browse.

11. In the Choose File dialog box, browse to the file MTLDNI_Cfg_Mitel.ini.

12. SelectMTLDNI_Cfg_Mitel.ini, and select Open.

13. On the Import/Export page, select Import File.

14. After the file is imported, a message prompting you to restart the PIMG unit appears. Select OK.

15. In the web browser, go to http://10.12.13.74.

16. To sign in, enter the following case-sensitive settings.

Table 135: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password
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1. Select OK.

2. If your Unity Connection system must have an RTP port range of 16384 to 32767, do the following
substeps. Otherwise, continue to Step 23.

You must set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to
32767. Otherwise, Unity Connection cannot answer calls,and callers hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. Some Unity Connection configurations require
a different RTP port range.

Note

1. On the Configuration menu, select Import/Export.

2. On the Import/Export page, under Export Files, select Export All Settings.

3. In the File Download dialog box, select Save.

4. In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units,
browse to a directory where you want to save the file, and select Save.

5. In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you
saved.

6. Locate the line with the following parameter:

gwRTPStartPort

7. Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384

8. Locate the line with the following parameter:

gwRTPEndPort

9. Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

10. Save the file, and exit Notepad.

11. On the Configuration menu of the PIMG unit, select Import/Export.

12. On the Import/Export page, under Browse for Import File, select Browse.

13. In the Choose File dialog box, browse to the file Config.ini that you saved.

14. Select Config.ini, and select Open.

15. On the Import/Export page, select Import File.

16. When prompted to restart the PIMG unit, select OK.

17. When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.

18. To sign in, enter the following case-sensitive settings.

PIMG Integration Guide for Cisco Unity Connection Release 12.X
121

Setting Up a Mitel SX-200 Digital PIMG Integration with Cisco Unity Connection
Downloading the PIMG Firmware Update Files for Digital Mitel PIMG Units



Table 136: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

1. Select OK.

1. On the System menu, select Password.

2. On the Change Password page, enter the following settings.

Table 137: Change Password Page Settings

SettingField

Enter IpodAdmin. (This setting is case sensitive.)Old Password

Enter your new password. (This setting is case
sensitive.)

New Password

Enter your new password. (This setting is case
sensitive.)

Confirm Password

1. Select Change.

2. On the Configuration menu, select Routing Table.

3. On the Routing Table page, under Router Configuration, select VoIP Host Groups.

4. Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 138: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name
of the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select
False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select
True.

Fault-Tolerant

1. For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity
Connection server and the server port in the format <host name or IP address>:5060.
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For Unity Connection with a cluster configured, under Host List, enter the host name or IP address of the
subscriber server (the second Unity Connection server that you installed) and the server port in the format
<host name or IP address>:5060.

1. For Unity Connectionwithout a cluster, continue to Step 32. For Unity Connectionwith a cluster configured,
select Add Host.

2. In the second field, enter the host name or IP address of the publisher server (the first Unity Connection
server that you installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the
Unity Connection cluster may not function correctly.

3. Select Submit.

4. Under Router Configuration, select TDM Trunk Groups.

5. Under TDM Trunk Groups, select Add Trunk Group.

6. Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.

Table 139: First TDM Trunk Group Settings (Inbound Calls)

SettingsField

Enter Inbound_PBX_Calls or another unique name.

This TDM trunk group handles all incoming calls
from the phone system.

Name

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports handle inbound
calls. For example, enter “*” for all PIMG ports, or
enter “1-6” for the first six PIMG ports.

Port/Channel Content

1. Under TDM Trunk Groups, select Add Trunk Group.

2. Enter the following settings for the second TDM trunk group.

Table 140: Second TDM Trunk Group Settings (MWIs)

SettingsField

EnterMWIs or another unique name.

This TDM trunk group handles outbound MWI calls
(where applicable).

Name

Select Ascending.Selection Direction

Select Cyclic.Selection Mode
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SettingsField

Enter the numbers of the PIMG ports that dial out
MWIs. For example, enter “*” for all PIMG ports, or
enter “7,8” for the last two PIMG ports.

Port/Channel Content

1. Under TDM Trunk Groups, select Add Trunk Group.

2. Enter the following settings for the third TDM trunk group.

Table 141: Third TDM Trunk Group Settings (Outbound Calls)

SettingsField

EnterOutbound_PBX_Calls or another unique name.

This TDM trunk group handles all outbound calls
from Unity Connection.

Name

Select Descending.Selection Direction

Select Linear.Selection Mode

Enter * for all channels in all ports.

Enter the numbers of the PIMG ports that handles
outbound (dialout) calls. For example, enter “*” for
all PIMG ports, or enter “7,8” for the last two PIMG
ports.

Port/Channel Content

1. Select Submit.

2. Under Router Configuration, select Inbound VoIP Rules.

3. Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.

4. Select Add Rule.

5. Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 142: First New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable

EnterMWI_Calls or another name.

This inbound VoIP rule handles all MWI calls from
Unity Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address

1. Under Inbound VoIP Request Matching, enter the following settings.
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The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another
rule.

Table 143: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

1. Under Outbound Routes, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another
rule.

Table 144: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you
created for MWIs in Step 37. For example, select
“MWIs.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

1. Under Inbound VoIP Rules, select Add Rule.
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2. Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.

Table 145: Second New Inbound VoIP Rule Settings (Outbound Calls)

SettingsField

Check this check box.Enable

Enter Outbound_UC_Calls or another name.

This inbound VoIP rule handles all outbound calls
from Unity Connection.

Rule Label

Select Call.Request Type

Enter *.Originating VoIP Host Address

1. Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another
rule.

Table 146: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

1. Under Outbound Routes, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another
rule.

Table 147: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you
created for outbound calls in Step 39. For example,
select “Outbound_PBX_Calls.”

Trunk Group
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SettingsField

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

1. Select Submit.

2. Under Router Configuration, select Inbound TDM Rules.

3. Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.

Table 148: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule handles all incoming calls
from the phone system.

Rule Label

Select Call.Request Type

Select the name of the TDM trunk group that you
created for incoming calls from the phone system in
Step 35. For example, select “Inbound_PBX_Calls.”

Trunk Group

1. Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another
rule.

Table 149: Inbound TDM Request Matching Settings

SettingsField

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Number
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SettingsField

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Name

1. Under Outbound Routes, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another
rule.

Table 150: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination

Select the name of the VoIP host group that you
created for Unity Connection in Step 28.

Host Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

1. If you want to create more Inbound TDM rules, under Inbound TDM Rules, selectAdd Rule. Otherwise,
continue to Step 58.

2. Repeat Step 53 through Step 56 for all remaining inbound TDM rules that you want to create.
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3. Select Submit.

4. On the Configuration menu, select TDM > General.

5. On the TDM General Settings page, enter the following settings.

Table 151: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Enter the code that turns MWIs on.Turn MWI On FAC

Enter the code that turns MWIs off.Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Select No.Disconnect on Fax Cleardown Tone

1. Select Submit.

2. On the Configuration menu, select TDM > Port Enable.

3. On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.

4. Confirm that Yes is selected for all other ports on the PIMG unit.

5. Select Submit.

6. On the Configuration menu, select VoIP > General.

7. On the VoIP General Settings page, enter the following settings.

Table 152: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name
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SettingField

Select UDP.Transport Type

Select No.Call as Domain Name

Select No.SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that
the PIMG unit uses.

DNS Server Address

Select No.DNS Translation of Phone Numbers

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Enter 30.TCP Inactivity Timer (sec)

TLS

Select No.TLS Transport Enabled

Enter 5061.TLS Server Port

Select SSLv3 TLSv1.SSL TLS Protocol

Select Yes.Mutual TLS Authentication Required

Enter 30.TLS Inactivity Timer (sec)

Select Yes.Verify TLS Peer Certificate Date

Select Yes.Verify TLS Peer Certificate Trust

Proxy

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port
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SettingField

Enter 10.Proxy Query Interval

Timing

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Enter 5000.T4 Time (ms)

Monitoring

Select No.Monitor Call Connections

Call Monitor Interval (sec)

Monitor VoIP Hosts

VoIP Host Monitor Interval (sec)

1. Select Submit.

2. On the Configuration menu, select VoIP > Media.

3. On the VoIP Media Settings page, enter the following settings.

Table 153: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select RFC2833.RTP Fax/Modem Tone Relay Mode

Select Off.RTP Source IP Address Validation

Select Off.RTP Source UDP Port Validation

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select On Demand.RFC 3960 Early Media Support

PIMG Integration Guide for Cisco Unity Connection Release 12.X
131

Setting Up a Mitel SX-200 Digital PIMG Integration with Cisco Unity Connection
Downloading the PIMG Firmware Update Files for Digital Mitel PIMG Units



SettingsField

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Frames Per Packet

Fax

Fax IP-Transport Mode

SRTP

Select RTP Only.SRTP Preference

Select Yes.MKI on Transmit Stream

Select Yes.Key Derivation Enable

Enter 16.Key Derivation Rate

Enter 64.Anti-replay Window Size Hint

Select AES_Counter_Mode.Cipher Mode

Select SHA1.Authentication Type

Select SHA1_80_bit.Authentication Tag Length

1. Select Submit.

2. On the Configuration menu, select VoIP > QOS.

3. On the VoIP QOS Configuration page, enter the following settings.

Table 154: VoIP QOS Configurative Page Settings

SettingsField

Enter 104.Call Control QOS Byte

PIMG Integration Guide for Cisco Unity Connection Release 12.X
132

Setting Up a Mitel SX-200 Digital PIMG Integration with Cisco Unity Connection
Downloading the PIMG Firmware Update Files for Digital Mitel PIMG Units



SettingsField

Enter 184.RTP QOS Byte

1. Select Submit.

2. On the Configuration menu, select IP.

3. On the IP Settings page, enter the following settings.

Table 155: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the
PIMG unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is
different from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway
router that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

SNTP Server IP Address

1. Select Submit.

2. On the Configuration menu, select Tone Detection.

3. On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select
Busy and do the following substeps to verify that the tone is correct.

1. From a available phone, call a second phone.

2. Answer the second phone when it rings, and leave both handsets off so that both phones are busy.

3. From a third phone, dial one of the busy phones.

4. Confirm that you hear a busy tone.

5. Hang up the third phone but leave the handsets for the other two phones off.

4. Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 79c.
from the third phone.

5. Select Learn.

6. On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do
the following substeps to verify that the tone is correct.

1. From an available phone, dial an extension that does not exist.
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2. Confirm that you hear the reorder or error tone.

3. Hang up the phone.

7. Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 82a.

8. Select Learn.

9. On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Ringback and
do the following substeps to verify that the tone is correct.

1. From an available phone, dial an extension that does exist.

2. Confirm that you hear the ringback tone.

3. Hang up the phone.

10. Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 85a.

11. Select Learn.

12. Select Submit.

13. Hang up the phones that you used in Step 79.

14. On the System menu, select Restart.

15. On the Restart page, select Restart Unit Now.

16. Repeat Step 2 through Step 91 on all remaining PIMG units.

SUMMARY STEPS

1. On a Windows workstation that have access to the PIMG units, go to the following link:

DETAILED STEPS

On a Windows workstation that have access to the PIMG units, go to the following link:

Configuring Unity Connection for Integration with Mitel SX-200 Phone System
After ensuring that the Mitel SX-200 phone system, the PIMG units, and Unity Connection are ready for the
integration, do the following procedure to set up the integration and to enter the port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
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Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without
voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
Step 6 Select Save.
Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 156: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 157: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled
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ConsiderationsField

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.

Table 158: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification
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ConsiderationsField

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note

Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 159: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From
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SettingField

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is

checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

Table 160: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
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Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone
system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.
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C H A P T E R 8
Setting Up a Mitel SX-2000 Digital PIMG
Integration with Cisco Unity Connection

• Setting Up a Mitel SX-2000 Digital PIMG Integration, on page 141

Setting Up a Mitel SX-2000 Digital PIMG Integration

Task List for Mitel SX-2000 PIMG Phone System Integration
Before doing the following tasks to integrate Unity Connection with the Mitel SX-2000 phone system using
PIMG units (media gateways), confirm that the Unity Connection server is ready for the integration after
completing the server installation, following the tasks in the “Installing Cisco Unity Connection” chapter of
the Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Unity Connection
server requirements have been met. See the Requirements, on page 12 section.

2. Plan how the voice messaging ports are used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports, on page 7 chapter.

3. Program the Mitel SX-2000 phone system and extensions. See the Programming Mitel SX-2000 PIMG
Phone System for Integration section.

4. Set up the PIMG units. See the Setting Up the Digital Mitel PIMG Units section.

5. Create the integration. See the Creating an Integration, on page 29 section.

6. Test the integration. See the Testing the Integration, on page 401 chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Adding New User Templates for Multiple Integrations, on page 407 chapter.

Requirements
This integration supports configurations of the following components:
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Phone System
• Mitel SX-2000.

• One or more of the applicable PIMG units. For details, see the “Introduction” chapter.

• The voice messaging ports in the phone system connected by digital lines to the ports on the PIMG units.

To simplify troubleshooting, we recommend that you connect the voice messaging ports on the phone system
to the ports on the PIMG units in a planned manner. For example, connect the first phone system voice
messaging port to the first port on the first PIMG unit, connect the second phone system voice messaging port
to the second port on the first PIMG unit, and so on. Alternatively, if you have multiple PIMG units, you can
reduce answer times in the event of a PIMG unit failure by connecting the phone system ports to the PIMG
units in a round-robin fashion. For example, connect the first phone system voice messaging port to the first
port on the first PIMG unit, connect the second phone system voice messaging port to the first port on the
second PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.

Programming Mitel SX-2000 PIMG Phone System for Integration
The following programming instructions are provided as an example only. The specific programming for your
phone system may vary depending on its configuration.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Send MWI Requests, do not send calls to it.

Caution

Do the following steps to program the Mitel SX-2000 phone system.

Step 1 On the phone system console, go to the Main Forms screen, and selectMultiline Set Forms.
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Step 2 On the Multiline Set Forms screen, selectMultiline Set Assignment.
Step 3 On the Multiline Set Assignment screen, select DNI Circuit Assignment.
Step 4 On the DNI Circuit Assignment screen, enter the following options.

Table 161: DNI Circuit Assignment Options

SettingField

Enter 2.Cabinet

Enter 1.Shelf

Enter 7.Slot

Enter 4.Circuit

Select DNI Line.Card Type

Select Superset 430.Device Type: Channel #1

Step 5 Return to the Multiline Set Forms screen.
Step 6 On the Multiline Set Forms screen, selectMultiline Set Key Assignment.
Step 7 On the Multiline Set Key Assignment screen, enter the following options.

Table 162: Multiline Set Key Assignment Options

SettingField

Enter the first directory number.Prime Directory Number

Select not assigned.Key Number: 2

Select not assigned.Key Number: 3

Select not assigned.Key Number: 4

Select not assigned.Key Number: 5

Select not assigned.Key Number: 6

Select not assigned.Key Number: 7

Select not assigned.Key Number: 8

Select not assigned.Key Number: 9

Select not assigned.Key Number: 10

Select not assigned.Key Number: 11

Step 8 Return to the Form Groups screen.
Step 9 On the Form Groups screen, select Group Forms.
Step 10 On the Group Forms screen, select Hunt Group Assignment.
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Step 11 On the Hunt Group Assignment screen, enter the following options.

Table 163: Hunt Group Assignment Options

SettingField

Enter the pilot number for Unity Connection.Pilot Number

Enter IP gateway hunt.Name

Select the hunt mode that you want to use. For example,
select “Circular.”

Hunt Mode

Step 12 In the Hunt Group Assignment table of the Hunt Group Assignment screen, assign the directory number for each port
on the PIMG units connected to the phone system as follows.

Table 164: Hunt Group Assignment Table

NameDirectory NumberMember

Enter IP gateway Port 1.<the prime directory number>1

Enter IP gateway Port 2.<the second directory number>2

Enter IP gateway Port 3.<the third directory number>3

Enter IP gateway Port 4.<the next directory number>4

Enter IP gateway Port 5.<the next directory number>5

Enter IP gateway Port 6.<the next directory number>6

Enter IP gateway Port 7.<the next directory number>7

Enter IP gateway Port 8.<the next directory number>8

. . .<additional directory numbers>. . .

Enter IP gateway Port <n>.<the last directory number><last member>

Setting Up the Digital Mitel PIMG Units
Do the following procedures to set up the digital Mitel PIMG units that are connected to the Mitel SX-2000
phone system.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the digital Mitel PIMG units using digital lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.
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Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the PIMG units.

Downloading PIMG Firmware Update Files for Digital Mitel PIMG Units
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.

To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

1. In the tree control on the Downloads Home page, expand Unified Communications> Unified
Communications Applications > Messaging > Cisco Unity and select Cisco Unity Telephony
Integration.

2. On the Log In page, enter your username and password, then select Log In.

3. On the Select a Release page, under Latest Releases, select the most recent release.

4. In the right column, select the version of the firmware for digital Mitel PIMG units.

5. On the Download Image page, select Download.

6. On the Supporting Document(s) page, select Agree.

7. In the File Download dialog box, select Save.

8. In the Save As dialog box, browse to theWindows workstation that have access the PIMG units, browse
to a directory where you want to save the file, and select Save.

9. In the Download Complete dialog box, select Open. The window for extracting the PIMG firmware
update files appears and select Extract.

10. In the Extract dialog box, browse to the directory where you want the extracted files, and selectExtract.

11. Close the window for the extracting application.

Note

On aWindows workstation with a high-speed Internet connection that have access to the PIMG units, go to the following
link:

Setting Up Digital Mitel PIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the PIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.
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d) Close the Command Prompt window.

Step 2 Connect a PIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.

Table 165: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
Step 7 On the Upgrade page, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted PIMG firmware

update files.
Step 9 SelectMtl_<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.

Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file installation fails.
Restarting the PIMG unit at this step may prevent the PIMG unit from functioning correctly.

Step 12 Repeat Step 6 through Step 11 for each of the following files:

• Mtl_<xx>.fsh

• Run<xx>FskEcho.dsp

• Mtl<xx>.lca

Step 13 On the Configuration menu, select Import/Export.
Step 14 On the Import/Export page, select Browse.
Step 15 In the Choose File dialog box, browse to the file MTLDNI_Cfg_Mitel.ini.
Step 16 SelectMTLDNI_Cfg_Mitel.ini, and select Open.
Step 17 On the Import/Export page, select Import File.
Step 18 After the file is imported, a message prompting you to restart the PIMG unit appears. Select OK.
Step 19 In the web browser, go to http://10.12.13.74.
Step 20 To sign in, enter the following case-sensitive settings.

Table 166: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

PIMG Integration Guide for Cisco Unity Connection Release 12.X
146

Setting Up a Mitel SX-2000 Digital PIMG Integration with Cisco Unity Connection
Setting Up Digital Mitel PIMG Units (Firmware Version 6.x)



Step 21 Select OK.
Step 22 If your Unity Connection systemmust have an RTP port range of 16384 to 32767, do the following substeps. Otherwise,

continue to Step 23.

Youmust set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to 32767. Otherwise,
Unity Connection cannot answer calls and callers hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. SomeUnity Connection configurations require
a different RTP port range.

Note

a) On the Configuration menu, select Import/Export.
b) On the Import/Export page, under Export Files, select Export All Settings.
c) In the File Download dialog box, select Save.
d) In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units, browse to a

directory where you want to save the file, and select Save.
e) In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you saved.
f) Locate the line with the following parameter:

gwRTPStartPort

g) Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384

h) Locate the line with the following parameter:

gwRTPEndPort

i) Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

j) Save the file, and exit Notepad.
k) On the Configuration menu of the PIMG unit, select Import/Export.
l) On the Import/Export page, under Browse for Import File, select Browse.
m) In the Choose File dialog box, browse to the file Config.ini that you saved.
n) Select Config.ini, and select Open.
o) On the Import/Export page, select Import File.
p) When prompted to restart the PIMG unit, select OK.
q) When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.
r) To sign in, enter the following case-sensitive settings.

Table 167: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

s) Select OK.
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Step 23 On the System menu, select Password.
Step 24 On the Change Password page, enter the following settings.

Table 168: Change Password Page Settings

SettingField

Enter IpodAdmin. (This setting is case sensitive.)Old Password

Enter your new password. (This setting is case sensitive.)New Password

Enter your new password. (This setting is case sensitive.)Confirm Password

Step 25 Select Change.
Step 26 On the Configuration menu, select Routing Table.
Step 27 On the Routing Table page, under Router Configuration, select VoIP Host Groups.
Step 28 Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 169: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name of
the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connectionwith a cluster configured) Select False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connectionwith a cluster configured) SelectTrue.

Fault-Tolerant

Step 29 For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity Connection
server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, enter the host name or IP address of the subscriber
server (the second Unity Connection server that you installed) and the server port in the format <host name or IP
address>:5060.

Step 30 For Unity Connection without a cluster, continue to Step 32. For Unity Connection with a cluster configured, select
Add Host.

Step 31 In the second field, enter the host name or IP address of the publisher server (the first Unity Connection server that you
installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the Unity Connection
cluster may not function correctly.

Step 32 Select Submit.
Step 33 Under Router Configuration, select TDM Trunk Groups.
Step 34 Under TDM Trunk Groups, select Add Trunk Group.
Step 35 Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.
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Table 170: First TDM Trunk Group Settings (Inbound Calls)

SettingsField

Enter Inbound_PBX_Calls or another unique name.

This TDM trunk group handles all incoming calls from
the phone system.

Name

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports handling inbound
calls. For example, enter “*” for all PIMG ports, or enter
“1-6” for the first six PIMG ports.

Port/Channel Content

Step 36 Under TDM Trunk Groups, select Add Trunk Group.
Step 37 Enter the following settings for the second TDM trunk group.

Table 171: Second TDM Trunk Group Settings (MWIs)

SettingsField

EnterMWIs or another unique name.

This TDM trunk group handles outbound MWI calls
(where applicable).

Name

Select Ascending.Selection Direction

Select Cyclic.Selection Mode

Enter the numbers of the PIMG ports that dial out MWIs.
For example, enter “*” for all PIMG ports, or enter “7,8”
for the last two PIMG ports.

Port/Channel Content

Step 38 Under TDM Trunk Groups, select Add Trunk Group.
Step 39 Enter the following settings for the third TDM trunk group.

Table 172: Third TDM Trunk Group Settings (Outbound Calls)

SettingsField

Enter Outbound_PBX_Calls or another unique name.

This TDM trunk group handles all outbound calls from
Unity Connection.

Name

Select Descending.Selection Direction

Select Linear.Selection Mode
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SettingsField

Enter * for all channels in all ports.

Enter the numbers of the PIMG ports that handle outbound
(dialout) calls. For example, enter “*” for all PIMG ports,
or enter “7,8” for the last two PIMG ports.

Port/Channel Content

Step 40 Select Submit.
Step 41 Under Router Configuration, select Inbound VoIP Rules.
Step 42 Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.
Step 43 Select Add Rule.
Step 44 Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 173: First New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable

EnterMWI_Calls or another name.

This inbound VoIP rule handles all MWI calls from Unity
Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address

Step 45 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another rule.

Table 174: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 46 Under Outbound Routes, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another rule.
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Table 175: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for MWIs in Step 37. For example, select “MWIs.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 47 Under Inbound VoIP Rules, select Add Rule.
Step 48 Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.

Table 176: Second New Inbound VoIP Rule Settings (Outbound Calls)

SettingsField

Check this check box.Enable

Enter Outbound_UC_Calls or another name.

This inbound VoIP rule handle all outbound calls from
Unity Connection.

Rule Label

Select Call.Request Type

Enter *.Originating VoIP Host Address

Step 49 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.
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Table 177: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 50 Under Outbound Routes, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.

Table 178: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for outbound calls in Step 39. For example, select
“Outbound_PBX_Calls.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 51 Select Submit.
Step 52 Under Router Configuration, select Inbound TDM Rules.
Step 53 Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.
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Table 179: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule handles all incoming calls from
the phone system.

Rule Label

Select Call.Request Type

Select the name of the TDM trunk group that you created
for incoming calls from the phone system in Step 35. For
example, select “Inbound_PBX_Calls.”

Trunk Group

Step 54 Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another rule.

Table 180: Inbound TDM Request Matching Settings

SettingsField

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Name

Step 55 Under Outbound Routes, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another rule.

Table 181: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination
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SettingsField

Select the name of the VoIP host group that you created
for Cisco Unity Connection in Step 28.

Host Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 56 If you want to create more Inbound TDM rules, under Inbound TDM Rules, select Add Rule. Otherwise, continue to
Step 58.

Step 57 Repeat Step 53 through Step 56 for all remaining inbound TDM rules that you want to create.
Step 58 Select Submit.
Step 59 On the Configuration menu, select TDM > General.
Step 60 On the TDM General Settings page, enter the following settings.

Table 182: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Enter the code that turns MWIs on.Turn MWI On FAC

Enter the code that turns MWIs off.Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer
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SettingsField

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Select No.Disconnect on Fax Cleardown Tone

Step 61 Select Submit.
Step 62 On the Configuration menu, select TDM > Port Enable.
Step 63 On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.
Step 64 Confirm that Yes is selected for all other ports on the PIMG unit.
Step 65 Select Submit.
Step 66 On the Configuration menu, select VoIP > General.
Step 67 On the VoIP General Settings page, enter the following settings.

Table 183: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Select No.SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that the
PIMG unit uses.

DNS Server Address

Select No.DNS Translation of Phone Numbers

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Enter 30.TCP Inactivity Timer (sec)

TLS
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SettingField

Select No.TLS Transport Enabled

Enter 5061.TLS Server Port

Select SSLv3 TLSv1.SSL TLS Protocol

Select Yes.Mutual TLS Authentication Required

Enter 30.TLS Inactivity Timer (sec)

Select Yes.Verify TLS Peer Certificate Date

Select Yes.Verify TLS Peer Certificate Trust

Proxy

Leave this field blank.

Unity Connection

Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Enter 5000.T4 Time (ms)

Monitoring

Select No.Monitor Call Connections

Call Monitor Interval (sec)

Monitor VoIP Hosts

VoIP Host Monitor Interval (sec)

Step 68 Select Submit.
Step 69 On the Configuration menu, select VoIP > Media.
Step 70 On the VoIP Media Settings page, enter the following settings.
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Table 184: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select RFC2833.RTP Fax/Modem Tone Relay Mode

Select Off.RTP Source IP Address Validation

Select Off.RTP Source UDP Port Validation

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select On Demand.RFC 3960 Early Media Support

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Fax

Fax IP-Transport Mode

SRTP

Select RTP Only.SRTP Preference

Select Yes.MKI on Transmit Stream

Select Yes.Key Derivation Enable

Enter 16.Key Derivation Rate

Enter 64.Anti-replay Window Size Hint

Select AES_Counter_Mode.Cipher Mode
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SettingsField

Select SHA1.Authentication Type

Select SHA1_80_bit.Authentication Tag Length

Step 71 Select Submit.
Step 72 On the Configuration menu, select VoIP > QOS.
Step 73 On the VoIP QOS Configuration page, enter the following settings.

Table 185: VoIP QOS Configurative Page Settings

SettingsField

Enter 104.Call Control QOS Byte

Enter 184.RTP QOS Byte

Step 74 Select Submit.
Step 75 On the Configuration menu, select IP.
Step 76 On the IP Settings page, enter the following settings.

Table 186: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

SNTP Server IP Address

Step 77 Select Submit.
Step 78 On the Configuration menu, select Tone Detection.
Step 79 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select Busy and do the

following substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
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e) Hang up the third phone but leave the handsets for the other two phones off.

Step 80 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 79c. from the
third phone.

Step 81 Select Learn.
Step 82 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 83 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 82a.
Step 84 Select Learn.
Step 85 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, selectRingback and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist.
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 86 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 85a.
Step 87 Select Learn.
Step 88 Select Submit.
Step 89 Hang up the phones that you used in Step 79.
Step 90 On the System menu, select Restart.
Step 91 On the Restart page, select Restart Unit Now.
Step 92 Repeat Step 2 through Step 91 on all remaining PIMG units.

Configuring Unity Connection Integration with Mitel SX-2000 Phone System
After ensuring that the Mitel SX-2000 phone system, the PIMG units, and Unity Connection are ready for
the integration, do the following procedure to set up the integration and to enter the port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
Step 6 Select Save.
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Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 187: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 188: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled
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ConsiderationsField

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.

Table 189: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification
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ConsiderationsField

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note

Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 190: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From
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SettingField

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is

checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

Table 191: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
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Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone
system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.
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C H A P T E R 9
Setting Up an NEC NEAX 2400 Digital PIMG
Integration with Cisco Unity Connection

• Setting Up an NEC NEAX 2400 Digital PIMG Integration, on page 165

Setting Up an NEC NEAX 2400 Digital PIMG Integration

Task List for NEC NEAX 2400 PIMG Phone System Integration
Before doing the following tasks to integrate Unity Connection with the NEC NEAX 2400 phone system
using PIMG units (media gateways), confirm that the Unity Connection server is ready for the integration
after completing the server installation, following the tasks in the “Installing Cisco Unity Connection” chapter
of the Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Cisco Unity
Connection server requirements have been met. See the Requirements, on page 12 section.

2. Plan how the voice messaging ports are used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports, on page 7 chapter.

3. Program the NEC NEAX 2400 phone system and extensions. See the Programming NEC NEAX 2400
PIMG Phone System Integration section.

4. Set up the PIMG units. See the Setting Up Digital PIMG Units section.

5. Create the integration. See the Configuring Unity Connection for Integration with NEC NEAX 2400
Phone System, on page 184 section.

6. Test the integration. See the Testing the Integration, on page 401 chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Integrations with Multiple Phone Systems, on page 5 chapter.

Requirements
This integration supports configurations of the following components:
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Phone System
• One of the following NEC NEAX 2400 phone systems:

• IMG

• IMX

• IPX (release 15 or later)

• One or more of the applicable PIMG units. For details, see the “Introduction” chapter.

• The voice messaging ports in the phone system connected by digital lines to the ports on the PIMG units.

To simplify troubleshooting, we recommend that you connect the voice messaging ports on the phone system
to the ports on the PIMG units in a planned manner. For example, connect the first phone system voice
messaging port to the first port on the first PIMG unit, connect the second phone system voice messaging port
to the second port on the first PIMG unit, and so on. Alternatively, if you have multiple PIMG units, you can
reduce answer times in the event of a PIMG unit failure by connecting the phone system ports to the PIMG
units in a round-robin fashion. For example, connect the first phone system voice messaging port to the first
port on the first PIMG unit, connect the second phone system voice messaging port to the first port on the
second PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.

Programming NEC NEAX 2400 PIMG Phone System Integration
The following programming instructions are provided as an example only. The specific programming for your
phone system may vary depending on its configuration.
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In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Send MWI Requests, do not send calls to it.

Caution

Do the following steps to program the NEC NEAX 2400 phone system using Command Line Interface

Step 1 Sign in to the NEC NEAX 2400 administration terminal and go to the Maintenance Command Menu page.
Step 2 On the Maintenance Command Menu page, enter 14 (Installation).
Step 3 On the Installation Menu page, enter 3 (ASYD) to assign system data.
Step 4 Enter the following settings.

Table 192: Assignment of System Data Settings

SettingField

Enter 1.Sys

Enter 78.Index

Enter 0B.Data

Step 5 On the Maintenance Command Menu page, enter 6 (Station Data).
Step 6 On the Station Data Commands page, enter 3 (ASTN) to assign the station numbers for the voice messaging ports.
Step 7 On the Station Number Assignment page, enter the extension for the first port that connects to the PIMG unit.

Confirm that the station number (extension) is not already assigned. Otherwise, the integration cannot function correctly.

Step 8 On the Station Data Commands page, enter 2 (ASCL).
Step 9 On the Station Class Data page, assign the applicable station class information to the voice messaging port.
Step 10 On the Station Data Commands page, enter 1 (ASDT).
Step 11 On the Station Data page, in the LENS field, enter the applicable line equipment number for the voice messaging port.
Step 12 On the Station Data Commands page, enter 5 (AKYD).
Step 13 On the Key Data page, select Assignment/Change and press Enter.
Step 14 On the Assignment of Key Data page, enter the following settings to enable the PRIMARY APPEARANCE function

on Key 1.

Table 193: Assignment of Key Data Settings for Key 1

SettingField

Enter 1.KYN

Enter 2.KYI

Step 15 Press Esc to move to the next operation.
Step 16 Enter the following settings to enable the MWL SET function on Key 5.
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Table 194: Assignment of Key Data Settings for Key 5

SettingField

Enter 5.KYN

Enter 9.FKI

Step 17 Press Esc to move to the next operation.
Step 18 Enter the following settings to enable the MWL CNCL function on Key 6.

Table 195: Assignment of Key Data Settings for Key 6

SettingField

Enter 6.KYN

Enter 11.FKY

Step 19 On the Maintenance Command Menu page, enter 13 (Restriction Data).
Step 20 On the Restriction Data Commands page, enter 2 (ASFC).
Step 21 On the Service Feature Assignment page, enter the following settings.

Table 196: Service Feature Assignment Settings

SettingField

Enter SFI:74.TN:1

Enter SFI:82.TN:1

Step 22 Program each phone to forward calls to the pilot number assigned to the voice messaging ports, based on one of the
Unity Connection call transfer types shown in Table 197: Call Transfer Types.

Table 197: Call Transfer Types

UsageTransfer Type

Program the phone to forward calls to the pilot number
when:

• The extension is busy.

• The call is not answered.

Release transfer

(blind transfer)
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UsageTransfer Type

Program the user station to forward calls to the pilot
number only when the call is not answered (on the phone
system, the number of rings before forwarding must be
more than the number of rings to supervise the call).
Confirm that call forwarding is disabledwhen the extension
is busy.

Supervised transfer

Setting Up Digital PIMG Units
Do the following procedures to set up the digital PIMG units that are connected to the NEC NEAX 2400
phone system.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the PIMG units using digital lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the PIMG units.

Downloading the PIMG Firmware Update Files for Digital PIMG Units
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.
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To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

1. In the tree control on the Downloads Home page, expand Unified Communications> Unified
Communications Applications > Messaging > Cisco Unity and select Cisco Unity Telephony
Integration.

2. On the Log In page, enter your username and password, then select Log In.

3. On the Select a Release page, under Latest Releases, select the most recent release.

4. In the right column, select the version of the firmware for digital PIMG units.

5. On the Download Image page, select Download.

6. On the Supporting Document(s) page, select Agree.

7. In the File Download dialog box, select Save.

8. In the Save As dialog box, browse to theWindows workstation that have access the PIMG units, browse
to a directory where you want to save the file, and select Save.

9. In the Download Complete dialog box, select Open. The window for extracting the PIMG firmware
update files appears and select Extract.

10. In the Extract dialog box, browse to the directory where you want the extracted files, and selectExtract.

11. Close the window for the extracting application.

Note

On a Windows workstation that have access to the PIMG units, go to the following link:

Setting Up the Digital PIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the PIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 2 Connect a PIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.
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Table 198: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
Step 7 On the Upgrade page, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted PIMG firmware

update files.
Step 9 Select Ami<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.

Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file installation fails.
Restarting the PIMG unit at this step may prevent the PIMG unit from functioning correctly.

Step 12 Repeat Step 6 through Step 11 for each of the following files:

• Ami_<xx>.fsh

• Run<xx>FskEcho.dsp

• iNim<xx>.ibt

• iNim<xx>.ilc

• iNim<xx>.iap

Step 13 On the Configuration menu, select Import/Export.
Step 14 On the Import/Export page, select Browse.
Step 15 In the Choose File dialog box, browse to the file DNI_Cfg_Generic.ini.
Step 16 Select DNI_Cfg_Generic.ini, and select Open.
Step 17 On the Import/Export page, select Import File.
Step 18 After the file is imported, a message prompting you to restart the PIMG unit appears. Select OK.
Step 19 In the web browser, go to http://10.12.13.74.
Step 20 To sign in, enter the following case-sensitive settings.

Table 199: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 21 Select OK.
Step 22 Do the following substeps to configure an RTP port range of 16384 to 32767.
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Youmust set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to 32767. Otherwise,
Unity Connection cannot answer calls and callers hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. SomeUnity Connection configurations require
a different RTP port range.

Note

a) On the Configuration menu, select Import/Export.
b) On the Import/Export page, under Export Settings, select Export All Settings.
c) In the File Download dialog box, select Save.
d) In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units, browse to a

directory where you want to save the file, and select Save.
e) In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you saved.
f)
g)
h) Locate the line with the following parameter:

gwRTPStartPort

i) Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384

j) Locate the line with the following parameter:

gwRTPEndPort

k) Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

l) Save the file, and exit Notepad.
m) On the Configuration menu of the PIMG unit, select Import/Export.
n) On the Import/Export page, under Browse for Import File, select Browse.
o) In the Choose File dialog box, browse to the file Config.ini that you saved.
p) Select Config.ini, and select Open.
q) On the Import/Export page, select Import File.
r) When prompted to restart the PIMG unit, select OK.
s) When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.
t) To sign in, enter the following case-sensitive settings.

Table 200: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

u) Select OK.

Step 23 On the System menu, select Password.
Step 24 On the Change Password page, enter the following settings.
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Table 201: Change Password Page Settings

SettingField

Enter IpodAdmin. (This setting is case sensitive.)Old Password

Enter your new password. (This setting is case sensitive.)New Password

Enter your new password. (This setting is case sensitive.)Confirm Password

Step 25 Select Change.
Step 26 On the Configuration menu, select Routing Table.
Step 27 On the Routing Table page, under Router Configuration, select VoIP Host Groups.
Step 28 Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 202: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name of
the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connectionwith a cluster configured) Select False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connectionwith a cluster configured) SelectTrue.

Fault-Tolerant

Step 29 For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity Connection
server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, enter the host name or IP address of the subscriber
server (the second Unity Connection server that you installed) and the server port in the format <host name or IP
address>:5060.

Step 30 For Unity Connection without a cluster, continue to Step 32. For Unity Connection with a cluster configured, select
Add Host.

Step 31 In the second field, enter the host name or IP address of the publisher server (the first Unity Connection server that you
installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the Unity Connection
cluster may not function correctly.

Step 32 Select Submit.
Step 33 Under Router Configuration, select TDM Trunk Groups.
Step 34 Under TDM Trunk Groups, select Add Trunk Group.
Step 35 Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.

PIMG Integration Guide for Cisco Unity Connection Release 12.X
173

Setting Up an NEC NEAX 2400 Digital PIMG Integration with Cisco Unity Connection
Setting Up the Digital PIMG Units (Firmware Version 6.x)



Table 203: First TDM Trunk Group Settings (Inbound Calls)

SettingsField

Enter Inbound_PBX_Calls or another unique name.

This TDM trunk group handles all incoming calls from
the phone system.

Name

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports that handle inbound
calls. For example, enter “*” for all PIMG ports, or enter
“1-6” for the first six PIMG ports.

Port/Channel Content

Step 36 Under TDM Trunk Groups, select Add Trunk Group.
Step 37 Enter the following settings for the second TDM trunk group.

Table 204: Second TDM Trunk Group Settings (MWIs)

SettingsField

EnterMWIs or another unique name.

This TDM trunk group handles outbound MWI calls
(where applicable).

Name

Select Ascending.Selection Direction

Select Cyclic.Selection Mode

Enter the numbers of the PIMG ports that MWIs. For
example, enter “*” for all PIMG ports, or enter “7,8” for
the last two PIMG ports.

Port/Channel Content

Step 38 Under TDM Trunk Groups, select Add Trunk Group.
Step 39 Enter the following settings for the third TDM trunk group.

Table 205: Third TDM Trunk Group Settings (Outbound Calls)

SettingsField

Enter Outbound_PBX_Calls or another unique name.

This TDM trunk group handles all outbound calls from
Unity Connection.

Name

Select Descending.Selection Direction

Select Linear.Selection Mode
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SettingsField

Enter * for all channels in all ports.

Enter the numbers of the PIMG ports that handle outbound
(dialout) calls. For example, enter “*” for all PIMG ports,
or enter “7,8” for the last two PIMG ports.

Port/Channel Content

Step 40 Select Submit.
Step 41 Under Router Configuration, select Inbound VoIP Rules.
Step 42 Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.
Step 43 Select Add Rule.
Step 44 Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 206: First New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable

EnterMWI_Calls or another name.

This inbound VoIP rule handles all MWI calls from Unity
Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address

Step 45 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another inbound VoIP
rule.

Table 207: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 46 Under Outbound Routes, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another rule.
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Table 208: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for MWIs in Step 37. For example, select “MWIs.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 47 Under Inbound VoIP Rules, select Add Rule.
Step 48 Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.

Table 209: Second New Inbound VoIP Rule Settings (Outbound Calls)

SettingsField

Check this check box.Enable

Enter Outbound_UC_Calls or another name.

This inbound VoIP rule handles all outbound calls from
Unity Connection.

Rule Label

Select Call.Request Type

Enter *.Originating VoIP Host Address

Step 49 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.
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Table 210: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 50 Under Outbound Routes, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.

Table 211: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for outbound calls in Step 39. For example, select
“Outbound_PBX_Calls.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 51 Select Submit.
Step 52 Under Router Configuration, select Inbound TDM Rules.
Step 53 Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.
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Table 212: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule handles all incoming calls from
the phone system.

Rule Label

Select Call.Request Type

Select the name of the TDM trunk group that you created
for incoming calls from the phone system in Step 35. For
example, select “Inbound_PBX_Calls.”

Trunk Group

Step 54 Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another rule.

Table 213: Inbound TDM Request Matching Settings

SettingsField

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Name

Step 55 Under Outbound Routes, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another rule.

Table 214: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination
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SettingsField

Select the name of the VoIP host group that you created
for Unity Connection in Step 28.

Host Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 56 If you want to create more Inbound TDM rules, under Inbound TDM Rules, select Add Rule. Otherwise, continue to
Step 58.

Step 57 Repeat Step 53 through Step 56 for all remaining inbound TDM rules that you want to create.
Step 58 Select Submit.
Step 59 On the Configuration menu, select TDM > Digital.
Step 60 On the Digital Telephony page, in the Telephony Switch Type field, select NEC_NEAX.
Step 61 Select Submit.
Step 62 On the Configuration menu, select TDM > General.
Step 63 On the TDM General Settings page, enter the following settings.

Table 215: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Leave this field blank.Turn MWI On FAC

Leave this field blank.Turn MWI Off FAC
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SettingsField

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Select No.Disconnect on Fax Cleardown Tone

Step 64 Select Submit.
Step 65 On the Configuration menu, select TDM > Port Enable.
Step 66 On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.
Step 67 Confirm that Yes is selected for all other ports on the PIMG unit.
Step 68 Select Submit.
Step 69 On the Configuration menu, select VoIP > General.
Step 70 On the VoIP General Settings page, enter the following settings.

Table 216: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Select No.SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that the
PIMG unit uses.

DNS Server Address

Select No.DNS Translation of Phone Numbers

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port
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SettingField

Enter 30.TCP Inactivity Timer (sec)

TLS

Select No.TLS Transport Enabled

Enter 5061.TLS Server Port

Select SSLv3 TLSv1.SSL TLS Protocol

Select Yes.Mutual TLS Authentication Required

Enter 30.TLS Inactivity Timer (sec)

Select Yes.Verify TLS Peer Certificate Date

Select Yes.Verify TLS Peer Certificate Trust

Proxy

Leave this field blank.

Unity Connection

Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Enter 5000.T4 Time (ms)

Monitoring

Select No.Monitor Call Connections

Call Monitor Interval (sec)

Monitor VoIP Hosts

VoIP Host Monitor Interval (sec)

Step 71 Select Submit.
Step 72 On the Configuration menu, select VoIP > Media.
Step 73 On the VoIP Media Settings page, enter the following settings.
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Table 217: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select RFC2833.RTP Fax/Modem Tone Relay Mode

Select Off.RTP Source IP Address Validation

Select Off.RTP Source UDP Port Validation

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select On Demand.RFC 3960 Early Media Support

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Fax

Fax IP-Transport Mode

SRTP

Select RTP Only.SRTP Preference

Select Yes.MKI on Transmit Stream

Select Yes.Key Derivation Enable

Enter 16.Key Derivation Rate

Enter 64.Anti-replay Window Size Hint

Select AES_Counter_Mode.Cipher Mode
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SettingsField

Select SHA1.Authentication Type

Select SHA1_80_bit.Authentication Tag Length

Step 74 Select Submit.
Step 75 On the Configuration menu, select VoIP > QOS.
Step 76 On the VoIP QOS Configuration page, enter the following settings.

Table 218: VoIP QOS Configurative Page Settings

SettingsField

Enter 104.Call Control QOS Byte

Enter 184.RTP QOS Byte

Step 77 Select Submit.
Step 78 On the Configuration menu, select IP.
Step 79 On the IP Settings page, enter the following settings.

Table 219: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

SNTP Server IP Address

Step 80 Select Submit.
Step 81 On the Configuration menu, select Tone Detection.
Step 82 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select Busy and do the

following substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
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e) Hang up the third phone but leave the handsets for the other two phones off.

Step 83 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 82c. from the
third phone.

Step 84 Select Learn.
Step 85 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 86 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 85a.
Step 87 Select Learn.
Step 88 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, selectRingback and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 89 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 88a.
Step 90 Select Learn.
Step 91 Select Submit.
Step 92 Hang up the phones that you used in Step 82.
Step 93 On the System menu, select Restart.
Step 94 On the Restart page, select Restart Unit Now.
Step 95 Repeat Step 2 through Step 94 on all remaining PIMG units.

Configuring Unity Connection for Integration with NEC NEAX 2400 Phone
System

After ensuring that the NEC NEAX 2400 phone system, the PIMG units, and Unity Connection are ready for
the integration, do the following procedure to set up the integration and to enter the port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
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Step 6 Select Save.
Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 220: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 221: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled
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ConsiderationsField

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.

Table 222: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification
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ConsiderationsField

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note

Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 223: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From
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SettingField

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is

checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

Table 224: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
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Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone
system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.
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C H A P T E R 10
Setting Up a Nortel Meridian 1 Digital PIMG
Integration with Cisco Unity Connection

• Setting Up a Nortel Meridian 1 Digital PIMG Integration, on page 191

Setting Up a Nortel Meridian 1 Digital PIMG Integration

Task List for Nortel Meridian 1 PIMG Phone System Integration
Before doing the following tasks to integrate Unity Connection with the Nortel Meridian 1 phone system
using PIMG units (media gateways), confirm that the Unity Connection server is ready for the integration
after completing the server installation, following the tasks in the “Installing Cisco Unity Connection” chapter
of the Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Cisco Unity
Connection server requirements have been met. See the Requirements, on page 12 section.

2. Plan how the voice messaging ports are used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports, on page 7 chapter.

3. Program the Nortel Meridian 1 phone system and extensions. See the Programming Nortel Meridian 1
PIMG Phone System Integration section.

4. Set up the PIMG units. See the Setting Up Digital PIMG Units section.

5. Create the integration. See the Configuring Unity Connection for Integration with Nortel Meridian 1
Phone System, on page 216section .

6. Test the integration. See the Testing the Integration, on page 401 chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Integrations with Multiple Phone Systems, on page 5 chapter.

Requirements
This integration supports configurations of the following components:
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Phone System
• One of the following models:

• Nortel Meridian 1 phone system (Option 11, 21, 51, 61, 71, or 81), software release 17 or later.

• Nortel Succession (CS 1000) phone system, software release 3.0 or later.

• The Nortel SL 1 phone system, when upgraded toMeridian 1 so that it is compatible with theM2616
digital phone.

• The following software option packages installed:

• Package 19, Digit Display Software (DDSP)

• Package 46, Message Waiting Center (MWC)

• One or more digital lines that are compatible with the M2616 digital phone for connecting to the PIMG
units.

• One or more of the applicable PIMG units. For details, see the “Introduction” chapter.

• The voice messaging ports in the phone system connected by digital lines to the ports on the PIMG units.

To simplify troubleshooting, we recommend that you connect the voice messaging ports on the phone system
to the ports on the PIMG units in a planned manner. For example, connect the first phone system voice
messaging port to the first port on the first PIMG unit, connect the second phone system voice messaging port
to the second port on the first PIMG unit, and so on. Alternatively, if you have multiple PIMG units, you can
reduce answer times in the event of a PIMG unit failure by connecting the phone system ports to the PIMG
units in a round-robin fashion. For example, connect the first phone system voice messaging port to the first
port on the first PIMG unit, connect the second phone system voice messaging port to the first port on the
second PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.
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Programming Nortel Meridian 1 PIMG Phone System Integration
The following programming instructions are provided as an example only. The specific programming for your
phone system may vary depending on its configuration.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Send MWI Requests, do not send calls to it.

Caution

Do the following steps to program the Nortel Meridian 1 phone system.

Step 1 Assign extensions for the voice messaging ports.
Step 2 Confirm that the software on the phone system has the necessary following option packages using overlay 22:

• DDSP (Package 19, Digit Display Software)

• MWC (Package 46, Message Waiting Center)

If either of these options is missing, contact your sales representative.

Step 3 On overlay 11, set the following options to create the M2616 digital set emulation for the first port.

Table 225: Digital Set Emulation Options for the Second Port

SettingOption

Enter NEW.REQ

Enter 2616.TYPE

Enter 0 0 6 2.TN

Enter 0.CUST

Enter ADD HFD CNDA HTA MWA.CLS

Enter the extension of the second port on the PIMG unit.HUNT

Enter the primary number for this PIMG unit. Enter any
valid unused number.

KEY 00 SCR

KEY 13 MIK

KEY 14 MCK

KEY 15 TRN

Step 4 Set the following options to create the digital set emulation for the second port.
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Table 226: Digital Set Emulation Options for the Second Port

SettingOption

Enter NEW.REQ

Enter 2616.TYPE

Enter 0 0 6 3.TN

Enter 0.CUST

Enter ADD HFD CNDA HTA MWA.CLS

Enter the extension of the next port on the PIMG unit.HUNT

Enter the extension for this PIMG unit port. Enter any valid
unused number.

KEY 00 SCR

KEY 13 MIK

KEY 14 MCK

KEY 15 TRN

Step 5 Repeat Step 4 for all remaining ports on the PIMG units.
Step 6 On overlay 95, set the following options to enable display of a four-letter code that represents why the call was forwarded.

Table 227: Calling Party Display Options

SettingOption

Enter CHG.REQ

Enter CPND.TYPE

Enter the customer number.CUST

Enter YES.RESN

Enter CFWD.CFWD

Enter CFNA.CFNA

Enter HUNT.HUNT

Enter T.XFER

Enter A.AAA

Step 7 On each subscriber phone, program the phone to forward calls to the pilot number assigned to the voice messaging ports,
based on one of the Unity Connection call transfer types shown in Table 228: Call Transfer Types.
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Table 228: Call Transfer Types

UsageTransfer Type

Program the phone to forward calls to the pilot number
when:

• The extension is busy

• The call is not answered

Release transfer (blind transfer)

Program the user station to forward calls to the pilot number
only when the call is not answered (on the phone system,
the number of rings before forwarding must be more than
the number of rings to supervise the call). Confirm that call
forwarding is disabled when the extension is busy.

Supervised transfer

Step 8 Use Table 229: Hunt Methods for the Nortel Meridian 1 Phone System to determine the hunt method that you want to
use, and do the applicable procedure.

Table 229: Hunt Methods for the Nortel Meridian 1 Phone System

ProcedureHunt Method

See the Setting Up Hunt Group for Up to 30 Ports.Hunting Group

• Use for systems with up to 30 voice messaging ports.

• The search route calls to the next idle PIMG port in
the group when a call encounters a busy port.

• When the search reaches a PIMG port that has been
disabled or has lost its Unity Connection to the PIMG
unit, the search stops at this port. The call rings until
the caller hangs up.

See the Setting Up ACD Hunt Group for More Than 30
Ports.

ACD Hunt Group

• Use for systems with more than 30 voice messaging
ports.

• The search route calls to the next idle PIMG port in
the group when a call encounters a busy port.

• When the search reaches a PIMG port that has been
disabled or has lost its Unity Connection to the PIMG
unit, the search stops at this port. The call rings until
the caller hangs up.
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ProcedureHunt Method

See the Setting Up ACD Hunt Group for More Than 30
Ports.

Group Hunt Feature

• Use for systems with any number of voice messaging
ports.

• Software option package 120 must be installed on the
phone system.

• The search route calls to the next idle PIMG port in
the group when a call encounters a busy port.

• When the search reaches a PIMG port that has been
disabled or has lost its Unity Connection to the PIMG
unit, the search continues to the next available port.

Setting Up Hunt Group for Up to 30 Ports
See Table 229: Hunt Methods for the Nortel Meridian 1 Phone System for considerations about using this
procedure.

Step 1 Set up the first voice messaging port as the pilot number of the hunt group.
Step 2 Set the first voice messaging port to hunt to the second voice messaging port.
Step 3 Set the second voice messaging port to hunt to the third, then continue up to the 30th.
Step 4 Set the 30th voice messaging port to hunt to the first voice messaging port. See the example in Table 230: Example of a

30-Port Hunt Group.

Table 230: Example of a 30-Port Hunt Group

DestinationSettingDevice

Port 2HUNTPort 1

Port 3HUNTPort 2

Port 4HUNTPort 3

<additional ports>HUNT. . .

Port 30HUNTPort 29

Port 1HUNTPort 30
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Setting Up ACD Hunt Group for More Than 30 Ports
See Table 229: Hunt Methods for the Nortel Meridian 1 Phone System for considerations about using this
procedure.

Step 1 Set up ACD 1 as the pilot number of the hunt group.
Step 2 With the Night Call Forward Destination (NCFW) command, set ACD 1 to forward to the first voice messaging port.
Step 3 Set the first voice messaging port to hunt to the second, then continue up to the 30th.
Step 4 Set the 30th voice messaging port to hunt to ACD 2.
Step 5 With the NCFW command, set ACD 2 to forward to the 31st voice messaging port.
Step 6 Set the 31st voice messaging port to hunt to the 32nd, and so on.
Step 7 Continue creating 30-port hunt groups in this manner until the last voice messaging port.
Step 8 Set the last voice messaging port to hunt to ACD 1. See the example in Table 231: Example of a 72-Port ACD Hunt

Group.

Table 231: Example of a 72-Port ACD Hunt Group

DestinationSettingsDevice

Port 1NCFWACD 1 (pilot number)

Port 2HUNTPort 1

Port 3HUNTPort 2

<additional ports><additional ports>

Port 30HUNTPort 29

ACD 2HUNTPort 30

Port 31NCFWACD 2

Port 32HUNTPort 31

<additional ports><additional ports>

Port 60HUNTPort 59

ACD 3HUNTPort 60

Port 61NCFWACD 3

Port 62HUNTPort 61

<additional ports><additional ports>

Port 72HUNTPort 71

ACD 1HUNTPort 72
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Setting Up the Group Hunt Feature
See Table 229: Hunt Methods for the Nortel Meridian 1 Phone System for considerations about using this
procedure.

Step 1 In LD 22, verify that software package 120 is equipped.

Table 232: Entries for LD 22

EntryPrompt

Enter PRT to start a print request.REQ:

Enter PKG to print the list of equipped packages.TYPE:

Step 2 In LD 18, create a Group Hunt list number.

Table 233: Entries for LD 18

EntryPrompt

Enter NEW.REQ:

Enter GHT.TYPE:

Enter the list number for the Group Hunt list. For example,
enter 1.

LSNO:

Enter the customer number as defined in LD 15.CUST:

Enter the maximum length of DN allowed for Group Hunt
list.

DNSZ:

Enter the maximum number of DNs in the Group Hunt list.SIZE:

Enter YES to write the information to the data store.WRT:

Press Enter.STOR:

Step 3 In LD 57, define the Pilot DN (PLDN) and associate it with the number for the Group Hunt list.

Table 234: Entries for LD 57

EntryPrompt

Enter CHG.REQ:

Enter FFC.TYPE:

Enter the customer number as defined in LD 15.CUST:

Press Enter.FFCT:

Enter PLDN for the Pilot DN.CODE:

PIMG Integration Guide for Cisco Unity Connection Release 12.X
198

Setting Up a Nortel Meridian 1 Digital PIMG Integration with Cisco Unity Connection
Setting Up the Group Hunt Feature



EntryPrompt

Enter the DN that is the pilot for the Group Hunt list.PLDN:

Enter GPHT.USE:

Enter the Group Hunt list number that you created in LD
18.

LSNO:

Do one of the following:

• If you want linear hunting, enter LIN.

• If you want round robin hunting, enter RRB.

HTYP:

Do one of the following:

• If you want Group Hunting to skip idle stations with
Call Forward All Calls active, enter NO.

• If you want GroupHunting to terminate on idle stations
with Call Forward All Calls active, enter YES.

CFWI:

Do one of the following to configure the maximum number
of calls allowed in the Pilot DN queue:

• If you want to no calls in the queue, enter 0.

• If you want only one call in the queue at a time, enter
1.

• If you want no limit on the number of calls in the
queue, enter ALL.

• If you want the number of calls in the queue to be less
than or equal to the number of active members of the
Group Hunt list, enter ACTM.

MQUE:

Step 4 In LD 18, modify the Group Hunt list number.

Table 235: Entries for LD 18

EntryPrompt

Enter CHG.REQ:

Enter GHT.TYPE:

Enter the list number for the Group Hunt list that you
created in Step 2. For example, enter 1.

LSNO:

Enter the maximum number of DNs in the Group Hunt list.SIZE:

Enter YES to write the information to the data store.WRT:
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EntryPrompt

Enter the first DN in the Group Hunt list in the following
format:

x...x y...y

For example, enter 00 2216.

STOR:

Enter YES to write the information to the data store.WRT:

Enter the second DN in the Group Hunt list in the following
format:

x...x y...y

For example, enter 01 2217.

STOR:

Enter YES to write the information to the data store.WRT:

Enter the third DN in the Group Hunt list in the following
format:

x...x y...y

For example, enter 02 2218.

STOR:

Add more DNs in the Group Hunt list.. . .

Enter YES to write the information to the data store.WRT:

Enter the last DN in the Group Hunt list in the following
format:

x...x y...y

For example, enter 07 2223.

STOR:

Step 5 In LD 11, enter a Group Hunt Pilot DN (PLDN) for each DN in the Group Hunt list that connects to a PIMG port.

Table 236: Entries for LD 11

EntryPrompt

Enter CHG.REQ:

Enter the first DN in the Group Hunt list. For example, enter
2616.

TYPE:

Enter 1 0 0 7.TN:
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EntryPrompt

Enter YES.ECHG:

Enter FDN <extension> for the PLDN that you configured
in Step 3.

Enter HUNT <extension> for the PLDN that you
configured in Step 3.

If applicable, enter EHT <extension> for the PLDN that
you configured in Step 3.

If applicable, enter EFD <extension> for the PLDN that
you configured in Step 3.

Step 6 Repeat Step 5 for all remaining DNs in the Group Hunt list.

Setting Up Digital PIMG Units
Do the following procedures to set up the digital PIMG units that are connected to the Nortel Meridian 1
phone system.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the PIMG units using digital lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the PIMG units.

Downloading the PIMG firmware update files for digital PIMG units
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.
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To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

1. In the tree control on the Downloads Home page, expand Unified Communications> Unified
Communications Applications > Messaging > Cisco Unity and select Cisco Unity Telephony
Integration.

2. On the Log In page, enter your username and password, then select Log In.

3. On the Select a Release page, under Latest Releases, select the most recent release.

4. In the right column, select the version of the firmware for digital PIMG units.

5. On the Download Image page, select Download.

6. On the Supporting Document(s) page, select Agree.

7. In the File Download dialog box, select Save.

8. In the Save As dialog box, browse to theWindows workstation that have access the PIMG units, browse
to a directory where you want to save the file, and select Save.

9. In the Download Complete dialog box, select Open. The window for extracting the PIMG firmware
update files appears and select Extract.

10. In the Extract dialog box, browse to the directory where you want the extracted files, and selectExtract.

11. Close the window for the extracting application.

Note

On a Windows workstation that have access to the PIMG units, go to the following link:

Setting Up Digital PIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the PIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 2 Connect a PIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.
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Table 237: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
Step 7 On the Upgrade page, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted PIMG firmware

update files.
Step 9 Select Ami<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.

Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file installation fails.
Restarting the PIMG unit at this step may prevent the PIMG unit from functioning correctly.

Step 12 Repeat Step 6 through Step 11 for each of the following files:

• Ami_<xx>.fsh

• Run<xx>FskEcho.dsp

• iNim<xx>.ibt

• iNim<xx>.ilc

• iNim<xx>.iap

Step 13 On the Configuration menu, select Import/Export.
Step 14 On the Import/Export page, select Browse.
Step 15 In the Choose File dialog box, browse to the file DNI_Cfg_Generic.ini.
Step 16 Select DNI_Cfg_Generic.ini, and select Open.
Step 17 On the Import/Export page, select Import File.
Step 18 After the file is imported, a message prompting you to restart the PIMG unit appears. Select OK.
Step 19 In the web browser, go to http://10.12.13.74.
Step 20 To sign in, enter the following case-sensitive settings.

Table 238: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 21 Select OK.
Step 22 Do the following substeps to configure an RTP port range of 16384 to 32767.
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Youmust set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to 32767. Otherwise,
Unity Connection cannot answer calls and callers hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. SomeUnity Connection configurations require
a different RTP port range.

Note

a) On the Configuration menu, select Import/Export.
b) On the Import/Export page, under Export Settings, select Export All Settings.
c) In the File Download dialog box, select Save.
d) In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units, browse to a

directory where you want to save the file, and select Save.
e) In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you saved.
f)
g)
h) Locate the line with the following parameter:

gwRTPStartPort

i) Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384

j) Locate the line with the following parameter:

gwRTPEndPort

k) Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

l) Save the file, and exit Notepad.
m) On the Configuration menu of the PIMG unit, select Import/Export.
n) On the Import/Export page, under Browse for Import File, select Browse.
o) In the Choose File dialog box, browse to the file Config.ini that you saved.
p) Select Config.ini, and select Open.
q) On the Import/Export page, select Import File.
r) When prompted to restart the PIMG unit, select OK.
s) When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.
t) To sign in, enter the following case-sensitive settings.

Table 239: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

u) Select OK.

Step 23 On the System menu, select Password.
Step 24 On the Change Password page, enter the following settings.
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Table 240: Change Password Page Settings

SettingField

Enter IpodAdmin. (This setting is case sensitive.)Old Password

Enter your new password. (This setting is case sensitive.)New Password

Enter your new password. (This setting is case sensitive.)Confirm Password

Step 25 Select Change.
Step 26 On the Configuration menu, select Routing Table.
Step 27 On the Routing Table page, under Router Configuration, select VoIP Host Groups.
Step 28 Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 241: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name of
the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connectionwith a cluster configured) Select False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connectionwith a cluster configured) SelectTrue.

Fault-Tolerant

Step 29 For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity Connection
server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, enter the host name or IP address of the subscriber
server (the second Unity Connection server that you installed) and the server port in the format <host name or IP
address>:5060.

Step 30 For Unity Connection without a cluster, continue to Step 32. For Unity Connection with a cluster configured, select
Add Host.

Step 31 In the second field, enter the host name or IP address of the publisher server (the first Unity Connection server that you
installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the Unity Connection
cluster may not function correctly.

Step 32 Select Submit.
Step 33 Under Router Configuration, select TDM Trunk Groups.
Step 34 Under TDM Trunk Groups, select Add Trunk Group.
Step 35 Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.
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Table 242: First TDM Trunk Group Settings (Inbound Calls)

SettingsField

Enter Inbound_PBX_Calls or another unique name.

This TDM trunk group handles all incoming calls from
the phone system.

Name

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports that handles inbound
calls. For example, enter “*” for all PIMG ports, or enter
“1-6” for the first six PIMG ports.

Port/Channel Content

Step 36 Under TDM Trunk Groups, select Add Trunk Group.
Step 37 Enter the following settings for the second TDM trunk group.

Table 243: Second TDM Trunk Group Settings (MWIs)

SettingsField

EnterMWIs or another unique name.

This TDM trunk group handles outbound MWI calls
(where applicable).

Name

Select Ascending.Selection Direction

Select Cyclic.Selection Mode

Enter the numbers of the PIMG ports that dial out MWIs.
For example, enter “*” for all PIMG ports, or enter “7,8”
for the last two PIMG ports.

Port/Channel Content

Step 38 Under TDM Trunk Groups, select Add Trunk Group.
Step 39 Enter the following settings for the third TDM trunk group.

Table 244: Third TDM Trunk Group Settings (Outbound Calls)

SettingsField

Enter Outbound_PBX_Calls or another unique name.

This TDM trunk group handles all outbound calls from
Unity Connection.

Name

Select Descending.Selection Direction

Select Linear.Selection Mode
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SettingsField

Enter * for all channels in all ports.

Enter the numbers of the PIMG ports that handle outbound
(dialout) calls. For example, enter “*” for all PIMG ports,
or enter “7,8” for the last two PIMG ports.

Port/Channel Content

Step 40 Select Submit.
Step 41 Under Router Configuration, select Inbound VoIP Rules.
Step 42 Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.
Step 43 Select Add Rule.
Step 44 Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 245: First New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable

EnterMWI_Calls or another name.

This inbound VoIP rule handles all MWI calls from Unity
Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address

Step 45 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another inbound VoIP
rule.

Table 246: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 46 Under Outbound Routes, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another rule.
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Table 247: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for MWIs in Step 37. For example, select “MWIs.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 47 Under Inbound VoIP Rules, select Add Rule.
Step 48 Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.

Table 248: Second New Inbound VoIP Rule Settings (Outbound Calls)

SettingsField

Check this check box.Enable

Enter Outbound_UC_Calls or another name.

This inbound VoIP rule handles all outbound calls from
Unity Connection.

Rule Label

Select Call.Request Type

Enter *.Originating VoIP Host Address

Step 49 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.

s
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Table 249: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 50 Under Outbound Routes, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.

Table 250: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for outbound calls in Step 39. For example, select
“Outbound_PBX_Calls.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 51 Select Submit.
Step 52 Under Router Configuration, select Inbound TDM Rules.
Step 53 Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.
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Table 251: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule handles all incoming calls from
the phone system.

Rule Label

Select Call.Request Type

Select the name of the TDM trunk group that you created
for incoming calls from the phone system in Step 35. For
example, select “Inbound_PBX_Calls.”

Trunk Group

Step 54 Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another rule.

Table 252: Inbound TDM Request Matching Settings

SettingsField

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Name

Step 55 Under Outbound Routes, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another rule.

Table 253: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination
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SettingsField

Select the name of the VoIP host group that you created
for Unity Connection in Step 28.

Host Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 56 If you want to create more Inbound TDM rules, under Inbound TDM Rules, select Add Rule. Otherwise, continue to
Step 58.

Step 57 Repeat Step 53 through Step 56 for all remaining inbound TDM rules that you want to create.
Step 58 Select Submit.
Step 59 On the Configuration menu, select TDM > Digital.
Step 60 On the Digital Telephony page, in the Telephony Switch Type field, select M1.
Step 61 Select Submit.
Step 62 On the Configuration menu, select TDM > General.
Step 63 On the TDM General Settings page, enter the following settings.

Table 254: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Leave this field blank.Turn MWI On FAC

Leave this field blank.Turn MWI Off FAC
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SettingsField

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Select No.Disconnect on Fax Cleardown Tone

Step 64 Select Submit.
Step 65 On the Configuration menu, select TDM > Port Enable.
Step 66 On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.
Step 67 Confirm that Yes is selected for all other ports on the PIMG unit.
Step 68 Select Submit.
Step 69 On the Configuration menu, select VoIP > General.
Step 70 On the VoIP General Settings page, enter the following settings.

Table 255: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Select No.SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that the
PIMG unit uses.

DNS Server Address

Select No.DNS Translation of Phone Numbers

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port
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SettingField

Enter 30.TCP Inactivity Timer (sec)

TLS

Select No.TLS Transport Enabled

Enter 5061.TLS Server Port

Select SSLv3 TLSv1.SSL TLS Protocol

Select Yes.Mutual TLS Authentication Required

Enter 30.TLS Inactivity Timer (sec)

Select Yes.Verify TLS Peer Certificate Date

Select Yes.Verify TLS Peer Certificate Trust

Proxy

Leave this field blank.

Unity Connection

Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Enter 5000.T4 Time (ms)

Monitoring

Select No.Monitor Call Connections

Call Monitor Interval (sec)

Monitor VoIP Hosts

VoIP Host Monitor Interval (sec)

Step 71 Select Submit.
Step 72 On the Configuration menu, select VoIP > Media.
Step 73 On the VoIP Media Settings page, enter the following settings.
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Table 256: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select RFC2833.RTP Fax/Modem Tone Relay Mode

Select Off.RTP Source IP Address Validation

Select Off.RTP Source UDP Port Validation

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select On Demand.RFC 3960 Early Media Support

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Fax

Fax IP-Transport Mode

SRTP

Select RTP Only.SRTP Preference

Select Yes.MKI on Transmit Stream

Select Yes.Key Derivation Enable

Enter 16.Key Derivation Rate

Enter 64.Anti-replay Window Size Hint

Select AES_Counter_Mode.Cipher Mode
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SettingsField

Select SHA1.Authentication Type

Select SHA1_80_bit.Authentication Tag Length

Step 74 Select Submit.
Step 75 On the Configuration menu, select VoIP > QOS.
Step 76 On the VoIP QOS Configuration page, enter the following settings.

Table 257: VoIP QOS Configurative Page Settings

SettingsField

Enter 104.Call Control QOS Byte

Enter 184.RTP QOS Byte

Step 77 Select Submit.
Step 78 On the Configuration menu, select IP.
Step 79 On the IP Settings page, enter the following settings.

Table 258: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

SNTP Server IP Address

Step 80 Select Submit.
Step 81 On the Configuration menu, select Tone Detection.
Step 82 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select Busy and do the

following substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
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e) Hang up the third phone but leave the handsets for the other two phones off.

Step 83 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 82c. from the
third phone.

Step 84 Select Learn.
Step 85 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 86 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 85a.
Step 87 Select Learn.
Step 88 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, selectRingback and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 89 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 88a.
Step 90 Select Learn.
Step 91 Select Submit.
Step 92 Hang up the phones that you used in Step 82.
Step 93 On the System menu, select Restart.
Step 94 On the Restart page, select Restart Unit Now.
Step 95 Repeat Step 2 through Step 94 on all remaining PIMG units.

Configuring Unity Connection for Integration with Nortel Meridian 1 Phone
System

After ensuring that the Nortel Meridian 1 phone system, the PIMG units, and Unity Connection are ready for
the integration, do the following procedure to set up the integration and to enter the port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
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Step 6 Select Save.
Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 259: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 260: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled
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ConsiderationsField

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.

Table 261: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification
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ConsiderationsField

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note

Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 262: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From
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SettingField

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is

checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

Table 263: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
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Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone
system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.

PIMG Integration Guide for Cisco Unity Connection Release 12.X
221

Setting Up a Nortel Meridian 1 Digital PIMG Integration with Cisco Unity Connection
Creating an Integration



PIMG Integration Guide for Cisco Unity Connection Release 12.X
222

Setting Up a Nortel Meridian 1 Digital PIMG Integration with Cisco Unity Connection
Creating an Integration



C H A P T E R 11
Setting Up a Rolm 9751 Digital PIMG Integration
with Cisco Unity Connection

• Task List for ROLM 9751 Digital PIMG Phone System Integration, on page 223
• Requirements, on page 224
• Programming ROLM 9751 Digital PIMG Phone System for Integration, on page 225
• Setting Up Digital Rolm PIMG Units, on page 229
• Configuring Unity Connection for Integration with Rolm 9751 Phone System, on page 244

Task List for ROLM 9751 Digital PIMG Phone System Integration
Before doing the following tasks to integrate Unity Connection with the ROLM 9751 phone system using
PIMG units (media gateways), confirm that the Unity Connection server is ready for the integration after
completing the server installation, following the tasks in the “Installing Cisco Unity Connection” chapter of
the Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Unity Connection
server requirements have been met. See the Requirements, on page 12 section.

2. Plan how the voice messaging ports are used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports, on page 7 chapter.

3. Program the ROLM9751 phone system and extensions. See the Programming ROLM9751 Digital PIMG
Phone System for Integration, on page 225 section.

4. Set up the PIMG units.

5. Create the integration. See the Configuring Unity Connection for Integration with Rolm 9751 Phone
System, on page 244 section.

6. Test the integration. See the Testing the Integration, on page 401 chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Adding New User Templates for Multiple Integrations, on page 407 chapter.
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Requirements
This integration supports configurations of the following components:

Phone System
• ROML 9751 phone system with ROLMphone digital phones.

• One of the following software releases:

• 9005.

• 9006.

• (Software release 9005 only) RolmLink Interface (RLI) card.

• (Software release 9006 only) SLMR-type line card.

• One or more of the applicable PIMG units. For details, see the “Introduction” chapter.

• The voice messaging ports in the phone system connected by digital lines to the ports on the PIMG units.

To simplify troubleshooting, we recommend that you connect the voice messaging ports on the phone system
to the ports on the PIMG units in a planned manner. For example, connect the first phone system voice
messaging port to the first port on the first PIMG unit, connect the second phone system voice messaging port
to the second port on the first PIMG unit, and so on. Alternatively, if you have multiple PIMG units, you can
reduce answer times in the event of a PIMG unit failure by connecting the phone system ports to the PIMG
units in a round-robin fashion. For example, connect the first phone system voice messaging port to the first
port on the first PIMG unit, connect the second phone system voice messaging port to the first port on the
second PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.
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Programming ROLM 9751 Digital PIMG Phone System for
Integration

If you use programming options other than those supplied in the following procedure, the performance of the
integration may be affected.

The following programming instructions are provided as an example only. The specific programming for your
phone system may vary depending on its configuration.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Send MWI Requests, do not send calls to it.

Caution

Programing the Rolm 9751 Phone System (Software Release 9005)

Step 1 Use the MO COS_FEATURE command to modify the class of service (COS) for the voice messaging port and the
ROLMphone 400 lines so that the following features are set as indicated:

• APV (always in privacy)—Yes

• NFL (no flash allowed)—No

• NOH (no howler)—Yes

• DND (do not disturb)—No

Step 2 On an unused Feature Configuration Table, use the CRE BUTTON _400 command to make the following button
assignments for the ROLMphone 400. Cancel all remaining button assignments.

Table 264: Required Button Assignments

SettingButton

Enter LINE 1.9

Enter HOLD.10

Enter CNCT (connect).30

EnterMWCTR (message waiting center).37

Enter XFER (transfer).38

All buttons not listed in Table 264: Required Button Assignments must have no assignments. Otherwise the integration
cannot function correctly.

Step 3 Use the CRE EXT command to create an extension number for each port connects to the PIMG units.
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For example, the first port can be extension 501, the second port can be extension 502, and so on.

Step 4 Use the CRE RPI <xx><yy><zz> (where <xx> is the shelf number, <yy> is the card slot number, and <zz> is the card
channel number) to assign the extension numbers, telephone type (400) and button feature table to the Rolm digital
channels. One RPI channel per PIMG port is required.

Step 5 Use the CRE HD_Group 500 command to place all PIMG ports into a hunt group that has the pilot number 500.
Step 6 Continue with the Setting Up Digital Rolm PIMG Units.

Programing the ROLM 9751Phone System (Software Release 9006)

Step 1 Use the ADDDPLN command to create a dial plan for the voice messaging port extensions with the following settings.

Table 265: ADD Directory Number Table Settings

SettingField

Enter DGTS.TYPE

Enter the extension of the first port connects to the PIMG
units.

DGTS

Enter 0.DPLN

Leave this field blank.CPS

Enter STN.DAR

Enter N.CHECK

Leave this field blank.ACDP

Leave this field blank.AC2

Leave this field blank.CPS2

Leave this field blank.ACDP2

Leave this field blank.SKIPDGTS

Step 2 Repeat Step 1 for all remaining ports connect to the PIMG units.
Step 3 Use the ADDSTN command to configure the PIMG ports as ROLMphone 400 station sets with the following settings.

Accept the default settings for all other fields.

Table 266: PIMG Port Settings

SettingField

Enter 2052.Station Number/Loc

Enter 1- 1-115- 2.Port Location
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SettingField

Enter RP400.Device Type

Enter 10/9.Faceplate#/PrimeKey#

Step 4 Make the following faceplate key assignments.

Table 267: Required Faceplate Key Assignments

SettingKey

Enter RP400.DIGTYPE

Enter LINE.9

Enter CNCT.30

Enter XFER.38

Enter CALLWT.40

Step 5 If you use a hunt group for the PIMG ports, do the following substeps. Otherwise, continue to Step 6.
a) Use the ADDDPLN command to change the dial plan for the pilot number with the following settings.

Table 268: ADD Directory Number Table Settings for the Hunt Group Pilot Number

SettingField

Enter DGTS.TYPE

Enter the pilot number of the hunt group for the PIMG
ports.

DGTS

Enter 0.CPS

Enter HUNT.DAR

Enter N.ACDP

b) Use the ADDHUNT command to add the PIMG port extensions to the hunt group with the following settings.

Table 269: ADD Hunt Group Settings for the PIMG Ports

SettingField

Enter VCE.TYPE

Enter the pilot number of the hunt group for the PIMG
ports.

AC

Enter the number of the dial plan that you created in
Step 1.

DPLN

PIMG Integration Guide for Cisco Unity Connection Release 12.X
227

Setting Up a Rolm 9751 Digital PIMG Integration with Cisco Unity Connection
Programing the ROLM 9751Phone System (Software Release 9006)



SettingField

Enter the extension numbers of all the ports connect to
the PIMG units.

STNO

Leave this field blank.NAME

Enter 0.CQMAX

Enter Y.FNA

Enter LIN.STYPE

Step 6 Use the CHACOS command to configure the class of service (COS) with the following settings for administrators and
technicians who must be able to call the PIMG units directly for troubleshooting.

Table 270: COS Restriction Table Settings

SettingField

Enter the number of the COS that you are setting up.COS

Enter huntb&huntna&mscap.AVCE

Leave this field blank.ADTE

Leave this field blank.AFAX

Leave this field blank.DVCE

Leave this field blank.DDTE

Leave this field blank.DFAX

Step 7 Configure forwarding for all subscriber extensions with the following settings.

Table 271: Forwarding Settings for Subscriber Extensions

SettingField

Enter DN.VCE Call Forward Dest Type

Enter Y.Busy Internal

Enter Y.Busy External

Enter Y.Do Not Disturb Internal

Enter Y.Do Not Disturb External

Enter Y.Ring No Answer Internal

Enter Y.Ring No Answer External

Enter Y.All Conditions Internal
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SettingField

Enter Y.All Conditions External

Enter the pilot number of the hunt group for the PIMG ports.Night Option: VCE Call Forward Dest 1

Leave this field blank.Night Option: VCE Call Forward Dest 2

Leave this field blank.Station Hunt Dest

Enter Y.DNIS Display

Enter N.Delayed CFW on Busy

Leave this field blank.Simplex Voice Call Dest

Step 8 Continue with the Setting Up Digital Rolm PIMG Units.

Setting Up Digital Rolm PIMG Units
Do the following procedures to set up the digital Rolm PIMG units that are connected to the Siemens Hicom
150 phone system.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the digital Rolm PIMG units using digital lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the documentation for the PIMG units.

Downloading the PIMG Firmware Update Files for Digital Rolm PIMG Units

Step 1 On a Windows workstation with a high-speed Internet connection that have access to the PIMG units, go to the Voice
and Unified Communications Downloads page at
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.

To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

Note

Step 2 In the tree control on the Downloads Home page, expand Unified Communications> Unified Communications
Applications > Messaging > Cisco Unity and select Cisco Unity Telephony Integration.

Step 3 On the Log In page, enter your username and password, then select Log In.
Step 4 On the Select a Release page, under Latest Releases, select the most recent release.
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Step 5 In the right column, select the version of the firmware for digital Rolm PIMG units.

Step 6 On the Download Image page, select Download.
Step 7 On the Supporting Document(s) page, select Agree.
Step 8 In the File Download dialog box, select Save.
Step 9 In the Save As dialog box, browse to the Windows workstation that have access the PIMG units, browse to a directory

where you want to save the file, and select Save.
Step 10 In the Download Complete dialog box, selectOpen. The window for extracting the PIMG firmware update files appears.
Step 11 Select Extract.
Step 12 In the Extract dialog box, browse to the directory where you want the extracted files, and select Extract.
Step 13 Close the window for the extracting application.

Setting Up the Digital Rolm PIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the PIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 2 Connect a PIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.

Table 272: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
Step 7 On the Upgrade page, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted PIMG firmware

update files.
Step 9 SelectMtl_<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.
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Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file installation fails.
Restarting the PIMG unit at this step may prevent the PIMG unit from functioning correctly.

Step 12 Repeat Step 6 through Step 11 for each of the following files (where <xx> is multiple digits):

• Mtl_<xx>.fsh

• Run<xx>FskEcho.dsp

• Mtl<xx>.lca

Step 13 On the Configuration menu, select Import/Export.
Step 14 On the Import/Export page, select Browse.
Step 15 In the Choose File dialog box, browse to the file RLMDNI_Cfg_Rolm.ini.
Step 16 Select RLMDNI_Cfg_Rolm.ini, and select Open.
Step 17 On the Import/Export page, select Import File.
Step 18 After the file is imported, a message prompting you to restart the PIMG unit appears. Select OK.
Step 19 In the web browser, go to http://10.12.13.74.
Step 20 To sign in, enter the following case-sensitive settings.

Table 273: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 21 Select OK.
Step 22 If your Unity Connection systemmust have an RTP port range of 16384 to 32767, do the following substeps. Otherwise,

continue to Step 23.

Youmust set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to 32767. Otherwise,
Unity Connection cannot be able answer calls and callers hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. SomeUnity Connection configurations require
a different RTP port range.

Note

a) On the Configuration menu, select Import/Export.
b) On the Import/Export page, under Export Files, select Export All Settings.
c) In the File Download dialog box, select Save.
d) In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units, browse to a

directory where you want to save the file, and select Save.
e) In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you saved.
f) Locate the line with the following parameter:

gwRTPStartPort

g) Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384
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h) Locate the line with the following parameter:

gwRTPEndPort

i) Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

j) Save the file, and exit Notepad.
k) On the Configuration menu of the PIMG unit, select Import/Export.
l) On the Import/Export page, under Browse for Import File, select Browse.
m) In the Choose File dialog box, browse to the file Config.ini that you saved.
n) Select Config.ini, and select Open.
o) On the Import/Export page, select Import File.
p) When prompted to restart the PIMG unit, select OK.
q) When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.
r) To sign in, enter the following case-sensitive settings.

Table 274: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

s) Select OK.

Step 23 On the System menu, select Password.
Step 24 On the Change Password page, enter the following settings.

Table 275: Change Password Page Settings

SettingField

Enter IpodAdmin. (This setting is case sensitive.)Old Password

Enter your new password. (This setting is case sensitive.)New Password

Enter your new password. (This setting is case sensitive.)Confirm Password

Step 25 Select Change.
Step 26 On the Configuration menu, select Routing Table.
Step 27 On the Routing Table page, under Router Configuration, select VoIP Host Groups.
Step 28 Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 276: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name of
the VoIP host group.

Name
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SettingsField

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select True.

Fault-Tolerant

Step 29 For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity Connection
server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, enter the host name or IP address of the subscriber
server (the second Unity Connection server that you installed) and the server port in the format <host name or IP
address>:5060.

Step 30 For Unity Connection without a cluster, continue to Step 32. For Unity Connection with a cluster configured, select
Add Host.

Step 31 In the second field, enter the host name or IP address of the publisher server (the first Unity Connection server that you
installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the Unity Connection
cluster may not function correctly.

Step 32 Select Submit.
Step 33 Under Router Configuration, select TDM Trunk Groups.
Step 34 Under TDM Trunk Groups, select Add Trunk Group.
Step 35 Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.

Table 277: First TDM Trunk Group Settings (Inbound Calls)

SettingsField

Enter Inbound_PBX_Calls or another unique name.

This TDM trunk group handles all incoming calls from
the phone system.

Name

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports that handle inbound
calls. For example, enter “*” for all PIMG ports, or enter
“1-6” for the first six PIMG ports.

Port/Channel Content

Step 36 Under TDM Trunk Groups, select Add Trunk Group.
Step 37 Enter the following settings for the second TDM trunk group.
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Table 278: Second TDM Trunk Group Settings (MWIs)

SettingsField

EnterMWIs or another unique name.

This TDM trunk group handles outbound MWI calls
(where applicable).

Name

Select Ascending.Selection Direction

Select Cyclic.Selection Mode

Enter the numbers of the PIMG ports that dial out MWIs.
For example, enter “*” for all PIMG ports, or enter “7,8”
for the last two PIMG ports.

Port/Channel Content

Step 38 Under TDM Trunk Groups, select Add Trunk Group.
Step 39 Enter the following settings for the third TDM trunk group.

Table 279: Third TDM Trunk Group Settings (Outbound Calls)

SettingsField

Enter Outbound_PBX_Calls or another unique name.

This TDM trunk group handles all outbound calls from
Unity Connection.

Name

Select Descending.Selection Direction

Select Linear.Selection Mode

Enter * for all channels in all ports.

Enter the numbers of the PIMGports that handles outbound
(dialout) calls. For example, enter “*” for all PIMG ports,
or enter “7,8” for the last two PIMG ports.

Port/Channel Content

Step 40 Select Submit.
Step 41 Under Router Configuration, select Inbound VoIP Rules.
Step 42 Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.
Step 43 Select Add Rule.
Step 44 Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 280: First New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable
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SettingsField

EnterMWI_Calls or another name.

This inbound VoIP rule handles all MWI calls from Unity
Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address

Step 45 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another rule.

Table 281: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 46 Under Outbound Routes, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another rule.

Table 282: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for MWIs in Step 37. For example, select “MWIs.

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name
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SettingsField

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 47 Under Inbound VoIP Rules, select Add Rule.
Step 48 Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.

Table 283: Second New Inbound VoIP Rule Settings (Outbound Calls)

SettingsField

Check this check box.Enable

Enter Outbound_UC_Calls or another name.

This inbound VoIP rule handle all outbound calls from
Unity Connection.

Rule Label

Select Call.Request Type

Enter *.Originating VoIP Host Address

Step 49 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.

Table 284: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 50 Under Outbound Routes, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.
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Table 285: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for outbound calls in Step 39. For example, select
“Outbound_PBX_Calls.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 51 Select Submit.
Step 52 Under Router Configuration, select Inbound TDM Rules.
Step 53 Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.

Table 286: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule handles all incoming calls from
the phone system.

Rule Label

Select Call.Request Type

Select the name of the TDM trunk group that you created
for incoming calls from the phone system in Step 35. For
example, select “Inbound_PBX_Calls.”

Trunk Group

Step 54 Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another rule.
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Table 287: Inbound TDM Request Matching Settings

SettingsField

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Name

Step 55 Under Outbound Routes, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another rule.

Table 288: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination

Select the name of the VoIP host group that you created
for Unity Connection in Step 28.

Host Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary
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Step 56 If you want to create more Inbound TDM rules, under Inbound TDM Rules, select Add Rule. Otherwise, continue to
Step 58.

Step 57 Repeat Step 53 through Step 56 for all remaining inbound TDM rules that you want to create.
Step 58 Select Submit.
Step 59 On the Configuration menu, select TDM > Digital.
Step 60 On the Digital Telephony page, in the Telephony Switch Type field, select the applicable setting for your phone system:

• Rolm_9751_SW9005

• Rolm_9751_SW9006

Step 61 Select Submit.
Step 62 On the Configuration menu, select TDM > General.
Step 63 On the TDM General Settings page, enter the following settings.

Table 289: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Leave this field blank.Turn MWI On FAC

Leave this field blank.Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Select No.Disconnect on Fax Cleardown Tone

Step 64 Select Submit.
Step 65 On the Configuration menu, select TDM > Port Enable.
Step 66 On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.
Step 67 Confirm that Yes is selected for all other ports on the PIMG unit.
Step 68 Select Submit.
Step 69 On the Configuration menu, select VoIP > General.
Step 70 On the VoIP General Settings page, enter the following settings.
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Table 290: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Select No.SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that the
PIMG unit uses.

DNS Server Address

Select No.DNS Translation of Phone Numbers

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Enter 30.TCP Inactivity Timer (sec)

TLS

Select No.TLS Transport Enabled

Enter 5061.TLS Server Port

Select SSLv3 TLSv1.SSL TLS Protocol

Select Yes.Mutual TLS Authentication Required

Enter 30.TLS Inactivity Timer (sec)

Select Yes.Verify TLS Peer Certificate Date

Select Yes.Verify TLS Peer Certificate Trust

Proxy

Leave this field blank.Primary Proxy Server Address
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SettingField

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Enter 5000.T4 Time (ms)

Monitoring

Select No.Monitor Call Connections

Call Monitor Interval (sec)

Monitor VoIP Hosts

VoIP Host Monitor Interval (sec)

Step 71 Select Submit.
Step 72 On the Configuration menu, select VoIP > Media.
Step 73 On the VoIP Media Settings page, enter the following settings.

Table 291: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select RFC2833.RTP Fax/Modem Tone Relay Mode

Select Off.RTP Source IP Address Validation

Select Off.RTP Source UDP Port Validation

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select On Demand.RFC 3960 Early Media Support

PIMG Integration Guide for Cisco Unity Connection Release 12.X
241

Setting Up a Rolm 9751 Digital PIMG Integration with Cisco Unity Connection
Setting Up the Digital Rolm PIMG Units (Firmware Version 6.x)



SettingsField

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Fax

Fax IP-Transport Mode

SRTP

Select RTP Only.SRTP Preference

Select Yes.MKI on Transmit Stream

Select Yes.Key Derivation Enable

Enter 16.Key Derivation Rate

Enter 64.Anti-replay Window Size Hint

Select AES_Counter_Mode.Cipher Mode

Select SHA1.Authentication Type

Select SHA1_80_bit.Authentication Tag Length

Step 74 Select Submit.
Step 75 On the Configuration menu, select VoIP > QOS.
Step 76 On the VoIP QOS Configuration page, enter the following settings.

Table 292: VoIP QOS Configurative Page Settings

SettingsField

Enter 104.Call Control QOS Byte

Enter 184.RTP QOS Byte

Step 77 Select Submit.
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Step 78 On the Configuration menu, select IP.
Step 79 On the IP Settings page, enter the following settings.

Table 293: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

SNTP Server IP Address

Step 80 Select Submit.
Step 81 On the Configuration menu, select Tone Detection.
Step 82 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select Busy and do the

following substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.

Step 83 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 82c. from the
third phone.

Step 84 Select Learn.
Step 85 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 86 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 85a.
Step 87 Select Learn.
Step 88 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, selectRingback and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist.
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

PIMG Integration Guide for Cisco Unity Connection Release 12.X
243

Setting Up a Rolm 9751 Digital PIMG Integration with Cisco Unity Connection
Setting Up the Digital Rolm PIMG Units (Firmware Version 6.x)



Step 89 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 88a.
Step 90 Select Learn.
Step 91 Select Submit.
Step 92 Hang up the phones that you used in Step 82.
Step 93 On the System menu, select Restart.
Step 94 On the Restart page, select Restart Unit Now.
Step 95 Repeat Step 2 through Step 94 on all remaining PIMG units.

Configuring Unity Connection for Integration with Rolm 9751
Phone System

After ensuring that the Rolm 9751 phone system, the PIMG units, and Unity Connection are ready for the
integration, do the following procedure to set up the integration and to enter the port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
Step 6 Select Save.
Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 294: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile
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SettingField

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 295: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.
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By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.

Table 296: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
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Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in
Step 3.

Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note

Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 297: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
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h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is
checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

Table 298: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone

system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.
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C H A P T E R 12
Setting Up a Serial (SMDI, MCI, or MD-110) PIMG
Integration with Cisco Unity Connection

• Setting Up a Serial (SMDI, MCI, or MD-110) PIMG Integration, on page 249

Setting Up a Serial (SMDI, MCI, or MD-110) PIMG Integration

Task List for Serial (SMDI, MCI, or MD-110) PIMG Integration
Before doing the following tasks to integrate Unity Connection with the Serial phone system using PIMG
units (media gateways), confirm that the Unity Connection server is ready for the integration after completing
the server installation, following the tasks in the “Installing Cisco Unity Connection” chapter of the Install,
Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Unity Connection
server requirements have been met. See the Requirements, on page 12 section.

2. Plan how the voice messaging ports are used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports, on page 7 chapter.

3. Program the phone system and extensions. See the Programming Phone System for a Serial Integration
section.

4. Set up the PIMG units. See the Setting Up Analog PIMG Units for a Serial Integration section.

5. Create the integration. See the Configuring Unity Connection for Integration with the Phone System, on
page 267 section.

6. Test the integration. See the Testing the Integration, on page 401 chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Adding New User Templates for Multiple Integrations, on page 407 chapter.

Requirements
This integration supports configurations of the following components:
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Phone System
• A phone system that supports the SMDI, MCI, or MD-110 serial protocols.

• For a Centrex phone system only:

• A Centrex service SMDI package, with one SMDI 4-wire private data link connected to the external
modem.

• A type 202T or 212A external modem, set to 1200 baud.

• One or more of the applicable PIMG units. For details, see the "Introduction” chapter.

• The serial data port on the phone system connected to the serial port on the master PIMG unit through
an RS-232 serial cable (which is available from Cisco).

Specifications for the serial cable are in Connecting PBX-IP Media Gateway (PIMG) to the Serial Port of a
PBX at http://www.dialogic.com/support/helpweb/mg/tn117.htm.

We recommend that the serial cable have the following construction:

• A maximum of 50 feet (15.24 m) in length

• 24 AWG stranded conductors

• Low capacitance—for example, no more than 12 pF/ft (39.4 pF/m) between conductors

• At least 65 percent braided shield over aluminized polymer sleeve around conductors

• UL-recognized overall cable jacket insulation with low dielectric constant

• Braided shield fully terminated to and enclosed by a metal connector backshell

• Gold-plated connector contacts

• The voice messaging ports in the phone system connected by analog lines to the ports on the PIMG units.

We recommend that you connect the voice messaging ports on the phone system to the ports on the PIMG
units in a planned manner to simplify troubleshooting. For example, the first phone system voice messaging
port connects to the first port on the first PIMG unit, the second phone system voice messaging port connects
to the second port on the first PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.
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Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.

Programming Phone System for a Serial Integration
If you use programming options other than those supplied in the following procedure, the performance of the
integration may be affected.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Perform Message Notification, do not send calls to it.

Caution

Do the following steps to program the phone system for a serial integration with Unity Connection

Step 1 Program the analog lines connecting to the voice messaging ports on the PIMG units as a multiline hunt group.

Make sure that the phone system sends calls only to Unity Connection voice ports that are set to Answer Calls. Calls sent
to a voice port not set to Answer Calls cannot be answered by Unity Connection and may cause other problems.

Step 2 Enable hookflash transfer capability on each analog line that connects to the voice messaging ports on the PIMG units.
Step 3 Enable caller ID (via SMDI, MCI, or MD-110) on each subscriber extension.
Step 4 For each subscriber extension, set the call forwarding options to the following:

• Unrestricted source

• Forward when the extension is not answered

• Forward when the extension is busy

Setting Up Analog PIMG Units for a Serial Integration
Do the following procedures to set up the analog PIMG units that are connected to the phone system for a
serial integration using the SMDI, MCI, or MD-110 protocol.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the PIMG units using analog lines and the applicable RS-232 serial
cable.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.
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Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the PIMG units.

Downloading PIMG Firmware Update Files for Analog PIMG Units

Step 1 On a Windows workstation with a high-speed Internet connection that have access to the PIMG units, go to the Voice
and Unified Communications Downloads page at
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.

To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

Note

Step 2 In the tree control on the Downloads Home page, expand Unified Communications> Unified Communications
Applications > Messaging > Cisco Unity and select Cisco Unity Telephony Integration.

Step 3 On the Log In page, enter your username and password, then select Log In.
Step 4 On the Select a Release page, under Latest Releases, select the most recent release.
Step 5 In the right column, select the version of the firmware for analog PIMG units.
Step 6 On the Download Image page, select Download.
Step 7 On the Supporting Document(s) page, select Agree.
Step 8 In the File Download dialog box, select Save.
Step 9 In the Save As dialog box, browse to the Windows workstation that have access the PIMG units, browse to a directory

where you want to save the file, and select Save.
Step 10 In the Download Complete dialog box, selectOpen. The window for extracting the PIMG firmware update files appears.
Step 11 Select Extract.
Step 12 In the Extract dialog box, browse to the directory where you want the extracted files, and select Extract.
Step 13 Close the window for the extracting application.

Setting Up Analog PIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the PIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 2 Connect a PIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.
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Table 299: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
Step 7 On the Upgrade page, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on the Windows workstation that has the extracted PIMG

firmware update files.
Step 9 Select Ls_<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.

Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file installation fails.
Restarting the PIMG unit at this step may prevent the PIMG unit from functioning correctly.

Step 12 Repeat Step 6 through Step 11 for the file Run_<xx > .dsp.
Step 13 On the System menu, select Upgrade.
Step 14 On the Upgrade page, under Import, select Browse.
Step 15 In the Choose File dialog box, browse to the file Ls_<xx > .fsh.
Step 16 Select Ls_<xx > .fsh, and select Open.
Step 17 On the Upgrade page, select Install File.
Step 18 After the file is installed, a message prompting you to restart the PIMG unit appears. Select OK.
Step 19 In the web browser, go to http://10.12.13.74.
Step 20 To sign in, enter the following case-sensitive settings.

Table 300: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 21 Select OK.
Step 22 If your Unity Connection systemmust have an RTP port range of 16384 to 32767, do the following substeps. Otherwise,

continue to Step 23.

You must set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to 32767.
Otherwise, Unity Connection cannot answer calls and callers hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. Some Unity Connection configurations
require a different RTP port range.

Note

a) On the Configuration menu, select Import/Export.
b) On the Import/Export page, under Export Files, select Export All Settings.
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c) In the File Download dialog box, select Save.
d) In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units, browse to a

directory where you want to save the file, and select Save.
e) In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you saved.
f) Locate the line with the following parameter:

gwRTPStartPort

g) Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384

h) Locate the line with the following parameter:

gwRTPEndPort

i) Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

j) Save the file, and exit Notepad.
k) On the Configuration menu of the PIMG unit, select Import/Export.
l) On the Import/Export page, under Browse for Import File, select Browse.
m) In the Choose File dialog box, browse to the file Config.ini that you saved.
n) Select Config.ini, and select Open.
o) On the Import/Export page, select Import File.
p) When prompted to restart the PIMG unit, select OK.
q) When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.
r) To sign in, enter the following case-sensitive settings.

Table 301: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

s) Select OK.

Step 23 On the System menu, select Password.
Step 24 On the Change Password page, enter the following settings.

Table 302: Change Password Page Settings

SettingField

Enter IpodAdmin. (This setting is case sensitive.)Old Password

Enter your new password. (This setting is case sensitive.)New Password

Enter your new password. (This setting is case sensitive.)Confirm Password
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Step 25 Select Change.
Step 26 On the Configuration menu, selectMgmt Protocols.
Step 27 On the Management Protocols page, enter the following settings.

Table 303: Management Protocols Page Settings

SettingsField

Select No.E-mail Alarms Enabled

Select No.SNMP Traps Enabled

Step 28 Select Submit.
Step 29 On the Configuration menu, select Routing Table.
Step 30 On the Routing Table page, under Router Configuration, select VoIP Host Groups.
Step 31 Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 304: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name of
the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) SelectFalse.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) SelectTrue.

Fault-Tolerant

Step 32 For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity Connection
server and the server port in the format <host name or IP address>:5060.

For Cisco Unity Connection with a cluster configured, under Host List, enter the host name or IP address of the
subscriber server (the second Unity Connection server that you installed) and the server port in the format <host name
or IP address>:5060.

Step 33 For Unity Connection without a cluster, continue to Step 35. For Unity Connection with a cluster configured, select
Add Host.

Step 34 In the second field, enter the host name or IP address of the publisher server (the first Unity Connection server that
you installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the Unity
Connection cluster may not function correctly.

Step 35 Select Submit.
Step 36 Under Router Configuration, select TDM Trunk Groups.
Step 37 Under TDM Trunk Groups, select Add Trunk Group.
Step 38 Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.
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Table 305: First TDM Trunk Group Settings (All Calls)

SettingsField

Enter All_Calls or another unique name.

This TDM trunk group handles all calls to and from the
phone system.

Name

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports that handle all calls.
For example, enter “*” for all PIMG ports, or enter “1-6”
for the first six PIMG ports.

Port/Channel Content

Step 39 Select Submit.
Step 40 Under Router Configuration, select Inbound VoIP Rules.
Step 41 Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.
Step 42 Select Add Rule.
Step 43 Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 306: First New Inbound VoIP Rule Settings (All Calls)

SettingsField

Check this check box.Enable

Do one of the following:

• If you use CPID manipulation, enter All_UC_Calls
or another name.

This inbound VoIP rule handles all outbound calls from
Unity Connection.

• If you cannot use CPID manipulation, enter
UC_Calls_and_Messages or another name.

This inbound VoIP rule handles all outbound calls and
MWI calls from Unity Connection.

Rule Label

Do one of the following:

• If you use CPID manipulation, select Call.

• If you cannot use CPID manipulation, select Any.

Request Type

Enter *.Originating VoIP Host Address

Step 44 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 43 must be selected. Otherwise, any changes you make apply to another rule.
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Table 307: Inbound VoIP Request Matching Settings

SettingsField

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Name

Step 45 Under Outbound Routes, enter the following settings.

The rule that you created in Step 43 must be selected. Otherwise, any changes you make apply to another rule.

Table 308: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for outbound calls in Step 38. For example, select
“All_Calls.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary
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Step 46 If you cannot use CPID manipulation, skip to Step 50. Otherwise, under Inbound VoIP Rules, select Add Rule.
Step 47 Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.

Table 309: Second New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable

Enter UC_MWIs or another name.

This inbound VoIP rule handles all MWIs from Unity
Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address

Step 48 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 47 must be selected. Otherwise, any changes you make apply to another rule.

Table 310: Inbound VoIP Request Matching Settings

SettingsField

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Name

Step 49 Under Outbound Routes, enter the following settings.

The rule that you created in Step 47 must be selected. Otherwise, any changes you make apply to another rule.

Table 311: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination
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SettingsField

Select the name of the TDM trunk group that you created
for outbound calls in Step 38. For example, select
“All_Calls.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 50 Select Submit.
Step 51 Under Router Configuration, select Inbound TDM Rules.
Step 52 Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.

Table 312: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule handles all incoming calls from
the phone system.

Rule Label

Select Call.Request Type

Select the name of the TDM trunk group that you created
for incoming calls from the phone system in Step 38. For
example, select “All_Calls.”

Trunk Group

Step 53 Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 52 must be selected. Otherwise, any changes you make apply to another rule.
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Table 313: Inbound TDM Request Matching Settings

SettingsField

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Name

Step 54 Under Outbound Routes, enter the following settings.

The rule that you created in Step 52 must be selected. Otherwise, any changes you make apply to another rule.

Table 314: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination

Select the name of the VoIP host group that you created
for Unity Connection in Step 31.

Host Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary
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Step 55 If you want to create more Inbound TDM rules, under Inbound TDM Rules, select Add Rule. Otherwise, continue
to Step 57.

Note that additional Inbound TDM rules are not necessary if you cannot use CPID manipulation.

Step 56 Repeat Step 52 through Step 55 for all remaining inbound TDM rules that you want to create.
Step 57 Select Submit.
Step 58
Step 59
Step 60
Step 61 On the Configuration menu, select TDM > General.
Step 62 On the TDM General Settings page, enter the following settings.

Table 315: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Leave this field blank.Turn MWI On FAC

Leave this field blank.Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Step 63 Select Submit.
Step 64 On the Configuration menu, select TDM > Port Enable.
Step 65 On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.
Step 66 Confirm that Yes is selected for all other ports on the PIMG unit.
Step 67 Select Submit.
Step 68 On the Configuration menu, select VoIP > General.
Step 69 On the VoIP General Settings page, enter the following settings.
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Table 316: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that the
PIMG unit uses.

DNS Server Address

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Proxy

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Monitoring

Select No.Monitor Call Connections

Step 70 Select Submit.
Step 71 On the Configuration menu, select VoIP > Media.
Step 72 On the VoIP Media Settings page, enter the following settings.
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Table 317: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Step 73 Select Submit.
Step 74 On the Configuration menu, select VoIP > QOS.
Step 75 On the VoIP QOS Configuration page, enter the following settings.

Table 318: VoIP QOS Configurative Page Settings

SettingsField

Enter 104.Call Control QOS Byte

Enter 184.RTP QOS Byte

Step 76 Select Submit.
Step 77 On the Configuration menu, select IP.
Step 78 On the IP Settings page, enter the following settings.
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Table 319: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

Step 79 Select Submit.
Step 80 On the Configuration menu, select Serial > General.
Step 81 On the Serial Port, COM 1 page, enter the following settings.

Table 320: Serial Port, COM 1 Page Settings

SettingsField

Select the setting that is configured on the phone system.

The default setting is 9600.

Serial Port Baud Rate

Select the setting that is configured on the phone system.

The default setting is None.

Serial Port Parity

Select the setting that is configured on the phone system.

The default setting is 8.

Serial Port Data Bits

Select the setting that is configured on the phone system.

The default setting is 1.

Serial Port Stop Bits

Step 82 Select Submit.
Step 83 On the Configuration menu, select Serial > Switch Protocol.
Step 84 On the Switch Protocol page, enter the following settings.

Table 321: Switch Protocol Page Settings

SettingsField

Serial Port, COM 1
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SettingsField

Select the applicable setting:

• Master—Select this setting when this PIMG unit is
connected to the data link serial cable from the phone
system. There can be only one master PIMG unit in
a phone system integration.

• Slave—Select this setting when this PIMG unit is
not connected to the data link serial cable from the
phone system. There can be multiple slave PIMG
units in a phone system integration.

Serial Mode

Select the serial protocol that your phone system uses:

• SMDI

• MCI

• MD-110

Serial Interface Protocol

Select the applicable setting. Typically, the settings are
7 or 10.

Cpid Len

Enter the applicable string or leave this field blank.
Typically, the setting is one of the following:

• A string of zeros, where the number of zeros matches
the setting of the Cpid Len field.

• A prefix that is provided by the Centrex service.

Cpid Padding String

If the setting of the Serial Interface Protocol field is
MD-110, enter 2. Otherwise, accept the default of 7.

Voice Mail Port Len

Enter the applicable setting. Typically, the setting is 1.System Number

Enter 2000.MWI Response Timeout

If the PIMG unit is the master, this field is for display
only.

If the PIMG unit is a slave, enter the IP address of the
master PIMG unit (the PIMG unit that is connected to the
data link serial cable from the phone system).

IP Address of Serial Server

Enter 2000.Serial Cpid Expiration

Logical Extension Number
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SettingsField

If the setting of the Serial Interface Protocol field is MCI
or MD-110, enter the extension number for each port on
the PIMG unit.

If the setting of the Serial Interface Protocol field is
SMDI, enter the logical port number. Typically, the setting
is 1 for port 1, 2 for port 2, and so on beginning with the
master PIMG unit and continuing through each of the
slave PIMG units.

1

2

3

4

5

6

7

8

Step 85 Select Submit.
Step 86 On the Configure menu, select Tone Detection.
Step 87 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select Busy and do

the following substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.

Step 88 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 87c. from the
third phone.

Step 89 Select Learn.
Step 90 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 91 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 90a.
Step 92 Select Learn.
Step 93 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Ringback and do the

following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist.
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 94 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 93a.
Step 95 Select Learn.
Step 96 Select Submit.
Step 97 Hang up the phones that you used in Step 87.
Step 98 On the System menu, select Restart.
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Step 99 On the Restart page, select Restart Unit Now.
Step 100 Repeat Step 2 through Step 99 on all remaining PIMG units.

Configuring Unity Connection for Integration with the Phone System
After ensuring that the phone system, the PIMG units, and Unity Connection are ready for the integration, do
the following procedure to set up the integration and to enter the port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
Step 6 Select Save.
Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 322: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name
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SettingField

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 323: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.
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Table 324: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note
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Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 325: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is

checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.
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Table 326: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone

system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.
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C H A P T E R 13
Setting Up a Siemens Hicom 150 Analog PIMG
Integration with Cisco Unity Connection

• Setting Up a Siemens Hicom 150 Analog PIMG Integration, on page 273

Setting Up a Siemens Hicom 150 Analog PIMG Integration

Task List for ROLM 9751 Digital PIMG Phone System Integration
Before doing the following tasks to integrate Unity Connection with the ROLM 9751 phone system using
PIMG units (media gateways), confirm that the Unity Connection server is ready for the integration after
completing the server installation, following the tasks in the “Installing Cisco Unity Connection” chapter of
the Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Unity Connection
server requirements have been met. See the Requirements, on page 12 section.

2. Plan how the voice messaging ports are used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports, on page 7 chapter.

3. Program the ROLM9751 phone system and extensions. See the Programming ROLM9751 Digital PIMG
Phone System for Integration, on page 225 section.

4. Set up the PIMG units.

5. Create the integration. See the Configuring Unity Connection for Integration with Rolm 9751 Phone
System, on page 244 section.

6. Test the integration. See the Testing the Integration, on page 401 chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Adding New User Templates for Multiple Integrations, on page 407 chapter.

Requirements
This integration supports configurations of the following components:
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Phone System
• The Siemens Hicom 150 phone system.

• Software version HE520MO4.809 or later.

• One or more of the applicable PIMG units. For details, see the “Introduction” chapter.

• The voice messaging ports in the phone system connected by analog lines to the ports on the PIMG units.

We recommend that you connect the voice messaging ports on the phone system to the ports on the PIMG
units in a planned manner to simplify troubleshooting. For example, the first phone system voice messaging
port connects to the first port on the first PIMG unit, the second phone system voice messaging port connects
to the second port on the first PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.

Programming Siemens Hicom 150 Phone System for Integration
If you use programming options other than those supplied in the following procedure, the performance of the
integration may be affected.

The following programming instructions are provided as an example only. The specific programming for your
phone system may vary depending on its configuration.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Send MWI Requests, do not send calls to it.

Caution

Do the following steps to program the Siemens Hicom 150 phone system.
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Step 1 In the Siemens Hicom 150 interface, configure the stations for the ports on all of the PIMG units using the following
settings.

Table 327: Station Settings

SettingField

Enter the internal call number that is associated with each
port on the PIMG units.

Call No.

Enter the DID for ports on the PIMG units dialing out (for
example, to set MWIs).

DID

Enter a name that you want for the station. For example,
enter “PIMG port 1” for the first port. Note that you can
enter a maximum of 16 characters.

Name

(Display only) The phone device that the phone system
has configured for the port.

Type

Select PhoneMail for the applicable dial plan.Type

Step 2 Select Apply.
Step 3 Configure the access number to forward calls to subscriber mailboxes.
Step 4 Configure the hunt group for the ports on the PIMG units that answer calls using the following settings.

Table 328: Hunt Group Settings

SettingField

Select an available index that you want to use for the ports
on the PIMG units.

Index

Enter the pilot number for Unity Connection.Call No.

Enter the four-digit DID that is associated with call number
that is associated with the hunt group.

DID

Enter a name for the hunt group.Name

From the drop-down box, select Linear.

You must use a linear hunt group. Otherwise, the
integration cannot function correctly.

Type

Step 5 Select Apply.
Step 6 Under Group, in the Call No. column, select the call number for the hunt group that you created in Step 4.
Step 7 In the Selection box, highlight all the ports on the PIMG units that answer calls.
Step 8 Add the highlighted ports to the Members box by selecting -.
Step 9 In the Members box, highlight the ports that dial out (for example, to set MWIs), and selectDown until all dialout ports

are at the bottom of the box.
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Step 10 Configure call forwarding for the ports on the PIMG units that answer calls. For the fields under Call Dest. List -
Definition, use the following settings.

Table 329: Call Dest. List - Definition Settings

SettingField

The call destination number that you use for the ports on
the PIMG units.

No.

Leave this field blank.Target 1

Enter 1 (which equals about 5 seconds).Cycles

Select Immediate.SR Type

Check this check box.RNA

Step 11 Under Call Dest. List - Station Assignment, select Show All Stations.
Step 12 In the table, assign the call destination for the definition using the following settings.

Table 330: Call Dest. List - Station Assignment Settings

SettingField

Select the extension for a port on the PIMG units, which
you assigned in Step 1.

Call No.

From the drop-down box, select the call destination
number, which you defined in Step 10.

Day

From the drop-down box, select the call destination
number, which you defined in Step 10.

Night

From the drop-down box, select the call destination
number, which you defined in Step 10.

Internal

Step 13 Select Apply.
Step 14 Repeat Step 12 and Step 13 for all remaining ports on the PIMG units.
Step 15 Program each phone to forward calls to the pilot number assigned to the voice messaging ports, based on one of the

Unity Connection call transfer types shown in Table 331: Call Transfer Types.

Table 331: Call Transfer Types

UsageTransfer Types

Program the phone to forward calls to the pilot number
when:

• The extension is busy

• The call is not answered

Release transfer (blind transfer)
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UsageTransfer Types

Program the user station to forward calls to the pilot
number only when the call is not answered (on the phone
system, the number of rings before forwarding must be
more than the number of rings to supervise the call).
Confirm that call forwarding is disabledwhen the extension
is busy.

Supervised transfer

Setting Up the Analog PIMG Units for a DTMF Integration
Do the following procedures to set up the analog PIMG units that are connected to the Siemens Hicom 150
phone system for a DTMF integration.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the PIMG units using analog lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the PIMG units.

Downloading PIMG Firmware Update Files for Analog PIMG Units

Step 1 On a Windows workstation with a high-speed Internet connection that have access to the PIMG units, go to the Voice
and Unified Communications Downloads page at
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.

To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

Note

Step 2 In the tree control on the Downloads Home page, expand Unified Communications> Unified Communications
Applications > Messaging > Cisco Unity and select Cisco Unity Telephony Integration.

Step 3 On the Log In page, enter your username and password, then select Log In.
Step 4 On the Select a Release page, under Latest Releases, select the most recent release.
Step 5 In the right column, select the version of the firmware for analog PIMG units.

Step 6 On the Download Image page, select Download.
Step 7 On the Supporting Document(s) page, select Agree.
Step 8 In the File Download dialog box, select Save.
Step 9 In the Save As dialog box, browse to the Windows workstation that have access the PIMG units, browse to a directory

where you want to save the file, and select Save.
Step 10 In the Download Complete dialog box, selectOpen. The window for extracting the PIMG firmware update files appears.
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Step 11 Select Extract.
Step 12 In the Extract dialog box, browse to the directory where you want the extracted files, and select Extract.
Step 13 Close the window for the extracting application.

Setting Up Analog PIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the PIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 2 Connect a PIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.

Table 332: Sign-in Settings

SettingsField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
Step 7 On the Upgrade page, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted PIMG firmware

update files.
Step 9 Select Ls_<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.

Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file installation fails.
Restarting the PIMG unit at this step may prevent the PIMG unit from functioning correctly.

Step 12 Repeat Step 6 through Step 11 for the following files:

• Run_<xx>FskEcho.dsp

• Ls_<xx>.fsh

1. On the Configuration menu, select Import/Export.
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2. On the Import/Export page, select Browse.

3. In the Choose File dialog box, browse to the file Ls_Cfg_Hicom300E.ini.

4. Select Ls_Cfg_Hicom300E.ini, and select Open.

5. On the Import/Export page, select Import File.

6. After the file is imported, a message prompting you to restart the PIMG unit appears. Select OK.

7. In the web browser, go to http://10.12.13.74.

8. To sign in, enter the following case-sensitive settings.

Table 333: Sign-in Settings

SettingsField

Enter admin.Username

Enter IpodAdmin.Password

1. Select OK.

2. Do the following substeps to configure an RTP port range of 16384 to 32767.

You must set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to
32767. Otherwise, Unity Connection cannot answer calls and callers hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. Some Unity Connection configurations require
a different RTP port range.

Note

1. On the Configuration menu, select Import/Export.

2. On the Import/Export page, under Export Files, select Export All Settings.

3. In the File Download dialog box, select Save.

4. In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units,
browse to a directory where you want to save the file, and select Save.

5. In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you
saved.

6.
7.
8. Locate the line with the following parameter:

gwRTPStartPort

9. Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384

10. Locate the line with the following parameter:
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gwRTPEndPort

11. Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

12. Save the file, and exit Notepad.

13. On the Configuration menu of the PIMG unit, select Import/Export.

14. On the Import/Export page, under Browse for Import File, select Browse.

15. In the Choose File dialog box, browse to the file Config.ini that you saved.

16. Select Config.ini, and select Open.

17. On the Import/Export page, select Import File.

18. When prompted to restart the PIMG unit, select OK.

19. When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.

20. To sign in, enter the following case-sensitive settings.

Table 334: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

1. Select OK.

1. On the System menu, select Password.

2. On the Change Password page, enter the following settings.

Table 335: Change Password Page Settings

SettingsField

Enter IpodAdmin. (This setting is case sensitive.)Old Password

Enter your new password. (This setting is case
sensitive.)

New Password

Enter your new password. (This setting is case
sensitive.)

Confirm Password

1. Select Change.

2. On the Configuration menu, selectMgmt Protocols.

3. On the Management Protocols page, enter the following settings.
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Table 336: Management Protocols Page Settings

SettingsField

Select No.E-mail Alarms Enabled

Select No.SNMP Traps Enabled

1. Select Submit.

2. On the Configuration menu, select Routing Table.

3. On the Routing Table page, under Router Configuration, select VoIP Host Groups.

4. Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 337: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name
of the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select
False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select
True.

Fault-Tolerant

1. For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity
Connection server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, confirm that field contains the host name
or IP address of the publisher server (the first Unity Connection server that you installed) and the server port
in the format <host name or IP address>:5060.

1. For Unity Connectionwithout a cluster, continue to Step 36. For Unity Connectionwith a cluster configured,
under Host List, enter the host name or IP address of the subscriber server (the second Unity Connection
server that you installed) and the server port in the format <host name or IP address>:5060.

2. Select Add Host.

3. In the second field, enter the host name or IP address of the publisher server (the first Unity Connection
server that you installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the
Unity Connection cluster may not function correctly.

4. Select Submit.

5. Under Router Configuration, select TDM Trunk Groups.

6. Under TDM Trunk Groups, select Add Trunk Group.
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7. Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.

Table 338: First TDM Trunk Group Settings (Inbound Calls)

SettingsField

Enter Inbound_PBX_Calls or another unique name.

This TDM trunk group handles all incoming calls
from the phone system.

Name

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports that handle
inbound calls. For example, enter “*” for all PIMG
ports, or enter “1-6” for the first six PIMG ports.

Port/Channel Content

1. Under TDM Trunk Groups, select Add Trunk Group.

2. Enter the following settings for the second TDM trunk group.

Table 339: Second TDM Trunk Group Settings (MWIs)

SettingsField

EnterMWIs or another unique name.

This TDM trunk group handles outbound MWI calls
(where applicable).

Name

Select Ascending.Selection Direction

Select Cyclic.Selection Mode

Enter the numbers of the PIMG ports that dial out
MWIs. For example, enter “*” for all PIMG ports, or
enter “7,8” for the last two PIMG ports.

Port/Channel Content

1. Under TDM Trunk Groups, select Add Trunk Group.

2. Enter the following settings for the third TDM trunk group.

Table 340: Third TDM Trunk Group Settings (Outbound Calls)

SettingsField

EnterOutbound_PBX_Calls or another unique name.

This TDM trunk group handles all outbound calls
from Unity Connection.

Name

Select Descending.Selection Direction
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SettingsField

Select Linear.Selection Mode

Enter * for all channels in all ports.

Enter the numbers of the PIMG ports that handle
outbound (dialout) calls. For example, enter “*” for
all PIMG ports, or enter “7,8” for the last two PIMG
ports.

Port/Channel Content

1. Select Submit.

2. Under Router Configuration, select Inbound VoIP Rules.

3. Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.

4. Select Add Rule.

5. Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 341: First New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable

EnterMWI_Calls or another name.

This inbound VoIP rule handles all MWI calls from
Unity Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address

1. Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another
rule.

Table 342: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name
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1. Under Outbound Routes, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another
rule.

Table 343: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you
created for MWIs in Step 41. For example, select
“MWIs.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

1. Under Inbound VoIP Rules, select Add Rule.

2. Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.

Table 344: Second New Inbound VoIP Rule Settings (Outbound Calls)

SettingsField

Check this check box.Enable

Enter Outbound_UC_Calls or another name.

This inbound VoIP rule handles all outbound calls
from Unity Connection.

Rule Label

Select Call.Request Type

Enter *.Originating VoIP Host Address

1. Under Inbound VoIP Request Matching, enter the following settings.
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The rule that you created in Step 52 must be selected. Otherwise, any changes you make apply to another
rule.

Table 345: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

1. Under Outbound Routes, enter the following settings.

The rule that you created in Step 52 must be selected. Otherwise, any changes you make apply to another
rule.

Table 346: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you
created for outbound calls in Step 43. For example,
select “Outbound_PBX_Calls.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

1. Select Submit.
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2. Under Router Configuration, select Inbound TDM Rules.

3. Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.

Table 347: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule handles all incoming calls
from the phone system.

Rule Label

Select Call.Request Type

Select the name of the TDM trunk group that you
created for incoming calls from the phone system in
Step 39. For example, select “Inbound_PBX_Calls.”

Trunk Group

1. Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 57 must be selected. Otherwise, any changes you make apply to another
rule.

Table 348: Inbound TDM Request Matching Settings

SettingsField

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Name

1. Under Outbound Routes, enter the following settings.

The rule that you created in Step 57 must be selected. Otherwise, any changes you make apply to another
rule.
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Table 349: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination

Select the name of the VoIP host group that you
created for Unity Connection in Step 31.

Host Group

CPID Manipulation

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

1. If you want to create more Inbound TDM rules, under Inbound TDM Rules, selectAdd Rule. Otherwise,
continue to Step 62.

2. Repeat Step 57 through Step 60 for all remaining inbound TDM rules that you want to create.

3. Select Submit.

4. On the Configuration menu, select TDM > General.

5. On the TDM General Settings page, enter the following settings.

Table 350: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)
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SettingsField

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Enter the code that turns MWIs on.Turn MWI On FAC

Enter the code that turns MWIs off.Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Select No.Disconnect on Fax Cleardown Tone

1. Select Submit.

2. On the Configuration menu, select TDM > Port Enable.

3. On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.

4. Confirm that Yes is selected for all other ports on the PIMG unit.

5. Select Submit.

6. On the Configuration menu, select VoIP > General.

7. On the VoIP General Settings page, enter the following settings.

Table 351: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that
the PIMG unit uses.

DNS Server Address

DNS Translation of Phone Numbers
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SettingField

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Enter 30.TCP Inactivity Timer (sec)

TLS

TLS Transport Enabled

TLS Server Port

SSL TLS Protocol

Mutual TLS Authentication Required

TLS Inactivity Timer (sec)

Verify TLS Peer Certificate Date

Verify TLS Peer Certificate Trust

Proxy

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Enter 5000.T4 Time (ms)

Monitoring

Select No.Monitor Call Connections

Call Monitor Interval (sec)
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SettingField

Monitor VoIP Hosts

VoIP Host Monitor Interval (sec)

1. Select Submit.

2. On the Configuration menu, select VoIP > Media.

3. On the VoIP Media Settings page, enter the following settings.

Table 352: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select RFC2833.RTP Fax/Modem Tone Relay Mode

Select Off.RTP Source IP Address Validation

Select Off.RTP Source UDP Port Validation

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select On Demand.RFC 3960 Early Media Support

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Frames Per Packet

Fax
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SettingsField

Fax IP-Transport Mode

1. Select Submit.

2. On the Configuration menu, select VoIP > QOS.

3. On the VoIP QOS Configuration page, enter the following settings.

Table 353: VoIP QOS Configuration Page Settings

SettingsField

Enter 104.Call Control QOS Byte

Enter 184.RTP QOS Byte

1. Select Submit.

2. On the Configuration menu, select IP.

3. On the IP Settings page, enter the following settings.

Table 354: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the
PIMG unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is
different from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway
router that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

1. Select Submit.

2. On the Configuration menu, select Tone Detection.

3. On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select
Busy and do the following substeps to verify that the tone is correct.

1. From an available phone, call a second phone.

2. Answer the second phone when it rings, and leave both handsets off so that both phones are busy.

3. From a third phone, dial one of the busy phones.
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4. Confirm that you hear a busy tone.

5. Hang up the third phone but leave the handsets for the other two phones off.

4. Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 83c.
from the third phone.

5. Select Learn.

6. On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do
the following substeps to verify that the tone is correct.

1. From an available phone, dial an extension that does not exist.

2. Confirm that you hear the reorder or error tone.

3. Hang up the phone.

7. Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 86a.

8. Select Learn.

9. On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Ringback and
and do the following substeps to verify that the tone is correct.

1. From an available phone, dial an extension that does exist

2. Confirm that you hear the ringback tone.

3. Hang up the phone.

10. Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 89a.

11. Select Learn.

12. Select Submit.

13. Hang up the phones that you used in Step 89.

14. On the System menu, select Restart.

15. On the Restart page, select Restart Unit Now.

16. Repeat Step 2 through Step 95 on all remaining PIMG units.

Configuring Unity Connection for Integration with Siemens Hicom 150 Phone
System

After ensuring that the Siemens Hicom 150 phone system, the PIMG units, and Unity Connection are ready
for the integration, do the following procedure to set up the integration and to enter the port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
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Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
Step 6 Select Save.
Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 355: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 356: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled
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ConsiderationsField

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.

Table 357: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification
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ConsiderationsField

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note

Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 358: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From
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SettingField

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is

checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

Table 359: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
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Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone
system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.
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C H A P T E R 14
Setting Up a Siemens Hicom 300 E (European)
Analog PIMG Integration with Cisco Unity
Connection

• Setting Up a Siemens Hicom 300 E (European) Analog PIMG Integration, on page 299

Setting Up a Siemens Hicom 300 E (European) Analog PIMG
Integration

Task List for Siemens Hicom 300 E (European) PIMG Phone System Integration
Before doing the following tasks to integrate Unity Connection with the Siemens Hicom 300 E phone system
using PIMG units (media gateways), confirm that the Unity Connection server is ready for the integration
after completing the server installation, following the tasks in the “Installing Cisco Unity Connection” chapter
of the Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Unity Connection
server requirements have been met. See the Requirements, on page 12 section.

2. Plan how the voice messaging ports are used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports, on page 7 chapter.

3. Program the Siemens Hicom 300 E (European) phone system and extensions. See the Programming
Siemens Hicom 300 E (European) PIMG Phone System section.

4. Set up the PIMG units. See the Setting Up the Analog PIMG Units for a DTMF Integration section.

5. Create the integration. See the Configuring Unity Connection for Integration with Siemens Hicom 300 E
(European) Phone System, on page 319 section.

6. Test the integration. See the Testing the Integration, on page 401 chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Adding New User Templates for Multiple Integrations, on page 407 chapter.
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Requirements
This integration supports configurations of the following components:

Phone System
• Siemens Hicom 300 E (European) phone system.

• Software version 3.0, release 0.17 or later.

• One or more of the applicable PIMG units. For details, see the “Introduction” chapter.

• The voice messaging ports in the phone system connected by analog lines to the ports on the PIMG units.

To simplify troubleshooting, we recommend that you connect the voice messaging ports on the phone system
to the ports on the PIMG units in a planned manner. For example, connect the first phone system voice
messaging port to the first port on the first PIMG unit, connect the second phone system voice messaging port
to the second port on the first PIMG unit, and so on. Alternatively, if you have multiple PIMG units, you can
reduce answer times in the event of a PIMG unit failure by connecting the phone system ports to the PIMG
units in a round-robin fashion. For example, connect the first phone system voice messaging port to the first
port on the first PIMG unit, connect the second phone system voice messaging port to the first port on the
second PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.

Programming Siemens Hicom 300 E (European) PIMG Phone System
The following programming instructions are provided as an example only. The specific programming for your
phone system may vary depending on its configuration.
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In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Send MWI Requests, do not send calls to it.

Caution

Step 1 Use the CHA-TAPRO command to create a button table to use on the voice messaging port extensions. The button table
must have the following parameters while the remaining parameters keep their default values.

Table 360: Button Table Parameter Settings

GermanEnglish

SettingParameterSettingParameter

Leave this field blank.STNOLeave this field blank.STNO

Enter 4.SNUEnter 4.STD

Enter OPTIT12.DIGTYPEnter OPTIT12.DIGTYP

Enter BK.KY03EnterMB.KY03

Enter TR.KY04Enter RLS.KY04

Enter NA.KY07Enter NAME.KY07

Enter KF.KY10Enter CONF.KY10

Enter RF.KY11Enter CONS.KY11

Enter UEG.KY12Enter TRANSFER.KY12

Step 2 If the Call Route mode on the PIMG unit cannot be set to Pooled, continue to Step 3. Otherwise, use the ADD-SA
command to create a hunt group for the voice messaging ports that are connected to the PIMG units. The hunt group must
have the following parameters set while the remaining parameters keep their default values.

Table 361: ADD-SA Parameter Settings for Voice Messaging Ports on the Analog PIMG Units

GermanEnglish

SettingParameterSettingParameter

Enter SPR.DIENSTEnter VCE.SERVICE

Enter the pilot number for the
hunt group.

RNREnter the pilot number for
the hunt group.

CD

Enter 0.WABEEnter 0.DPLN

Enter name for the hunt
group. For example, enter
“UNITYTELEPHONSVA.”

NAMEEnter name for the hunt
group. For example, enter
“UNITYTELEPHONSVA.”

NAME
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GermanEnglish

Leave this field blank.VERKEHRSSITUATIONLeave this field blank.CALL PROG. STATE

Enter the extensions for the
ports that answer calls. Do
not include the MWI-only
ports.

TLNNUEnter the extensions for the
ports that answer calls. Do
not include the MWI-only
ports.

STNO

Enter LIN.ARTEnter LIN.TYP

Enter 6.ANOKAPEnter 6.CQMAX

Enter -.UEBERLAUFEnter -.OVERFLOW

Step 3 Use the CHA-COSSU command to enable the mailbox feature in the class of service (COS) for the voice messaging
ports. The mailbox feature must have the following parameters while the remaining parameters keep their default values.

Table 362: HA-COSSU Parameter Settings for the Mailbox Feature

GermanEnglish

SettingParameterSettingParameter

Enter COS.ARTEnter COS.TYPE

Enter the number of the class
of service for which the
mailbox feature is enabled.
For example, enter “47”.

COSEnter the number of the class
of service for which the
mailbox feature is enabled.
For example, enter “47”.

COS

Enter FBKWQVKWBRK
BUC SSM RWS AULEXT
ANSYN AULERU.

SPRACHEEnter TA TNOTCRMB
COSXCD VCE NOANSA
FWDNWK ANSYN
FWDECA.

VOICE

Enter NIB NQVB.Enter NOCO NOTIE.FAX

Enter NIB NQVB.Enter NOCO NOTIE.TTX

Enter NIB NQVB.BTXEnter NOCO NOTIE.VTX

Enter FBKW QVKW
GRUBE.

DEEEnter TA TNOTCR
BASIC.

DTE

Step 4 Program each phone to forward calls to the pilot number assigned to the voice messaging ports, based on one of the
Cisco Unity Connection call transfer types shown in Table 363: Call Transfer Types.
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Table 363: Call Transfer Types

UsageTransfer Type

Program the phone to forward calls to the pilot number
when:

• The extension is busy.

• The call is not answered.

Release transfer (blind transfer)

Program the user station to forward calls to the pilot number
only when the call is not answered (on the phone system,
the number of rings before forwarding must be more than
the number of rings to supervise the call). Confirm that call
forwarding is disabled when the extension is busy.

Supervised transfer

Setting Up the Analog PIMG Units for a DTMF Integration
Do the following procedures to set up the analog PIMG units that are connected to the Siemens Hicom 300
E (European) phone system for a DTMF integration.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the PIMG units using analog lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the PIMG units.

Downloading PIMG Firmware Update Files for Analog PIMG Units

Step 1 On a Windows workstation that have access to the PIMG units, go to the following link:
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.

To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

Note

Step 2 In the tree control on the Downloads Home page, expand Unified Communications> Unified Communications
Applications > Messaging > Cisco Unity and select Cisco Unity Telephony Integration.

Step 3 On the Log In page, enter your username and password, then select Log In.
Step 4 On the Select a Release page, under Latest Releases, select the most recent release.
Step 5 In the right column, select the version of the firmware for analog PIMG units.

Step 6 On the Download Image page, select Download.
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Step 7 On the Supporting Document(s) page, select Agree.
Step 8 In the File Download dialog box, select Save.
Step 9 In the Save As dialog box, browse to the Windows workstation that have access the PIMG units, browse to a directory

where you want to save the file, and select Save.
Step 10 In the Download Complete dialog box, selectOpen. The window for extracting the PIMG firmware update files appears.
Step 11 Select Extract.
Step 12 In the Extract dialog box, browse to the directory where you want the extracted files, and select Extract.
Step 13 Close the window for the extracting application.

Setting Up Analog PIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the PIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 2 Connect a PIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.

Table 364: Sign-in Settings

SettingsField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
Step 7 On the Upgrade page, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted PIMG firmware

update files.
Step 9 Select Ls_<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.

Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file installation fails.
Restarting the PIMG unit at this step may prevent the PIMG unit from functioning correctly.
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Step 12 Repeat Step 6 through Step 11 for the following files:

• Run_<xx>FskEcho.dsp

• Ls_<xx>.fsh

1. On the Configuration menu, select Import/Export.

2. On the Import/Export page, select Browse.

3. In the Choose File dialog box, browse to the file Ls_Cfg_Hicom300ECS.ini.

4. Select Ls_Cfg_Hicom300ECS.ini, and select Open.

5. On the Import/Export page, select Import File.

6. After the file is imported, a message prompting you to restart the PIMG unit appears. Select OK.

7. In the web browser, go to http://10.12.13.74.

8. To sign in, enter the following case-sensitive settings.

Table 365: Sign-in Settings

SettingsField

Enter admin.Username

Enter IpodAdmin.Password

1. Select OK.

2. Do the following substeps to configure an RTP port range of 16384 to 32767.

You must set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to
32767. Otherwise, Unity Connection cannot answer calls and callers hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. Some Unity Connection configurations require
a different RTP port range.

Note

1. On the Configuration menu, select Import/Export.

2. On the Import/Export page, under Export Files, select Export All Settings.

3. In the File Download dialog box, select Save.

4. In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units,
browse to a directory where you want to save the file, and select Save.

5. In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you
saved.

6.
7.
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8. Locate the line with the following parameter:

gwRTPStartPort

9. Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384

10. Locate the line with the following parameter:

gwRTPEndPort

11. Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

12. Save the file, and exit Notepad.

13. On the Configuration menu of the PIMG unit, select Import/Export.

14. On the Import/Export page, under Browse for Import File, select Browse.

15. In the Choose File dialog box, browse to the file Config.ini that you saved.

16. Select Config.ini, and select Open.

17. On the Import/Export page, select Import File.

18. When prompted to restart the PIMG unit, select OK.

19. When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.

20. To sign in, enter the following case-sensitive settings.

Table 366: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

1. Select OK.

1. On the System menu, select Password.

2. On the Change Password page, enter the following settings.

Table 367: Change Password Page Settings

SettingsField

Enter IpodAdmin. (This setting is case sensitive.)Old Password

PIMG Integration Guide for Cisco Unity Connection Release 12.X
306

Setting Up a Siemens Hicom 300 E (European) Analog PIMG Integration with Cisco Unity Connection
Setting Up Analog PIMG Units (Firmware Version 6.x)



SettingsField

Enter your new password. (This setting is case
sensitive.)

New Password

Enter your new password. (This setting is case
sensitive.)

Confirm Password

1. Select Change.

2. On the Configuration menu, selectMgmt Protocols.

3. On the Management Protocols page, enter the following settings.

Table 368: Management Protocols Page Settings

SettingsField

Select No.E-mail Alarms Enabled

Select No.SNMP Traps Enabled

1. Select Submit.

2. On the Configuration menu, select Routing Table.

3. On the Routing Table page, under Router Configuration, select VoIP Host Groups.

4. Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 369: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name
of the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select
False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select
True.

Fault-Tolerant

1. For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity
Connection server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, enter the host name or IP address of the
subscriber server (the second Unity Connection server that you installed) and the server port in the format
<host name or IP address>:5060.
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1. For Unity Connectionwithout a cluster, continue to Step 35. For Unity Connectionwith a cluster configured,
select Add Host.

2. In the second field, enter the host name or IP address of the publisher server (the first Unity Connection
server that you installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the
Unity Connection cluster may not function correctly.

3. Select Submit.

4. Under Router Configuration, select TDM Trunk Groups.

5. Under TDM Trunk Groups, select Add Trunk Group.

6. Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.

Table 370: First TDM Trunk Group Settings (Inbound Calls)

SettingsField

Enter Inbound_PBX_Calls or another unique name.

This TDM trunk group handles all incoming calls
from the phone system.

Name

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports that handle
inbound calls. For example, enter “*” for all PIMG
ports, or enter “1-6” for the first six PIMG ports.

Port/Channel Content

1. Under TDM Trunk Groups, select Add Trunk Group.

2. Enter the following settings for the second TDM trunk group.

Table 371: Second TDM Trunk Group Settings (MWIs)

SettingsField

EnterMWIs or another unique name.

This TDM trunk group handles outbound MWI calls
(where applicable).

Name

Select Ascending.Selection Direction

Select Cyclic.Selection Mode

Enter the numbers of the PIMG ports that dial out
MWIs. For example, enter “*” for all PIMG ports, or
enter “7,8” for the last two PIMG ports.

Port/Channel Content

1. Under TDM Trunk Groups, select Add Trunk Group.
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2. Enter the following settings for the third TDM trunk group.

Table 372: Third TDM Trunk Group Settings (Outbound Calls)

SettingsField

EnterOutbound_PBX_Calls or another unique name.

This TDM trunk group handles all outbound calls
from Unity Connection.

Name

Select Descending.Selection Direction

Select Linear.Selection Mode

Enter * for all channels in all ports.

Enter the numbers of the PIMG ports that handles
outbound (dialout) calls. For example, enter “*” for
all PIMG ports, or enter “7,8” for the last two PIMG
ports.

Port/Channel Content

1. Select Submit.

2. Under Router Configuration, select Inbound VoIP Rules.

3. Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.

4. Select Add Rule.

5. Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 373: First New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable

EnterMWI_Calls or another name.

This inbound VoIP rule handles all MWI calls from
Unity Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address

1. Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 47 must be selected. Otherwise, any changes you make apply to another
rule.
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Table 374: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

1. Under Outbound Routes, enter the following settings.

The rule that you created in Step 47 must be selected. Otherwise, any changes you make apply to another
rule.

Table 375: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you
created for MWIs in Step 40. For example, select
“MWIs.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

1. Under Inbound VoIP Rules, select Add Rule.

2. Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.
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Table 376: Second New Inbound VoIP Rule Settings (Outbound Calls)

SettingsField

Check this check box.Enable

Enter Outbound_UC_Calls or another name.

This inbound VoIP rule handles all outbound calls
from Unity Connection.

Rule Label

Select Call.Request Type

Enter *.Originating VoIP Host Address

1. Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 51 must be selected. Otherwise, any changes you make apply to another
rule.

Table 377: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

1. Under Outbound Routes, enter the following settings.

The rule that you created in Step 51 must be selected. Otherwise, any changes you make apply to another
rule.

Table 378: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you
created for outbound calls in Step 42. For example,
select “Outbound_PBX_Calls.”

Trunk Group

CPID Manipulation
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SettingsField

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

1. Select Submit.

2. Under Router Configuration, select Inbound TDM Rules.

3. Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.

Table 379: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule handles all incoming calls
from the phone system.

Rule Label

Select Call.Request Type

Select the name of the TDM trunk group that you
created for incoming calls from the phone system in
Step 38. For example, select “Inbound_PBX_Calls.”

Trunk Group

1. Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 56 must be selected. Otherwise, any changes you make apply to another
rule.

Table 380: Inbound TDM Request Matching Settings

SettingsField

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Name
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SettingsField

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Name

1. Under Outbound Routes, enter the following settings.

The rule that you created in Step 56 must be selected. Otherwise, any changes you make apply to another
rule.

Table 381: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination

Select the name of the VoIP host group that you
created for Unity Connection in Step 31.

Host Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

1. If you want to create more Inbound TDM rules, under Inbound TDM Rules, selectAdd Rule. Otherwise,
continue to Step 61.

2. Repeat Step 56 through Step 59 for all remaining inbound TDM rules that you want to create.

3. Select Submit.

4. On the Configuration menu, select TDM > General.
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5. On the TDM General Settings page, enter the following settings.

Table 382: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Enter the code that turns MWIs on.Turn MWI On FAC

Enter the code that turns MWIs off.Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Select No.Disconnect on Fax Cleardown Tone

1. Select Submit.

2. On the Configuration menu, select TDM > Port Enable.

3. On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.

4. Confirm that Yes is selected for all other ports on the PIMG unit.

5. Select Submit.

6. On the Configuration menu, select VoIP > General.

7. On the VoIP General Settings page, enter the following settings.

Table 383: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name
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SettingField

SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that
the PIMG unit uses.

DNS Server Address

DNS Translation of Phone Numbers

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Enter 30.TCP Inactivity Timer (sec)

TLS

TLS Transport Enabled

TLS Server Port

SSL TLS Protocol

Mutual TLS Authentication Required

TLS Inactivity Timer (sec)

Verify TLS Peer Certificate Date

Verify TLS Peer Certificate Trust

Proxy

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing
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SettingField

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Enter 5000.T4 Time (ms)

Monitoring

Select No.Monitor Call Connections

Call Monitor Interval (sec)

Monitor VoIP Hosts

VoIP Host Monitor Interval (sec)

1. Select Submit.

2. On the Configuration menu, select VoIP > Media.

3. On the VoIP Media Settings page, enter the following settings.

Table 384: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select RFC2833.RTP Fax/Modem Tone Relay Mode

Select Off.RTP Source IP Address Validation

Select Off.RTP Source UDP Port Validation

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select On Demand.RFC 3960 Early Media Support

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Frame Size
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SettingsField

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Frames Per Packet

Fax

Fax IP-Transport Mode

1. Select Submit.

2. On the Configuration menu, select VoIP > QOS.

3. On the VoIP QOS Configuration page, enter the following settings.

Table 385: VoIP QOS Configuration Page Settings

SettingsField

Enter 104.Call Control QOS Byte

Enter 184.RTP QOS Byte

1. Select Submit.

2. On the Configuration menu, select IP.

3. On the IP Settings page, enter the following settings.

Table 386: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the
PIMG unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is
different from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway
router that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled
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1. Select Submit.

2. On the Configuration menu, select Tone Detection.

3. On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select
Busy and do the following substeps to verify that the tone is correct.

1. From an available phone, call a second phone.

2. Answer the second phone when it rings, and leave both handsets off so that both phones are busy.

3. From a third phone, dial one of the busy phones.

4. Confirm that you hear a busy tone.

5. Hang up the third phone but leave the handsets for the other two phones off.

4. Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 82c.
from the third phone.

5. Select Learn.

6. On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do
the following substeps to verify that the tone is correct.

1. From an available phone, dial an extension that does not exist.

2. Confirm that you hear the reorder or error tone.

3. Hang up the phone.

7. Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 85a.

8. Select Learn.

9. On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Ringback and
and do the following substeps to verify that the tone is correct.

1. From an available phone, dial an extension that does exist

2. Confirm that you hear the ringback tone.

3. Hang up the phone.

10. Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 88a.

11. Select Learn.

12. Select Submit.

13. Hang up the phones that you used in Step 88.

14. On the System menu, select Restart.

15. On the Restart page, select Restart Unit Now.

16. Repeat Step 2 through Step 94 on all remaining PIMG units.
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Configuring Unity Connection for Integration with Siemens Hicom 300 E
(European) Phone System

After ensuring that the Siemens Hicom 300 E (European) phone system, the PIMG units, and Unity Connection
are ready for the integration, do the following procedure to set up the integration and to enter the port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
Step 6 Select Save.
Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 387: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name
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SettingField

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 388: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.
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Table 389: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note
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Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 390: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is

checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.
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Table 391: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone

system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.

PIMG Integration Guide for Cisco Unity Connection Release 12.X
323

Setting Up a Siemens Hicom 300 E (European) Analog PIMG Integration with Cisco Unity Connection
Creating an Integration



PIMG Integration Guide for Cisco Unity Connection Release 12.X
324

Setting Up a Siemens Hicom 300 E (European) Analog PIMG Integration with Cisco Unity Connection
Creating an Integration



C H A P T E R 15
Setting Up a Siemens Hicom 300 E (North
American) Digital PIMG Integration

For detailed instructions for setting up a Siemens Hicom 300-series E (North American) digital PIMG
integration with Cisco Unity Connection, see the sections in this chapter:

• Setting Up a Siemens Hicom 300 E (North American) Digital PIMG Integration, on page 325

Setting Up a Siemens Hicom 300 E (North American) Digital
PIMG Integration

For detailed instructions for setting up a Siemens Hicom 300-series E (North American) digital PIMG
integration with Cisco Unity Connection, see the sections in this chapter:

Task List for Siemens Hicom 300 PIMG Phone System Integration
Before doing the following tasks to integrate Unity Connection with the Hicom 300 phone system using PIMG
units (media gateways), confirm that the Unity Connection server is ready for the integration after completing
the server installation, following the tasks in the “Installing Cisco Unity Connection” chapter of the Install,
Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Unity Connection
server requirements have been met. See the Requirements, on page 12 section.

2. Plan how the voice messaging ports are used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports, on page 7 chapter.

3. If you have a legacy voice messaging system, clear the MWIs for users who are migrating to Unity
Connection. See the Clearing MWIs from a Legacy Voice Messaging System section.

4. Program the Siemens Hicom 300 phone system and extensions. See the Programming the Siemens Hicom
300 E (North American) Phone System Integration Using the Command Line Interface section.

5. Set up the PIMG units. See the Setting Up the Digital PIMG Units section.

6. Create the integration. See the Configuring Unity Connection for Integration with Siemens Hicom 300 E
(North American) Phone System, on page 345 section.
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7. Test the integration. See the Testing the Integration, on page 401 chapter.

8. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Adding New User Templates for Multiple Integrations, on page 407 chapter.

Requirements
This integration supports configurations of the following components:

Phone System
• Siemens Hicom 300-series E CS (North American) phone system.

• Software version 9006.4 or later.

• SLMO line cards installed for connecting to the PIMG units.

• One or more of the applicable PIMG units. For details, see the “Introduction” chapter.

• The voice messaging ports in the phone system connected by digital lines to the ports on the PIMG units.

To simplify troubleshooting, we recommend that you connect the voice messaging ports on the phone system
to the ports on the PIMG units in a planned manner. For example, connect the first phone system voice
messaging port to the first port on the first PIMG unit, connect the second phone system voice messaging port
to the second port on the first PIMG unit, and so on. Alternatively, if you have multiple PIMG units, you can
reduce answer times in the event of a PIMG unit failure by connecting the phone system ports to the PIMG
units in a round-robin fashion. For example, connect the first phone system voice messaging port to the first
port on the first PIMG unit, connect the second phone system voice messaging port to the first port on the
second PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

• The phone system ready for the integration, as described in the documentation for the phone system.

Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.
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Clearing MWIs from a Legacy Voice Messaging System
If users do not have existing voicemail on a legacy voice messaging system, skip this section and continue
with the next section.

If users have existing voicemail on a legacy voice messaging system, do the following procedure.

1. Have all users who are migrating to Unity Connection delete or listen to their voice messages on the legacy
voice messaging system.

2. Confirm that all MWIs for the subscribers migrating to Unity Connection are turned off.

Programming the Siemens Hicom 300 E (North American) Phone System
Integration Using the Command Line Interface

The following programming instructions are provided as an example only. The specific programming for your
phone system may vary depending on its configuration.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Send MWI Requests, do not send calls to it.

Caution

Step 1 Use the ADD-COS command to add INTDTMF to the class of service that you use. The class of service must have the
following parameters while the remaining parameters keep their default values.

Table 392: ADD-COS Parameter Settings

SettingParameter

Enter the class of service that you are using.NEWCOS

Enter indtmf;.AVCE

Step 2 Use the ADD-DPLN command to create an extension for each voice messaging port on the PIMG units. Each extension
must have the following parameters set while the remaining parameters keep their default values.

Table 393: ADD-DPLN Parameter Settings for Voice Messaging Ports on the PIMG Units

SettingParameter

Enter <first extension>&&<last extension>.DGTS

Enter 0.DPLN

Leave this field blank.CPS

Enter STN.DAR

Enter N.CHECK
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Step 3 Use the ADD-SCSU command to create the first voice messaging port on the first PIMG unit. The voice messaging
port must have the following parameters while the remaining parameters keep their default values.

Table 394: ADD-SCSU Parameter Settings for Voice Messaging Ports on the PIMG Units

SettingParameter

Enter the extension number.STNO

Enter the port equipment number.PEN

Enter 0.DPLN

Enter 0.ITR

Enter the class of service that you are using.COS1

Enter the class of service that you are using.COS2

Enter 0.COSX

Enter the PSTN prefix plus the extension number.PUBSCR

Enter NAT.NTYPE

Enter 000000000000.ACTCDE

Leave this field blank.HTLNIDX

Enter OPTI.DEVFUNC

Enter Y.INS

Enter OEADPLC.OPTITYPE

Enter Y.CUI

Step 4 Repeat Step 3 for each remaining voice messaging port on all PIMG units.
Step 5 Use the CHA-KEPRO command to program the first voice messaging port on the first PIMG unit. The voice messaging

port must have the following parameters while the remaining parameters keep their default values.

Table 395: CHA-KEPRO Parameter Settings for Voice Messaging Ports on the PIMG Units

SettingParameter

Enter the extension number of the voice messaging port.STNO

Enter 1.STD

Enter OPTIE12.DIGTYPE

Step 6 Confirm that the key assignments for the voice messaging port match the key assignments shown in Table 396: Required
Key Assignments for Voice Messaging Ports on the PIMG Units.
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Table 396: Required Key Assignments for Voice Messaging Ports on the PIMG Units

AssignmentKey

LINE1

VACANT2

VACANT3

VACANT4

CONF5

XFER6

CNCT7

HOLDM8

MB9

SYSSP110

SYSSP211

VACANT12

The key assignments must match the key assignments shown above. Otherwise, the integration cannot function correctly.

Step 7 Repeat Step 5 and Step 6 for each remaining voice messaging port on all PIMG units.
Step 8 Use the ADD-KCSU command to set the primary line options for the first voice messaging port on the first PIMG unit.

The voice messaging port must have the following parameters while the remaining parameters keep their default values.

Table 397: ADD-KCSU Parameter Settings for Voice Messaging Ports on the PIMG Units

SettingParameter

Enter the extension number of the voice messaging port.STNO

Enter KEY.TYPE

Enter 1.PRIMKEY

Enter Y.RIOP

Enter PRIM.ORLNPF

Enter RING.TMLNPF

Enter Y.SGLBMOD

Enter STAND.ROLRING

Enter N.APRIVAT
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SettingParameter

Enter Y.AICS

Step 9 Repeat Step 8 for each remaining voice messaging port on all PIMG units.
Step 10 In the station configuration section, in the Common User Interface field, enter Yes.
Step 11 Program each phone to forward calls to the pilot number assigned to the voice messaging ports, based on one of the

Unity Connection call transfer types shown in Table 398: Call Transfer Types.

Table 398: Call Transfer Types

UsageTransfer Type

Program the phone to forward calls to the pilot number
when:

• The extension is busy.

• The call is not answered.

Release transfer (blind transfer)

Program the user station to forward calls to the pilot
number only when the call is not answered (on the phone
system, the number of rings before forwarding must be
more than the number of rings to supervise the call).
Confirm that call forwarding is disabledwhen the extension
is busy.

Supervised transfer

Setting Up the Digital PIMG Units
Do the following procedures to set up the digital PIMG units that are connected to the Siemens Hicom 300
phone system.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the PIMG units using digital lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the PIMG units.

Downloading the PIMG Firmware Update Files for Digital PIMG Units

Step 1 On a Windows workstation with a high-speed Internet connection that have access to the PIMG units, go to the Voice
and Unified Communications Downloads page at
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.
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To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

Note

Step 2 In the tree control on the Downloads Home page, expand Unified Communications> Unified Communications
Applications > Messaging > Cisco Unity and select Cisco Unity Telephony Integration.

Step 3 On the Log In page, enter your username and password, then select Log In.
Step 4 On the Select a Release page, under Latest Releases, select the most recent release.
Step 5 In the right column, select the version of the firmware for digital PIMG units.

Step 6 On the Download Image page, select Download.
Step 7 On the Supporting Document(s) page, select Agree.
Step 8 In the File Download dialog box, select Save.
Step 9 In the Save As dialog box, browse to the Windows workstation that have access the PIMG units, browse to a directory

where you want to save the file, and select Save.
Step 10 In the Download Complete dialog box, selectOpen. The window for extracting the PIMG firmware update files appears.
Step 11 Select Extract.
Step 12 In the Extract dialog box, browse to the directory where you want the extracted files, and select Extract.
Step 13 Close the window for the extracting application.

Setting Up the Digital PIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the PIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 2 Connect a PIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.

Table 399: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
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Step 7 On the Upgrade page, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted PIMG firmware

update files.
Step 9 Select Ami<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.

Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file installation fails.
Restarting the PIMG unit at this step may prevent the PIMG unit from functioning correctly.

Step 12 Repeat Step 6 through Step 11 for each of the following files:

• Ami_<xx>.fsh

• Run<xx>FskEcho.dsp

• iNim<xx>.ibt

• iNim<xx>.ilc

• iNim<xx>.iap

Step 13 On the Configuration menu, select Import/Export.
Step 14 On the Import/Export page, select Browse.
Step 15 In the Choose File dialog box, browse to the file DNI_Cfg_Generic.ini.
Step 16 Select DNI_Cfg_Generic.ini, and select Open.
Step 17 On the Import/Export page, select Import File.
Step 18 After the file is imported, a message prompting you to restart the PIMG unit appears. Select OK.
Step 19 In the web browser, go to http://10.12.13.74.
Step 20 To sign in, enter the following case-sensitive settings.

Table 400: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 21 Select OK.
Step 22 Do the following substeps to configure an RTP port range of 16384 to 32767.

Youmust set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to 32767. Otherwise,
Unity Connection cannot answer calls and callers hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. SomeUnity Connection configurations require
a different RTP port range.

Note

a) On the Configuration menu, select Import/Export.
b) On the Import/Export page, under Export Settings, select Export All Settings.
c) In the File Download dialog box, select Save.
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d) In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units, browse to a
directory where you want to save the file, and select Save.

e) In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you saved.
f)
g)
h) Locate the line with the following parameter:

gwRTPStartPort

i) Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384

j) Locate the line with the following parameter:

gwRTPEndPort

k) Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

l) Save the file, and exit Notepad.
m) On the Configuration menu of the PIMG unit, select Import/Export.
n) On the Import/Export page, under Browse for Import File, select Browse.
o) In the Choose File dialog box, browse to the file Config.ini that you saved.
p) Select Config.ini, and select Open.
q) On the Import/Export page, select Import File.
r) When prompted to restart the PIMG unit, select OK.
s) When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.
t) To sign in, enter the following case-sensitive settings.

Table 401: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

u) Select OK.

Step 23 On the System menu, select Password.
Step 24 On the Change Password page, enter the following settings.

Table 402: Change Password Page Settings

SettingField

Enter IpodAdmin. (This setting is case sensitive.)Old Password

Enter your new password. (This setting is case sensitive.)New Password
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SettingField

Enter your new password. (This setting is case sensitive.)Confirm Password

Step 25 Select Change.
Step 26 On the Configuration menu, select Routing Table.
Step 27 On the Routing Table page, under Router Configuration, select VoIP Host Groups.
Step 28 Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 403: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name of
the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select True.

Fault-Tolerant

Step 29 For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity Connection
server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, enter the host name or IP address of the subscriber
server (the second Unity Connection server that you installed) and the server port in the format <host name or IP
address>:5060.

Step 30 For Unity Connection without a cluster, continue to Step 32. For Unity Connection with a cluster configured, select
Add Host.

Step 31 In the second field, enter the host name or IP address of the publisher server (the first Unity Connection server that you
installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the Unity Connection
cluster may not function correctly.

Step 32 Select Submit.
Step 33 Under Router Configuration, select TDM Trunk Groups.
Step 34 Under TDM Trunk Groups, select Add Trunk Group.
Step 35 Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.

Table 404: First TDM Trunk Group Settings (Inbound Calls)

SettingsField

Enter Inbound_PBX_Calls or another unique name.

This TDM trunk group handles all incoming calls from
the phone system.

Name
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SettingsField

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports that handle inbound
calls. For example, enter “*” for all PIMG ports, or enter
“1-6” for the first six PIMG ports.

Port/Channel Content

Step 36 Under TDM Trunk Groups, select Add Trunk Group.
Step 37 Enter the following settings for the second TDM trunk group.

Table 405: Second TDM Trunk Group Settings (MWIs)

SettingsField

EnterMWIs or another unique name.

This TDM trunk group handles outbound MWI calls
(where applicable).

Name

Select Ascending.Selection Direction

Select Cyclic.Selection Mode

Enter the numbers of the PIMG ports that dial out MWIs.
For example, enter “*” for all PIMG ports, or enter “7,8”
for the last two PIMG ports.

Port/Channel Content

Step 38 Under TDM Trunk Groups, select Add Trunk Group.
Step 39 Enter the following settings for the third TDM trunk group.

Table 406: Third TDM Trunk Group Settings (Outbound Calls)

SettingsField

Enter Outbound_PBX_Calls or another unique name.

This TDM trunk group handles all outbound calls from
Unity Connection.

Name

Select Descending.Selection Direction

Select Linear.Selection Mode

Enter * for all channels in all ports.

Enter the numbers of the PIMG ports that handle outbound
(dialout) calls. For example, enter “*” for all PIMG ports,
or enter “7,8” for the last two PIMG ports.

Port/Channel Content

Step 40 Select Submit.
Step 41 Under Router Configuration, select Inbound VoIP Rules.
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Step 42 Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.
Step 43 Select Add Rule.
Step 44 Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 407: First New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable

EnterMWI_Calls or another name.

This inbound VoIP rule handles all MWI calls from Unity
Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address

Step 45 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another inbound VoIP
rule.

Table 408: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 46 Under Outbound Routes, enter the following settings.

The rule that you created in Step 44 must be selected. Otherwise, any changes you make apply to another rule.

Table 409: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for MWIs in Step 37. For example, select “MWIs.”

Trunk Group
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SettingsField

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 47 Under Inbound VoIP Rules, select Add Rule.
Step 48 Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.

Table 410: Second New Inbound VoIP Rule Settings (Outbound Calls)

SettingsField

Check this check box.Enable

Enter Outbound_UC_Calls or another name.

This inbound VoIP rule handles all outbound calls from
Unity Connection.

Rule Label

Select Call.Request Type

Enter *.Originating VoIP Host Address

Step 49 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.

Table 411: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number
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SettingsField

Enter *.Redirect Name

Step 50 Under Outbound Routes, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.

Table 412: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for outbound calls in Step 39. For example, select
“Outbound_PBX_Calls.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 51 Select Submit.
Step 52 Under Router Configuration, select Inbound TDM Rules.
Step 53 Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.

Table 413: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule handles all incoming calls from
the phone system.

Rule Label

Select Call.Request Type
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SettingsField

Select the name of the TDM trunk group that you created
for incoming calls from the phone system in Step 35. For
example, select “Inbound_PBX_Calls.”

Trunk Group

Step 54 Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another rule.

Table 414: Inbound TDM Request Matching Settings

SettingsField

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Name

Step 55 Under Outbound Routes, enter the following settings.

The rule that you created in Step 53 must be selected. Otherwise, any changes you make apply to another rule.

Table 415: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination

Select the name of the VoIP host group that you created
for Unity Connection in Step 28.

Host Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number
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SettingsField

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 56 If you want to create more Inbound TDM rules, under Inbound TDM Rules, select Add Rule. Otherwise, continue to
Step 58.

Step 57 Repeat Step 53 through Step 56 for all remaining inbound TDM rules that you want to create.
Step 58 Select Submit.
Step 59 On the Configuration menu, select TDM > Digital.
Step 60 On the Digital Telephony page, in the Telephony Switch Type field, select Optiset_300ECS.
Step 61 Select Submit.
Step 62 On the Configuration menu, select TDM > General.
Step 63 On the TDM General Settings page, enter the following settings.

Table 416: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Leave this field blank.Turn MWI On FAC

Leave this field blank.Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Select No.Disconnect on Fax Cleardown Tone

Step 64 Select Submit.
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Step 65 On the Configuration menu, select TDM > Port Enable.
Step 66 On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.
Step 67 Confirm that Yes is selected for all other ports on the PIMG unit.
Step 68 Select Submit.
Step 69 On the Configuration menu, select VoIP > General.
Step 70 On the VoIP General Settings page, enter the following settings.

Table 417: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Select No.SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that the
PIMG unit uses.

DNS Server Address

Select No.DNS Translation of Phone Numbers

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Enter 30.TCP Inactivity Timer (sec)

TLS

Select No.TLS Transport Enabled

Enter 5061.TLS Server Port

Select SSLv3 TLSv1.SSL TLS Protocol

Select Yes.Mutual TLS Authentication Required

Enter 30.TLS Inactivity Timer (sec)
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SettingField

Select Yes.Verify TLS Peer Certificate Date

Select Yes.Verify TLS Peer Certificate Trust

Proxy

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Enter 5000.T4 Time (ms)

Monitoring

Select No.Monitor Call Connections

Call Monitor Interval (sec)

Monitor VoIP Hosts

VoIP Host Monitor Interval (sec)

Step 71 Select Submit.
Step 72 On the Configuration menu, select VoIP > Media.
Step 73 On the VoIP Media Settings page, enter the following settings.

Table 418: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select RFC2833.RTP Fax/Modem Tone Relay Mode

Select Off.RTP Source IP Address Validation

Select Off.RTP Source UDP Port Validation
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SettingsField

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select On Demand.RFC 3960 Early Media Support

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Fax

Fax IP-Transport Mode

SRTP

Select RTP Only.SRTP Preference

Select Yes.MKI on Transmit Stream

Select Yes.Key Derivation Enable

Enter 16.Key Derivation Rate

Enter 64.Anti-replay Window Size Hint

Select AES_Counter_Mode.Cipher Mode

Select SHA1.Authentication Type

Select SHA1_80_bit.Authentication Tag Length

Step 74 Select Submit.
Step 75 On the Configuration menu, select VoIP > QOS.
Step 76 On the VoIP QOS Configuration page, enter the following settings.
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Table 419: VoIP QOS Configurative Page Settings

SettingsField

Enter 104.Call Control QOS Byte

Enter 184.RTP QOS Byte

Step 77 Select Submit.
Step 78 On the Configuration menu, select IP.
Step 79 On the IP Settings page, enter the following settings.

Table 420: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

SNTP Server IP Address

Step 80 Select Submit.
Step 81 On the Configuration menu, select Tone Detection.
Step 82 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select Busy and do the

following substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.

Step 83 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 82c. from the
third phone.

Step 84 Select Learn.
Step 85 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

PIMG Integration Guide for Cisco Unity Connection Release 12.X
344

Setting Up a Siemens Hicom 300 E (North American) Digital PIMG Integration
Setting Up the Digital PIMG Units (Firmware Version 6.x)



Step 86 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 85a.
Step 87 Select Learn.
Step 88 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, selectRingback and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 89 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 88a.
Step 90 Select Learn.
Step 91 Select Submit.
Step 92 Hang up the phones that you used in Step 82.
Step 93 On the System menu, select Restart.
Step 94 On the Restart page, select Restart Unit Now.
Step 95 Repeat Step 2 through Step 94 on all remaining PIMG units.

Configuring Unity Connection for Integration with Siemens Hicom 300 E (North
American) Phone System

After ensuring that the Siemens Hicom 300 E (North American) phone system, the PIMG units, and Unity
Connection are ready for the integration, do the following procedure to set up the integration and to enter the
port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
Step 6 Select Save.
Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 421: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System
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SettingField

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 422: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports
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ConsiderationsField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.

Table 423: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections
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ConsiderationsField

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note

Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 424: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name
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SettingField

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is

checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

Table 425: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone

system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.
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C H A P T E R 16
Creating New Integration with Siemens Hipath
3750 Phone System

After ensuring that the Siemens Hipath 3750 phone system, the PIMG units, and Unity Connection are ready
for the integration, do the following procedure to set up the integration and to enter the port settings.

• Setting Up a Siemens Hipath 3750 Analog PIMG Integration, on page 351

Setting Up a Siemens Hipath 3750 Analog PIMG Integration

Task List for Siemens Hipath 3750 PIMG Integration
Before doing the following tasks to integrate Unity Connection with the Hipath 3750 phone system using
PIMG units (media gateways), confirm that the Unity Connection server is ready for the integration after
completing the server installation, following the tasks in the “Installing Cisco Unity Connection” chapter of
the Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Unity Connection
server requirements have been met. See the Requirements, on page 12 section.

2. Plan how the voice messaging ports are used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports, on page 7 chapter.

3. Program the Siemens Hipath 3750 phone system and extensions. See the Programming Siemens Hipath
3750 Phone System for Integration Using the Command Line Interface section.

4. Set up the PIMG units.

5. Create the integration. See the Creating New Integration with Siemens Hipath 3750 Phone System, on
page 371 section.

6. Test the integration. See the Testing the Integration, on page 401 chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Adding New User Templates for Multiple Integrations, on page 407 chapter.
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Requirements
This integration supports configurations of the following components:

Phone System
• The Siemens Hipath 3750 phone system.

• Software version HE580S.13.108 or later.

• One or more of the applicable PIMG units. For details, see the “Introduction” chapter.

• The voice messaging ports in the phone system connected by analog lines to the ports on the PIMG units.

We recommend that you connect the voice messaging ports on the phone system to the ports on the PIMG
units in a planned manner to simplify troubleshooting. For example, the first phone system voice messaging
port connects to the first port on the first PIMG unit, the second phone system voice messaging port connects
to the second port on the first PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

• The phone system ready for the integration, as described in the documentation for the phone system.

Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.

Programming Siemens Hipath 3750 Phone System for Integration Using the
Command Line Interface

The following programming instructions are provided as an example only. The specific programming for your
phone system may vary depending on its configuration.
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In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Send MWI Requests, do not send calls to it.

Caution

Step 1 In the Siemens Hipath 3750 interface, configure the stations for the ports on all of the PIMG units using the following
settings.

Table 426: Station Settings

SettingField

Enter the internal call number that is associated with each
port on the PIMG units.

Call No.

Enter the DID for ports on the PIMG units are dialing out
(for example, to set MWIs).

DID

Enter a name that you want for the station. For example,
enter “PIMG port 1” for the first port. Note that you can
enter a maximum of 16 characters.

Name

(Display only) The phone device that the phone system
has configured for the port.

Type

Click PhoneMail for the applicable dial plan.Type

Step 2 Click Apply.
Step 3 Configure the access number to forward calls to subscriber mailboxes.
Step 4 Configure the hunt group for the ports on the PIMG units that answer calls using the following settings.

Table 427: Hunt Group Settings

SettingField

Click an available index that you want to use for the ports
on the PIMG units.

Index

Enter the pilot number for Unity Connection.Call No.

Enter the four-digit DID that is associated with call number
that is associated with the hunt group.

DID

Enter a name for the hunt group.Name

From the drop-down box, click Linear.

You must use a linear hunt group. Otherwise, the
integration cannot function correctly.

Type

Step 5 Click Apply.
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Step 6 Under Group, in the Call No. column, click the call number for the hunt group that you created in Step 4.
Step 7 In the Selection box, highlight all the ports on the PIMG units that answer calls.
Step 8 Add the highlighted ports to the Members box by clicking -.
Step 9 In the Members box, highlight the ports that dial out (for example, to set MWIs), and click Down until all dialout ports

are at the bottom of the box.
Step 10 Configure call forwarding for the ports on the PIMG units that answer calls. For the fields under Call Dest. List -

Definition, use the following settings.

Table 428: Call Dest. List - Definition Settings

SettingField

The call destination number that you use for the ports on
the PIMG units.

No.

Leave this field blank.Target 1

Enter 1 (which equals about 5 seconds).Cycles

Click Immediate.SR Type

Check this check box.RNA

Step 11 Under Call Dest. List - Station Assignment, click Show All Stations.
Step 12 In the table, assign the call destination for the definition using the following settings.

Table 429: Call Dest. List - Station Assignment Settings

SettingField

Click the extension for a port on the PIMG units, which
you assigned in Step 1.

Call No.

From the drop-down box, click the call destination number,
which you defined in Step 10.

Day

From the drop-down box, click the call destination number,
which you defined in Step 10.

Night

From the drop-down box, click the call destination number,
which you defined in Step 10.

Internal

Step 13 Click Apply.
Step 14 Repeat Step 12 and Step 13 for all remaining ports on the PIMG units.
Step 15 Program each phone to forward calls to the pilot number assigned to the voice messaging ports, based on one of the

Unity Connection call transfer types shown in Table 430: Call Transfer Types.
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Table 430: Call Transfer Types

UsageTransfer Types

Program the phone to forward calls to the pilot number
when:

• The extension is busy

• The call is not answered

Release transfer (blind transfer)

Program the user station to forward calls to the pilot
number only when the call is not answered (on the phone
system, the number of rings before forwarding must be
more than the number of rings to supervise the call).
Confirm that call forwarding is disabledwhen the extension
is busy.

Supervised transfer

Setting Up the Analog PIMG Units for a DTMF Integration
Do the following procedures to set up the analog PIMG units that are connected to the Siemens Hipath 3750
phone system for a DTMF integration.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the PIMG units using analog lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the PIMG units.

Downloading the PIMG Firmware Update Files for Analog PIMG Units

Step 1 On a Windows workstation with a high-speed Internet connection that have access to the PIMG units, go to the Voice
and Unified Communications Downloads page at
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.

To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

Note

Step 2 In the tree control on the Downloads Home page, expand Unified Communications> Unified Communications
Applications > Messaging > Cisco Unity and select Cisco Unity Telephony Integration.

Step 3 On the Log In page, enter your username and password, then select Log In.
Step 4 On the Select a Release page, under Latest Releases, select the most recent release.
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Step 5 In the right column, select the version of the firmware for analog PIMG units.

Step 6 On the Download Image page, select Download.
Step 7 On the Supporting Document(s) page, select Agree.
Step 8 In the File Download dialog box, select Save.
Step 9 In the Save As dialog box, browse to the Windows workstation that have access the PIMG units, browse to a directory

where you want to save the file, and select Save.
Step 10 In the Download Complete dialog box, selectOpen. The window for extracting the PIMG firmware update files appears.
Step 11 Select Extract.
Step 12 In the Extract dialog box, browse to the directory where you want the extracted files, and select Extract.
Step 13 Close the window for the extracting application.

To Set Up the Analog PIMG Units (Firmware Version 6.x)

Step 14 On the Windows workstation, add a temporary route to enable access to the PIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 15 Connect a PIMG unit to the network.
Step 16 In the web browser, go to http://10.12.13.74.
Step 17 To sign in, enter the following case-sensitive settings.

Table 431: Sign-in Settings

SettingsField

Enter admin.Username

Enter IpodAdmin.Password

Step 18 Select OK.
Step 19 On the System menu, select Upgrade.
Step 20 On the Upgrade page, select Browse.
Step 21 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted PIMG firmware

update files.
Step 22 Select Ls_<xx > .app (where <xx> is multiple digits), and select Open.
Step 23 On the Upgrade page, select Install File.
Step 24 After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.

Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file installation fails.
Restarting the PIMG unit at this step may prevent the PIMG unit from functioning correctly.

Step 25 Repeat Step 6 through Step 11 for the following files:
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• Run_<xx>FskEcho.dsp

• Ls_<xx>.fsh

1. On the Configuration menu, select Import/Export.

2. On the Import/Export page, select Browse.

3. In the Choose File dialog box, browse to the file Ls_Cfg_Hicom300E.ini.

4. Select Ls_Cfg_Hicom300E.ini, and select Open.

5. On the Import/Export page, select Import File.

6. After the file is imported, a message prompting you to restart the PIMG unit appears. Select OK.

7. In the web browser, go to http://10.12.13.74.

8. To sign in, enter the following case-sensitive settings.

Table 432: Sign-in Settings

SettingsField

Enter admin.Username

Enter IpodAdmin.Password

1. Select OK.

2. Do the following substeps to configure an RTP port range of 16384 to 32767.

You must set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to
32767. Otherwise, Unity Connection cannot answer calls and callers hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. Some Cisco Unity Connection configurations
require a different RTP port range.

Note

1. On the Configuration menu, select Import/Export.

2. On the Import/Export page, under Export Files, select Export All Settings.

3. In the File Download dialog box, select Save.

4. In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units,
browse to a directory where you want to save the file, and select Save.

5. In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you
saved.

6.
7.
8. Locate the line with the following parameter:

gwRTPStartPort
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9. Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384

10. Locate the line with the following parameter:

gwRTPEndPort

11. Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

12. Save the file, and exit Notepad.

13. On the Configuration menu of the PIMG unit, select Import/Export.

14. On the Import/Export page, under Browse for Import File, select Browse.

15. In the Choose File dialog box, browse to the file Config.ini that you saved.

16. Select Config.ini, and select Open.

17. On the Import/Export page, select Import File.

18. When prompted to restart the PIMG unit, select OK.

19. When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.

20. To sign in, enter the following case-sensitive settings.

Table 433: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

1. Select OK.

1. On the System menu, select Password.

2. On the Change Password page, enter the following settings.

Table 434: Change Password Page Settings

SettingsField

Enter IpodAdmin. (This setting is case sensitive.)Old Password

Enter your new password. (This setting is case
sensitive.)

New Password

Enter your new password. (This setting is case
sensitive.)

Confirm Password
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1. Select Change.

2. On the Configuration menu, selectMgmt Protocols.

3. On the Management Protocols page, enter the following settings.

Table 435: Management Protocols Page Settings

SettingsField

Select No.E-mail Alarms Enabled

Select No.SNMP Traps Enabled

1. Select Submit.

2. On the Configuration menu, select Routing Table.

3. On the Routing Table page, under Router Configuration, select VoIP Host Groups.

4. Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 436: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name
of the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select
False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select
True.

Fault-Tolerant

1. For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity
Connection server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, confirm that field contains the host name
or IP address of the publisher server (the first Unity Connection server that you installed) and the server port
in the format <host name or IP address>:5060.

1. For Unity Connectionwithout a cluster, continue to Step 36. For Unity Connectionwith a cluster configured,
under Host List, enter the host name or IP address of the subscriber server (the second Unity Connection
server that you installed) and the server port in the format <host name or IP address>:5060.

2. Select Add Host.

3. In the second field, enter the host name or IP address of the publisher server (the first Unity Connection
server that you installed) and the server port in the format <host name or IP address>:5060.
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Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the
Unity Connection cluster may not function correctly.

4. Select Submit.

5. Under Router Configuration, select TDM Trunk Groups.

6. Under TDM Trunk Groups, select Add Trunk Group.

7. Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.

Table 437: First TDM Trunk Group Settings (Inbound Calls)

SettingsField

Enter Inbound_PBX_Calls or another unique name.

This TDM trunk group handles all incoming calls
from the phone system.

Name

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports that handle
inbound calls. For example, enter “*” for all PIMG
ports, or enter “1-6” for the first six PIMG ports.

Port/Channel Content

1. Under TDM Trunk Groups, select Add Trunk Group.

2. Enter the following settings for the second TDM trunk group.

Table 438: Second TDM Trunk Group Settings (MWIs)

SettingsField

EnterMWIs or another unique name.

This TDM trunk group handles outbound MWI calls
(where applicable).

Name

Select Ascending.Selection Direction

Select Cyclic.Selection Mode

Enter the numbers of the PIMG ports that dial out
MWIs. For example, enter “*” for all PIMG ports, or
enter “7,8” for the last two PIMG ports.

Port/Channel Content

1. Under TDM Trunk Groups, select Add Trunk Group.

2. Enter the following settings for the third TDM trunk group.
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Table 439: Third TDM Trunk Group Settings (Outbound Calls)

SettingsField

EnterOutbound_PBX_Calls or another unique name.

This TDM trunk group handles all outbound calls
from Unity Connection.

Name

Select Descending.Selection Direction

Select Linear.Selection Mode

Enter * for all channels in all ports.

Enter the numbers of the PIMG ports that handle
outbound (dialout) calls. For example, enter “*” for
all PIMG ports, or enter “7,8” for the last two PIMG
ports.

Port/Channel Content

1. Select Submit.

2. Under Router Configuration, select Inbound VoIP Rules.

3. Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.

4. Select Add Rule.

5. Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 440: First New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable

EnterMWI_Calls or another name.

This inbound VoIP rule handles all MWI calls from
Unity Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address

1. Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another
rule.

Table 441: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number
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SettingsField

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

1. Under Outbound Routes, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another
rule.

Table 442: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you
created for MWIs in Step 41. For example, select
“MWIs.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

1. Under Inbound VoIP Rules, select Add Rule.

2. Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.
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Table 443: Second New Inbound VoIP Rule Settings (Outbound Calls)

SettingsField

Check this check box.Enable

Enter Outbound_UC_Calls or another name.

This inbound VoIP rule handles all outbound calls
from Unity Connection.

Rule Label

Select Call.Request Type

Enter *.Originating VoIP Host Address

1. Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 52 must be selected. Otherwise, any changes you make apply to another
rule.

Table 444: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

1. Under Outbound Routes, enter the following settings.

The rule that you created in Step 52 must be selected. Otherwise, any changes you make apply to another
rule.

Table 445: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you
created for outbound calls in Step 43. For example,
select “Outbound_PBX_Calls.”

Trunk Group

CPID Manipulation
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SettingsField

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

1. Select Submit.

2. Under Router Configuration, select Inbound TDM Rules.

3. Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.

Table 446: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule handles all incoming calls
from the phone system.

Rule Label

Select Call.Request Type

Select the name of the TDM trunk group that you
created for incoming calls from the phone system in
Step 39. For example, select “Inbound_PBX_Calls.”

Trunk Group

1. Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 57 must be selected. Otherwise, any changes you make apply to another
rule.

Table 447: Inbound TDM Request Matching Settings

SettingsField

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Name
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SettingsField

Enter the applicable matching ruleused. For example,
enter “*” for all.

Called Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Name

1. Under Outbound Routes, enter the following settings.

The rule that you created in Step 57 must be selected. Otherwise, any changes you make apply to another
rule.

Table 448: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination

Select the name of the VoIP host group that you
created for Unity Connection in Step 31.

Host Group

CPID Manipulation

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Calling Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Called Name

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Number

Enter the applicable matching rule used. For example,
enter “*” for all.

Redirect Name

Select Primary/Alternate Route

Select Primary.Primary
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1. If you want to create more Inbound TDM rules, under Inbound TDM Rules, selectAdd Rule. Otherwise,
continue to Step 62.

2. Repeat Step 57 through Step 60 for all remaining inbound TDM rules that you want to create.

3. Select Submit.

4. On the Configuration menu, select TDM > General.

5. On the TDM General Settings page, enter the following settings.

Table 449: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Enter the code that turns MWIs on.Turn MWI On FAC

Enter the code that turns MWIs off.Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Select No.Disconnect on Fax Cleardown Tone

1. Select Submit.

2. On the Configuration menu, select TDM > Port Enable.

3. On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.

4. Confirm that Yes is selected for all other ports on the PIMG unit.

5. Select Submit.

6. On the Configuration menu, select VoIP > General.

7. On the VoIP General Settings page, enter the following settings.
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Table 450: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that
the PIMG unit uses.

DNS Server Address

DNS Translation of Phone Numbers

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Enter 30.TCP Inactivity Timer (sec)

TLS

TLS Transport Enabled

TLS Server Port

SSL TLS Protocol

Mutual TLS Authentication Required

TLS Inactivity Timer (sec)

Verify TLS Peer Certificate Date

Verify TLS Peer Certificate Trust

Proxy

Leave this field blank.Primary Proxy Server Address
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SettingField

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Enter 5000.T4 Time (ms)

Monitoring

Select No.Monitor Call Connections

Call Monitor Interval (sec)

Monitor VoIP Hosts

VoIP Host Monitor Interval (sec)

1. Select Submit.

2. On the Configuration menu, select VoIP > Media.

3. On the VoIP Media Settings page, enter the following settings.

Table 451: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select RFC2833.RTP Fax/Modem Tone Relay Mode

Select Off.RTP Source IP Address Validation

Select Off.RTP Source UDP Port Validation

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select On Demand.RFC 3960 Early Media Support
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SettingsField

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Frames Per Packet

Fax

Fax IP-Transport Mode

1. Select Submit.

2. On the Configuration menu, select VoIP > QOS.

3. On the VoIP QOS Configuration page, enter the following settings.

Table 452: VoIP QOS Configuration Page Settings

SettingsField

Enter 104.Call Control QOS Byte

Enter 184.RTP QOS Byte

1. Select Submit.

2. On the Configuration menu, select IP.

3. On the IP Settings page, enter the following settings.

Table 453: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the
PIMG unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address
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SettingsField

Enter the new subnet mask, if the subnet mask is
different from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway
router that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

1. Select Submit.

2. On the Configuration menu, select Tone Detection.

3. On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select
Busy and do the following substeps to verify that the tone is correct.

1. From an available phone, call a second phone.

2. Answer the second phone when it rings, and leave both handsets off so that both phones are busy.

3. From a third phone, dial one of the busy phones.

4. Confirm that you hear a busy tone.

5. Hang up the third phone but leave the handsets for the other two phones off.

4. Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 83c.
from the third phone.

5. Select Learn.

6. On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do
the following substeps to verify that the tone is correct.

1. From an available phone, dial an extension that does not exist.

2. Confirm that you hear the reorder or error tone.

3. Hang up the phone.

7. Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 86a.

8. Select Learn.

9. On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Ringback and
and do the following substeps to verify that the tone is correct.

1. From an available phone, dial an extension that does exist

2. Confirm that you hear the ringback tone.

3. Hang up the phone.

10. Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 89a.

11. Select Learn.

12. Select Submit.
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13. Hang up the phones that you used in Step 89.

14. On the System menu, select Restart.

15. On the Restart page, select Restart Unit Now.

16. Repeat Step 2 through Step 95 on all remaining PIMG units.

Creating New Integration with Siemens Hipath 3750 Phone System
After ensuring that the Siemens Hipath 3750 phone system, the PIMG units, and Unity Connection are ready
for the integration, do the following procedure to set up the integration and to enter the port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
Step 6 Select Save.
Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 454: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name
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SettingField

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 455: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.
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Table 456: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note
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Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 457: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is

checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.
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Table 458: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone

system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.

PIMG Integration Guide for Cisco Unity Connection Release 12.X
375

Creating New Integration with Siemens Hipath 3750 Phone System
Creating an Integration



PIMG Integration Guide for Cisco Unity Connection Release 12.X
376

Creating New Integration with Siemens Hipath 3750 Phone System
Creating an Integration



C H A P T E R 17
Setting Up a Siemens Hipath 4000 Analog PIMG
Integration

For detailed instructions for setting up an Siemens Hipath 4000 analog PIMG integration with Cisco Unity
Connection, see the following sections in this chapter:

• Setting Up a Siemens Hipath 4000 Analog PIMG Integration, on page 377

Setting Up a Siemens Hipath 4000 Analog PIMG Integration
For detailed instructions for setting up an Siemens Hipath 4000 analog PIMG integration with Cisco Unity
Connection, see the following sections in this chapter:

Task List for Siemens Hipath 4000 PIMG Integration
Before doing the following tasks to integrate Unity Connection with the Hipath 4000 phone system using
PIMG units (media gateways), confirm that the Unity Connection server is ready for the integration after
completing the server installation, following the tasks in the “Installing Cisco Unity Connection” chapter of
the Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Unity Connection
server requirements have been met. See the Requirements, on page 12 section.

2. Plan how the voice messaging ports are used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports, on page 7 chapter.

3. Program the Siemens Hipath 4000 phone system and extensions. See the Programming Siemens Hipath
4000 Phone System for Integration section.

4. Set up the PIMG units.

5. Create the integration. See the Creating New Integration with Siemens Hipath 4000 Phone System, on
page 395 section.

6. Test the integration. See the Testing the Integration, on page 401 chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Adding New User Templates for Multiple Integrations, on page 407 chapter.
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Requirements
This integration supports configurations of the following components:

Phone System
• The Siemens Hipath 4000 phone system.

• Software version 2.0 SMR9 SMP0 or later.

• SLMA24 - Q2245 analog line card.

• One or more of the applicable PIMG units. For details, see the “Introduction” chapter.

• The voice messaging ports in the phone system connected by analog lines to the ports on the PIMG units.

We recommend that you connect the voice messaging ports on the phone system to the ports on the PIMG
units in a planned manner to simplify troubleshooting. For example, the first phone system voice messaging
port connects to the first port on the first PIMG unit, the second phone system voice messaging port connects
to the second port on the first PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

• The phone system ready for the integration, as described in the documentation for the phone system.

Unity Connection Server
• Unity Connection installed following the tasks in the “Installing Cisco Unity Connection” chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.

Programming Siemens Hipath 4000 Phone System for Integration
The following programming instructions are provided as an example only. The specific programming for your
phone system may vary depending on its configuration.
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In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Send MWI Requests, do not send calls to it.

Caution

Step 1 In the Siemens Hipath 4000 interface, use the CHA-ZAND command for the systemwide configuration for the analog
ports using the following settings.

Table 459: Systemwide Port Settings

SettingField

Enter alldata.TYPE

Enter extend.TRANSFER

Enter yes.RNGTNINT

Enter yes.PREDIA

Step 2 Use the CHA-ZAND command for the systemwide configuration for MWIs using the following settings.

Table 460: Systemwide MWI Settings

SettingField

Enter vmi.TYPE

Enter yes.MWIOPEN

Enter the one more than the number of digits in the calling
party extension. For example, if the calling party extension
has four digits, enter 5.

ALEN

Enter the one more than the number of digits in the called
party extension. For example, if the called party extension
has four digits, enter 5.

BLEN

Step 3 Use the ADD-COSSU command to configure a class of service template that have the following classes of service for
the ports that connect to the PIMG units:

• RTAx

• RTAy

• TNOTCR

• RKOABS

• NOANSA

For incoming lines
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• RTAx

• RTAy

• TNOTCR

• RKOABS

• NOANSA

• CDRx

For outgoing lines

Step 4 Use the ADD-SCSU command to configure each port that connects to the PIMG units using the following settings.

Table 461: Individual Port Settings

SettingField

Enter the extension of the port.STNO

Enter ANATE.DVCFIG

Enter the number of digits that the dial plan uses for
extensions.

DPLN

Enter the number of digits that the dial plan uses for
extensions.

ITR

Enter the number of the class of service that you defined in
Step 3.

COS1

Enter the number of the class of service that you defined in
Step 3.

COS2

Enter the number of the class of service that you defined in
Step 3.

LCOSV1

Enter the number of the class of service that you defined in
Step 3.

LCOSV2

Enter the number of the class of service that you defined in
Step 3.

LCOSD1

Enter the number of the class of service that you defined in
Step 3.

LCOSD2

Enter 0.COFIDX

Enter SUFDIAL&SSTN.SPEC

Enter DTMF.DIAL

Enter DTMFSTN&PREDIA&ASEND&BSEND.DPHAR
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Step 5 Use the ADD-SA command to configure a hunt group for the ports that connect to the PIMG units. The following is an
example of a hunt group configuration.

TYPE = stn
CD = 500
DPLN = 3
CPS =
SVC = vce
STNO = 501&502&503&504&505&506&507&508
POS =

Step 6 Program each phone to forward calls to the pilot number assigned to the voice messaging ports, based on one of the Unity
Connection call transfer types shown in the following table.

Table 462: Call Transfer Types

UsageTransfer Types

Program the phone to forward calls to the pilot number
when:

• The extension is busy

• The call is not answered

Release transfer (blind transfer)

Program the user station to forward calls to the pilot number
only when the call is not answered (on the phone system,
the number of rings before forwarding must be more than
the number of rings to supervise the call). Confirm that call
forwarding is disabled when the extension is busy.

Supervised transfer

Setting Up the Analog PIMG Units for a DTMF Integration
Do the following procedures to set up the analog PIMG units that are connected to the Siemens Hipath 4000
phone system for a DTMF integration.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the PIMG units using analog lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the PIMG units.
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Downloading the PIMG Firmware Update Files for Analog PIMG Units

Step 1 On a Windows workstation with a high-speed Internet connection that have access to the PIMG units, go to the Voice
and Unified Communications Downloads page at
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.

To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

Note

Step 2 In the tree control on the Downloads Home page, expand Unified Communications> Unified Communications
Applications > Messaging > Cisco Unity and select Cisco Unity Telephony Integration.

Step 3 On the Log In page, enter your username and password, then select Log In.
Step 4 On the Select a Release page, under Latest Releases, select the most recent release.
Step 5 In the right column, select the version of the firmware for analog PIMG units.
Step 6 On the Download Image page, select Download.
Step 7 On the Supporting Document(s) page, select Agree.
Step 8 In the File Download dialog box, select Save.
Step 9 In the Save As dialog box, browse to the Windows workstation that have access the PIMG units, browse to a directory

where you want to save the file, and select Save.
Step 10 In the Download Complete dialog box, selectOpen. The window for extracting the PIMG firmware update files appears.
Step 11 Select Extract.
Step 12 In the Extract dialog box, browse to the directory where you want the extracted files, and select Extract.
Step 13 Close the window for the extracting application.

Setting Up the Analog PIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the PIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 2 Connect a PIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.
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Table 463: Sign-in Settings

SettingsField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
Step 7 On the Upgrade page, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted PIMG firmware

update files.
Step 9 Select Ls_<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the PIMG unit appears. Select Cancel.

Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if the file installation fails.
Restarting the PIMG unit at this step may prevent the PIMG unit from functioning correctly.

Step 12 Repeat Step 6 through Step 11 for the file Run_<xx > .dsp.
Step 13 On the System menu, select Upgrade.
Step 14 On the Upgrade page, under Import, select Browse.
Step 15 In the Choose File dialog box, browse to the file Ls_<xx > .fsh.
Step 16 Select Ls_<xx > .fsh, and select Open.
Step 17 On the Upgrade page, select Install File.
Step 18 After the file is installed, a message prompting you to restart the PIMG unit appears. Select OK.
Step 19 In the web browser, go to http://10.12.13.74.
Step 20 To sign in, enter the following case-sensitive settings.

Table 464: Sign-in Settings

SettingsField

Enter admin.Username

Enter IpodAdmin.Password

Step 21 Select OK.
Step 22 If your Unity Connection systemmust have an RTP port range of 16384 to 32767, do the following substeps. Otherwise,

continue to Step 23.

Youmust set the RTP port range for the PIMG units if your system uses an RTP port range of 16384 to 32767. Otherwise,
Unity Connection cannot answer calls and callers hear ringing or silence.

The default RTP port range for PIMG units is 49000 to 50000. SomeUnity Connection configurations require
a different RTP port range.

Note

a) On the Configuration menu, select Import/Export.
b) On the Import/Export page, under Export Files, select Export All Settings.
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c) In the File Download dialog box, select Save.
d) In the Save As dialog box, browse to the Windows workstation that has access to the PIMG units, browse to a

directory where you want to save the file, and select Save.
e) In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you saved.
f) Locate the line with the following parameter:

gwRTPStartPort

g) Change the value of the parameter to 16384 so that the line reads as follows:

gwRTPStartPort = 16384

h) Locate the line with the following parameter:

gwRTPEndPort

i) Change the value of the parameter to 32767 so that the line reads as follows:

gwRTPEndPort = 32767

j) Save the file, and exit Notepad.
k) On the Configuration menu of the PIMG unit, select Import/Export.
l) On the Import/Export page, under Browse for Import Settings, select Browse.
m) In the Choose File dialog box, browse to the file Config.ini that you saved.
n) Select Config.ini, and select Open.
o) On the Import/Export page, select Import File.
p) When prompted to restart the PIMG unit, select OK.
q) When the PIMG unit has restarted, in the web browser, go to http://10.12.13.74.
r) To sign in, enter the following case-sensitive settings.

Table 465: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

s) Select OK.

Step 23 On the System menu, select Password.
Step 24 On the Change Password page, enter the following settings.

Table 466: Change Password Page Settings

SettingsField

Enter IpodAdmin.

(This setting is case sensitive.)

Old Password
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SettingsField

Enter your new password.

(This setting is case sensitive.)

New Password

Enter your new password.

(This setting is case sensitive.)

Confirm Password

Step 25 Select Change.
Step 26 On the Configuration menu, selectMgmt Protocols.
Step 27 On the Management Protocols page, enter the following settings.

Table 467: Management Protocols Page Settings

SettingsField

Select No.E-mail Alarms Enabled

Select No.SNMP Traps Enabled

Step 28 Select Submit.
Step 29 On the Configuration menu, select Routing Table.
Step 30 On the Routing Table page, under Router Configuration, select VoIP Host Groups.
Step 31 Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 468: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name of
the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select True.

Fault-Tolerant

Step 32 For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity Connection
server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, confirm that field contains the host name or IP address
of the publisher server (the first Unity Connection server that you installed) and the server port in the format <host
name or IP address>:5060.

Step 33 For Unity Connection without a cluster, continue to Step 36. For Unity Connection with a cluster configured, under
Host List, enter the host name or IP address of the subscriber server (the second Unity Connection server that you
installed) and the server port in the format <host name or IP address>:5060.

Step 34 Select Add Host.
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Step 35 In the second field, enter the host name or IP address of the publisher server (the first Unity Connection server that you
installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the Unity Connection
cluster may not function correctly.

Step 36 Select Submit.
Step 37 Under Router Configuration, select TDM Trunk Groups.
Step 38 Under TDM Trunk Groups, select Add Trunk Group.
Step 39 Under TDM Trunk Groups, enter the following settings for the first TDM trunk group.

Table 469: First TDM Trunk Group Settings (Inbound Calls)

SettingsField

Enter Inbound_PBX_Calls or another unique name.

This TDM trunk group handles all incoming calls from
the phone system.

Name

Select Ascending.Selection Direction

Select Linear.Selection Mode

Enter the numbers of the PIMG ports that handle inbound
calls. For example, enter “*” for all PIMG ports, or enter
“1-6” for the first six PIMG ports.

Port/Channel Content

Step 40 Under TDM Trunk Groups, select Add Trunk Group.
Step 41 Enter the following settings for the second TDM trunk group.

Table 470: Second TDM Trunk Group Settings (MWIs)

SettingsField

EnterMWIs or another unique name.

This TDM trunk group handles outbound MWI calls
(where applicable).

Name

Select Ascending.Selection Direction

Select Cyclic.Selection Mode

Enter the numbers of the PIMG ports that dial out MWIs.
For example, enter “*” for all PIMG ports, or enter “7,8”
for the last two PIMG ports.

Port/Channel Content

Step 42 Under TDM Trunk Groups, select Add Trunk Group.
Step 43 Enter the following settings for the third TDM trunk group.
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Table 471: Third TDM Trunk Group Settings (Outbound Calls)

SettingsField

Enter Outbound_PBX_Calls or another unique name.

This TDM trunk group handles all outbound calls from
Unity Connection.

Name

Select Descending.Selection Direction

Select Linear.Selection Mode

Enter * for all channels in all ports.

Enter the numbers of the PIMG ports that handle outbound
(dialout) calls. For example, enter “*” for all PIMG ports,
or enter “7,8” for the last two PIMG ports.

Port/Channel Content

Step 44 Select Submit.
Step 45 Under Router Configuration, select Inbound VoIP Rules.
Step 46 Under Inbound VoIP Rules, uncheck the Enabled check box for the default rule.
Step 47 Select Add Rule.
Step 48 Under Inbound VoIP Rules, enter the following settings for the first new inbound VoIP rule.

Table 472: First New Inbound VoIP Rule Settings (MWIs)

SettingsField

Check this check box.Enable

EnterMWI_Calls or another name.

This inbound VoIP rule handles all MWI calls from Unity
Connection.

Rule Label

SelectMessage.Request Type

Enter *.Originating VoIP Host Address

Step 49 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.

Table 473: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name
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SettingsField

Enter *.Redirect Number

Enter *.Redirect Name

Step 50 Under Outbound Routes, enter the following settings.

The rule that you created in Step 48 must be selected. Otherwise, any changes you make apply to another rule.

Table 474: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for MWIs in Step 41. For example, select “MWIs.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 51 Under Inbound VoIP Rules, select Add Rule.
Step 52 Under Inbound VoIP Rules, enter the following settings for the second new inbound VoIP rule.

Table 475: Second New Inbound VoIP Rule Settings (Outbound Calls)

SettingsField

Check this check box.Enable

Enter Outbound_UC_Calls or another name.

This inbound VoIP rule handles all outbound calls from
Unity Connection.

Rule Label

Select Call.Request Type
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SettingsField

Enter *.Originating VoIP Host Address

Step 53 Under Inbound VoIP Request Matching, enter the following settings.

The rule that you created in Step 52 must be selected. Otherwise, any changes you make apply to another rule.

Table 476: Inbound VoIP Request Matching Settings

SettingsField

Enter *.Calling Number

Enter *.Calling Name

Enter *.Called Number

Enter *.Called Name

Enter *.Redirect Number

Enter *.Redirect Name

Step 54 Under Outbound Routes, enter the following settings.

The rule that you created in Step 52 must be selected. Otherwise, any changes you make apply to another rule.

Table 477: Outbound Routes Settings

SettingsField

Device Selection

Select TDM.Outbound Destination

Select the name of the TDM trunk group that you created
for outbound calls in Step 43. For example, select
“Outbound_PBX_Calls.”

Trunk Group

CPID Manipulation

Enter S.Calling Number

Enter S.Calling Name

Enter D.Called Number

Enter D.Called Name

Enter R.Redirect Number

Enter R.Redirect Name

Select Primary/Alternate Route

PIMG Integration Guide for Cisco Unity Connection Release 12.X
389

Setting Up a Siemens Hipath 4000 Analog PIMG Integration
Setting Up the Analog PIMG Units (Firmware Version 6.x)



SettingsField

Select Primary.Primary

Step 55 Select Submit.
Step 56 Under Router Configuration, select Inbound TDM Rules.
Step 57 Under Inbound TDM Rules, enter the following settings for the first inbound TDM rule.

Table 478: First Inbound TDM Rule Settings

SettingsField

Check this check box.Enable

Enter Inbound_Rule_1 or another name.

This inbound TDM rule handles all incoming calls from
the phone system.

Rule Label

Select Call.Request Type

Select the name of the TDM trunk group that you created
for incoming calls from the phone system in Step 39. For
example, select “Inbound_PBX_Calls.”

Trunk Group

Step 58 Under Inbound TDM Request Matching, enter the following settings.

The rule that you created in Step 57 must be selected. Otherwise, any changes you make apply to another rule.

Table 479: Inbound TDM Request Matching Settings

SettingsField

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Name

Step 59 Under Outbound Routes, enter the following settings.

The rule that you created in Step 57 must be selected. Otherwise, any changes you make apply to another rule.

PIMG Integration Guide for Cisco Unity Connection Release 12.X
390

Setting Up a Siemens Hipath 4000 Analog PIMG Integration
Setting Up the Analog PIMG Units (Firmware Version 6.x)



Table 480: Outbound Routes Settings

SettingsField

Device Selection

Select VoIP.Outbound Destination

Select the name of the VoIP host group that you created
for Unity Connection in Step 31.

Host Group

CPID Manipulation

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Calling Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Called Name

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Number

Enter the applicablematching rule used. For example, enter
“*” for all.

Redirect Name

Select Primary/Alternate Route

Select Primary.Primary

Step 60 If you want to create more Inbound TDM rules, under Inbound TDM Rules, select Add Rule. Otherwise, continue to
Step 62.

Step 61 Repeat Step 57 through Step 60 for all remaining inbound TDM rules that you want to create.
Step 62 Select Submit.
Step 63
Step 64
Step 65
Step 66 On the Configuration menu, select TDM > General.
Step 67 On the TDM General Settings page, enter the following settings.

Table 481: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)
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SettingsField

Enter 2000.Maximum Call Party Delay (msecs)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Enter the code that turns MWIs on.Turn MWI On FAC

Enter the code that turns MWIs off.Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Step 68 Select Submit.
Step 69 On the Configuration menu, select TDM > Port Enable.
Step 70 On the TDM Port Enabling page, select No for the ports that you want to disable on the PIMG unit.
Step 71 Confirm that Yes is selected for all other ports on the PIMG unit.
Step 72 Select Submit.
Step 73 On the Configuration menu, select VoIP > General.
Step 74 On the VoIP General Settings page, enter the following settings.

Table 482: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the host and domain name of the PIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that the
PIMG unit uses.

DNS Server Address

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)
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SettingField

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Proxy

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 400.T1 Time (ms)

Enter 3000.T2 Time (ms)

Monitoring

Select No.Monitor Call Connections

Step 75 Select Submit.
Step 76 On the Configuration menu, select VoIP > Media.
Step 77 On the VoIP Media Settings page, enter the following settings.

Table 483: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression.Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size
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SettingsField

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Step 78 Select Submit.
Step 79 On the Configuration menu, select VoIP > QOS.
Step 80 On the VoIP QOS Configuration page, enter the following settings.

Table 484: VoIP QOS Configurative Page Settings

SettingsField

Enter 104.Call Control QOS Byte

Enter 184.RTP QOS Byte

Step 81 Select Submit.
Step 82 On the Configuration menu, select IP.
Step 83 On the IP Settings page, enter the following settings.

Table 485: IP Settings Page Settings

SettingsField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

Step 84 Select Submit.
Step 85 On the Configure menu, select Tone Detection.
Step 86 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select Busy and do the

following substeps to verify that the tone is correct.
a) From an available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
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c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.

Step 87 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 86c. from the
third phone.

Step 88 Select Learn.
Step 89 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 90 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 89a.
Step 91 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, selectRingback and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 92 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 91a.
Step 93 Select Learn.
Step 94 Select Submit.
Step 95 Hang up the phones that you used in Step 86.
Step 96 On the Configure menu, select Restart.
Step 97 On the Restart page, select Restart Unit Now.
Step 98 Repeat Step 2 through Step 97 on all remaining PIMG units.

Creating New Integration with Siemens Hipath 4000 Phone System
After ensuring that the Siemens Hipath 4000 phone system, the PIMG units, and Unity Connection are ready
for the integration, do the following procedure to set up the integration and to enter the port settings.

Creating an Integration

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Under Message Waiting Indicator Settings, selectUse Same Port for Enabling and Disabling MWIs.
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Step 6 Select Save.
Step 7 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 8 On the New Port Group page, enter the applicable settings and select Save.

Table 486: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the PIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name

Enter the SIP port of the PIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the TCP/UDP Server
Port field on the Configuration > VoIP > General page of
the PIMG unit. Otherwise, the integration cannot function
correctly.

Port

Step 9 On the Port Group Basics page, under Message Waiting Indicator Settings, uncheck the Enable Message Waiting
Indicators check box and select Save.

Step 10 In the Related Links drop-down box, select Add Ports and select Go.
Step 11 On the New Port page, enter the following settings and select Save.

Table 487: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled
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ConsiderationsField

Enter 8.

(If you want to use fewer than eight voice messaging ports,
enter the number of voice messaging ports that you want
to use on this PIMG unit.)

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the PIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 8.Port Group

Step 12 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 13 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.

Table 488: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification
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ConsiderationsField

(Serial integrations only) Uncheck this check box.
Otherwise, the integration may not function correctly.

(Digital and analog integrations only) Check this check
box to designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 14 Select Save.
Step 15 Select Next.
Step 16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.
Step 17 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 18 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 19 Repeat Step 7 through Step 18 for each remaining PIMG unit integrated with Unity Connection.

Each PIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses five PIMG units requires five port groups, one port group for each PIMG unit.

Note

Step 20 To create a port group for MWIs, do the following substeps.

All MWI requests are handled by the master PIMG unit and sent to the phone system over the RS-232 serial
cable (without using voice messaging ports). So the following substeps create a separate port group without
voice messaging ports and enable the port group for MWIs that are "not port specific" (they do not use ports).

Note

a) In Cisco Unity Connection Administration expand Telephony Integration then select Port Group .
b) On the Search Port Groups page, select Add New.
c) On the New Port Group page, enter the applicable settings and select Save.

Table 489: Settings for the New Port Group Page (MWIs)

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG SIP to in the drop-down box.

Create From
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SettingField

Enter aMWI Port Group or another descriptive name
for the port group.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the master PIMG unit.IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported
for PIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the master PIMG unit.IP Address or Host Name

Enter the SIP port of the master PIMG unit.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
PIMG unit. Otherwise, the integration cannot
function correctly.

Caution

Port

d) On the Port Group Basics page, on the Edit menu, select Advanced Settings.
e) On the Edit Advanced Settings page, under SIP MWI Requests, select Not Port Specific then select Save.
f) On the Edit menu, select Port Group Basics.
g) Under Port Group, select Reset.
h) Under Message Waiting Indicator Settings, confirm that the Enable Message Waiting Indicator check box is

checked and select Save.

Step 21 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 25.

Step 22 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 23 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

Table 490: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 24 Repeat Step 22 and Step 23 for all remaining phone system trunks that you want to create.
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Step 25 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone
system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 26 In the Task Execution Results window, select Close.
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C H A P T E R 18
Testing the Integration

To test whether Cisco Unity Connection and the phone system are integrated correctly, do the following
procedures in the order listed.

If any of the steps indicate a failure, see the following documentation as applicable:

• The installation guide for the phone system.
• Troubleshooting Guide for Cisco Unity Connection, Release 12.x, available at https://www.cisco.com/
c/en/us/td/docs/voice_ip_comm/connection/12x/troubleshooting/guide/b_12xcuctsg.html.

• The setup information earlier in this guide.

• Testing the Integration, on page 401

Testing the Integration

Introduction
To test whether Cisco Unity Connection and the phone system are integrated correctly, do the following
procedures in the order listed.

If any of the steps indicate a failure, see the following documentation as applicable:

• The installation guide for the phone system.

• Troubleshooting Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/troubleshooting/guide/b_12xcuctsg.html.

• The setup information earlier in this guide.

Setting Up the Test Configuration

SUMMARY STEPS

1. Set up two test extensions (Phone 1 and Phone 2) on the same phone system that Unity Connection is
connected to.

2. Set Phone 1 to forward calls to the Unity Connection pilot number when calls are not answered.
3. In Cisco Unity Connection Administration, expand Users, then select Users.
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4. On the Search Users page, select the display name of a user to use for testing. The extension for this
user must be the extension for Phone 1.

5. On the Edit User Basics page, uncheck the Set for Self-enrollment at Next Login check box.
6. In the Voice Name field, record a recorded name for the test user.
7. Select Save.
8. On the Edit menu, selectMessage Waiting Indicators.
9. On the Message Waiting Indicators page, select the message waiting indicator. If no message waiting

indication is in the table, select Add New.
10. On the Edit Message Waiting Indicator page, enter the following settings.
11. Select Save.
12. On the Edit menu, select Transfer Options.
13. On the Transfer Options page, select the active option.
14. On the Edit Transfer Option page, under Transfer Action, select the Extension option and enter the

extension of Phone 1.
15. In the Transfer Type field, select Release to Switch.
16. Select Save.
17. Minimize the Cisco Unity Connection Administration window.
18. Sign in to the Cisco Unified Real-Time Monitoring Tool (RTMT).
19. On the Unity Connection menu, select Port Monitor. The Port Monitor tool appears in the right pane.
20. In the right pane, select Start Polling. The Port Monitor displays which port is handling the calls that

you make.

DETAILED STEPS

Step 1 Set up two test extensions (Phone 1 and Phone 2) on the same phone system that Unity Connection is connected to.
Step 2 Set Phone 1 to forward calls to the Unity Connection pilot number when calls are not answered.

The phone system must forward calls to the Unity Connection pilot number in no fewer than four rings. Otherwise, the
test may fail.

Step 3 In Cisco Unity Connection Administration, expand Users, then select Users.
Step 4 On the Search Users page, select the display name of a user to use for testing. The extension for this user must be the

extension for Phone 1.
Step 5 On the Edit User Basics page, uncheck the Set for Self-enrollment at Next Login check box.
Step 6 In the Voice Name field, record a recorded name for the test user.
Step 7 Select Save.
Step 8 On the Edit menu, selectMessage Waiting Indicators.
Step 9 On the Message Waiting Indicators page, select the message waiting indicator. If no message waiting indication is in

the table, select Add New.
Step 10 On the Edit Message Waiting Indicator page, enter the following settings.

Table 491: Settings for the Edit MWI Page

SettingField

Check this check box to enable MWIs for the test user.Enabled
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SettingField

Accept the default or enter a different name.Display Name

Check this check box to enable MWIs on Phone 1.Inherit User’s Extension

Step 11 Select Save.
Step 12 On the Edit menu, select Transfer Options.
Step 13 On the Transfer Options page, select the active option.
Step 14 On the Edit Transfer Option page, under Transfer Action, select theExtension option and enter the extension of Phone 1.
Step 15 In the Transfer Type field, select Release to Switch.
Step 16 Select Save.
Step 17 Minimize the Cisco Unity Connection Administration window.

Do not close the Cisco Unity Connection Administration window because you use it again in a later procedure.

Step 18 Sign in to the Cisco Unified Real-Time Monitoring Tool (RTMT).
Step 19 On the Unity Connection menu, select Port Monitor. The Port Monitor tool appears in the right pane.
Step 20 In the right pane, select Start Polling. The Port Monitor displays which port is handling the calls that you make.

Testing an External Call with Release Transfer

SUMMARY STEPS

1. From Phone 2, enter the access code necessary to get an outside line, then enter the number outside
callers use to dial directly to Unity Connection.

2. In the Port Monitor, note which port handles this call.
3. When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting

means that the port is configured correctly.
4. Confirm that Phone 1 rings and that you hear a ringback tone on Phone 2. Hearing a ringback tone

means that Unity Connection correctly released the call and transferred it to Phone 1.
5. Leaving Phone 1 unanswered, confirm that the state of the port handling the call changes to “Idle.” This

state means that release transfer is successful.
6. Confirm that, after the number of rings that the phone system is set to wait, the call is forwarded to

Unity Connection and that you hear the greeting for the test user. Hearing the greeting means that the
phone system forwarded the unanswered call and the call-forward information to Unity Connection,
which correctly interpreted the information.

7. On the Port Monitor, note which port handles this call.
8. Leave a message for the test user and hang up Phone 2.
9. In the Port Monitor, confirm that the state of the port handling the call changes to “Idle.” This state

means that the port was successfully released when the call ended.
10. Confirm that the MWI on Phone 1 is activated. The activated MWI means that the phone system and

Unity Connection are successfully integrated for turning on MWIs.
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DETAILED STEPS

Step 1 From Phone 2, enter the access code necessary to get an outside line, then enter the number outside callers use to dial
directly to Unity Connection.

Step 2 In the Port Monitor, note which port handles this call.
Step 3 When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting means that the port

is configured correctly.
Step 4 Confirm that Phone 1 rings and that you hear a ringback tone on Phone 2. Hearing a ringback tone means that Unity

Connection correctly released the call and transferred it to Phone 1.
Step 5 Leaving Phone 1 unanswered, confirm that the state of the port handling the call changes to “Idle.” This state means

that release transfer is successful.
Step 6 Confirm that, after the number of rings that the phone system is set to wait, the call is forwarded to Unity Connection

and that you hear the greeting for the test user. Hearing the greeting means that the phone system forwarded the
unanswered call and the call-forward information to Unity Connection, which correctly interpreted the information.

Step 7 On the Port Monitor, note which port handles this call.
Step 8 Leave a message for the test user and hang up Phone 2.
Step 9 In the Port Monitor, confirm that the state of the port handling the call changes to “Idle.” This state means that the port

was successfully released when the call ended.
Step 10 Confirm that the MWI on Phone 1 is activated. The activated MWI means that the phone system and Unity Connection

are successfully integrated for turning on MWIs.

Testing Listening to Messages

SUMMARY STEPS

1. From Phone 1, enter the internal pilot number for Unity Connection.
2. When asked for your password, enter the password for the test user. Hearing the request for your password

means that the phone system sent the necessary call information to Unity Connection, which correctly
interpreted the information.

3. Confirm that you hear the recorded name for the test user (if you did not record a name for the test user,
you hear the extension number for Phone 1). Hearing the recorded name means that Unity Connection
correctly identified the user by the extension.

4. Listen to the message.
5. After listening to the message, delete the message.
6. Confirm that the MWI on Phone 1 is deactivated. The deactivated MWI means that the phone system and

Unity Connection are successfully integrated for turning off MWIs.
7. Hang up Phone 1.
8. On the Port Monitor, confirm that the state of the port handling the call changes to “Idle.” This state means

that the port was successfully released when the call ended.

DETAILED STEPS

Step 1 From Phone 1, enter the internal pilot number for Unity Connection.
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Step 2 When asked for your password, enter the password for the test user. Hearing the request for your password means that
the phone system sent the necessary call information to Unity Connection, which correctly interpreted the information.

Step 3 Confirm that you hear the recorded name for the test user (if you did not record a name for the test user, you hear the
extension number for Phone 1). Hearing the recorded name means that Unity Connection correctly identified the user by
the extension.

Step 4 Listen to the message.
Step 5 After listening to the message, delete the message.
Step 6 Confirm that theMWI on Phone 1 is deactivated. The deactivatedMWImeans that the phone system andUnity Connection

are successfully integrated for turning off MWIs.
Step 7 Hang up Phone 1.
Step 8 On the Port Monitor, confirm that the state of the port handling the call changes to “Idle.” This state means that the port

was successfully released when the call ended.

Setting Up Supervised Transfer on Unity Connection

SUMMARY STEPS

1. In Cisco Unity Connection Administration, on the Edit Transfer Option page for the test user, in the
Transfer Type field, select Supervise Transfer.

2. In the Rings to Wait For field, enter 3.
3. Select Save.
4. Minimize the Cisco Unity Connection Administration window.

DETAILED STEPS

Step 1 In Cisco Unity Connection Administration, on the Edit Transfer Option page for the test user, in the Transfer Type field,
select Supervise Transfer.

Step 2 In the Rings to Wait For field, enter 3.
Step 3 Select Save.
Step 4 Minimize the Cisco Unity Connection Administration window.

Do not close the Cisco Unity Connection Administration window because you use it again in a later procedure.

Testing Supervised Transfer

SUMMARY STEPS

1. From Phone 2, enter the access code necessary to get an outside line, then enter the number outside
callers use to dial directly to Unity Connection.

2. On the Port Monitor, note which port handles this call.
3. When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting

means that the port is configured correctly.
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4. Confirm that Phone 1 rings and that you do not hear a ringback tone on Phone 2. Instead, you should
hear the indication your phone system uses to mean that the call is on hold (for example, music).

5. Leaving Phone 1 unanswered, confirm that the state of the port handling the call remains “Busy.” This
state and hearing an indication that you are on hold mean that Unity Connection is supervising the
transfer.

6. Confirm that, after three rings, you hear the greeting for the test user. Hearing the greeting means that
Cisco Unity Connection successfully recalled the supervised-transfer call.

7. During the greeting, hang up Phone 2.
8. On the Port Monitor, confirm that the state of the port handling the call changes to “Idle.” This state

means that the port was successfully released when the call ended.
9. Select Stop Polling.
10. Exit RTMT.

DETAILED STEPS

Step 1 From Phone 2, enter the access code necessary to get an outside line, then enter the number outside callers use to dial
directly to Unity Connection.

Step 2 On the Port Monitor, note which port handles this call.
Step 3 When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting means that the port

is configured correctly.
Step 4 Confirm that Phone 1 rings and that you do not hear a ringback tone on Phone 2. Instead, you should hear the indication

your phone system uses to mean that the call is on hold (for example, music).
Step 5 Leaving Phone 1 unanswered, confirm that the state of the port handling the call remains “Busy.” This state and hearing

an indication that you are on hold mean that Unity Connection is supervising the transfer.
Step 6 Confirm that, after three rings, you hear the greeting for the test user. Hearing the greeting means that Cisco Unity

Connection successfully recalled the supervised-transfer call.
Step 7 During the greeting, hang up Phone 2.
Step 8 On the Port Monitor, confirm that the state of the port handling the call changes to “Idle.” This state means that the

port was successfully released when the call ended.
Step 9 Select Stop Polling.
Step 10 Exit RTMT.
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C H A P T E R 19
Adding New User Templates for Multiple
Integrations

• Adding New User Templates for Multiple Integrations, on page 407

Adding New User Templates for Multiple Integrations

Introduction
When you create the first phone system integration, this first phone system is automatically selected in the
default user template. The users that you add after creating this phone system integration are assigned to this
phone system by default.

However, for each additional phone system integration that you create, you must add the applicable new user
templates that assign users to the new phone system. You must add the new templates before you add new
users who are assigned to the new phone system.

For details on adding new user templates, or on selecting a user template when adding a new user, see the
“User Templates” section of the “User Attributes” chapter of the System Administration Guide for Cisco Unity
Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/administration/guide/b_12xcucsag.html.
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A P P E N D I X A
Adding a Secondary Master PIMG Unit

Because the master PIMG unit processes all call information andMWI requests for the system, the integration
loses important functionality if the master PIMG unit stops working. If you want to minimize this risk, you
can add a secondarymaster PIMG unit to process call information andMWI requests when the primarymaster
PIMG unit is no longer functioning.

During normal operation, the primary master PIMG unit is connected to power and is functioning, while the
secondary master PIMG unit is not connected to power and is not functioning. To activate the secondary
master PIMG unit, you must disconnect power to the primary master PIMG unit, then connect power to the
secondary master PIMG unit.

The following task list describes the process for adding a secondary master PIMG unit.

• Adding a Secondary Master PIMG Unit, on page 409

Adding a Secondary Master PIMG Unit
Because the master PIMG unit processes all call information andMWI requests for the system, the integration
loses important functionality if the master PIMG unit stops working. If you want to minimize this risk, you
can add a secondarymaster PIMG unit to process call information andMWI requests when the primarymaster
PIMG unit is no longer functioning.

During normal operation, the primary master PIMG unit is connected to power and is functioning, while the
secondary master PIMG unit is not connected to power and is not functioning. To activate the secondary
master PIMG unit, you must disconnect power to the primary master PIMG unit, then connect power to the
secondary master PIMG unit.

The following task list describes the process for adding a secondary master PIMG unit.

Task List to Add a Secondary Master PIMG Unit
Use the following task list to add a secondary master PIMG unit.

1. Set up the analog voice line connections to the master PIMG units. See the Analog Voice Line Connections
for the Master PIMG Units.

2. Set up the serial data cable connections to the master PIMG units. See the Serial Data Cable Connections
for the Master PIMG Units.

3. Configure the secondary master PIMG unit. See the Configuring the Secondary Master PIMG Unit.
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Analog Voice Line Connections for the Master PIMG Units
Circuit-switched phone systems typically have 25-pair or 32-pair cables to provide analog voice connections.
It is common that the cable is broken into individual lines that may attach to a punchdown cross-connect block
(for example, 66-Type), or the cable may terminate with RJ-11 or RJ-14 connectors to accept analog voice
lines.

A punchdown cross-connect block or line splitters may be used to split the analog lines. It is possible to use
these devices in combination to manage and split the lines.

No devices other than those described in this appendix should be connected to the analog voice lines for any
voice messaging port on the master PIMG units. Otherwise, the ring equivalency number (REN) may be
exceeded and the primary and secondary servers may not receive sufficient ring current to answer calls.

Note

Requirements
The following components are required for common configurations:

• Two or three analog voice patch cables for each port on the phone system.

• The applicable device to split the analog lines:

• One or more punchdown cross-connect blocks (for example, 66-Type), installed and ready to accept
lines.

• One line splitter for every one or two ports on the phone system. The line splitter accepts both RJ-11
and RJ-14 connectors.

• The applicable connectors (RJ-11 and/or RJ-14) for the analog voice lines. Figure A-1 shows the pinout
for the RJ-11 connector, and Figure A-2 shows the pinout for the RJ-14 connector.

Figure 4: Figure A-1 RJ-11 Connector Pinout
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Figure 5: Figure A-2 RJ-14 Connector Pinout

Connections Using RJ-11 Connectors
The following figures illustrate common configurations:

• Figure A-3 shows the connections between a phone system and the primary and secondary master PIMG
units, through a punchdown cross-connect block.

• Figure A-4 shows the connections between a phone system with an RJ-11 connector and the primary
and secondary master PIMG units.

• Figure A-5 shows the connections between a phone system with an RJ-14 connector and the primary
and secondary master PIMG units.

Figure 6: Figure A-3 Connections from the Phone System Through a Punchdown Block
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Figure 7: Figure A-4 Connections for an RJ-11 Connector from the Phone System

Figure 8: Figure A-5 Connections for an RJ-11 Connector from the Phone System

Serial Data Cable Connections for the Master PIMG Units
Connecting the RS-232 serial cables between a circuit-switched phone system and the primary and secondary
master PIMG varies depending on the number of serial ports the phone system has.

Requirements
The following components are required for phone systems with only one serial port:

• Three RS-232 serial cables

• Data splitter unit

The following components are required for phone systems with multiple serial ports:
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• Two RS-232 serial cables

Connections for the Serial Data Cables
Figure A-6 shows the connections between the serial port on a phone system that has only one serial port to
the serial ports on the primary and secondary master PIMG units. Figure A-6 shows the connections between
the serial ports on a phone system that has two serial ports to the serial ports on the master PIMG units.

Note that the following figures do not show the analog voice lines, which are described in the Analog Voice
Line Connections for the Master PIMG Units.
Figure 9: Figure A-6 Serial Cable Connections from a Single Serial Port on the Phone System to the Serial Ports on the Master PIMG
Units

Figure 10: Figure A-7 Serial Cable Connections from Multiple Serial Ports on the Phone System to the Serial Ports on the Master PIMG
Units

Configuring the Secondary Master PIMG Unit
This procedure has the following requirements:

• All analog lines and serial cables must be correctly connected.

• The primary secondary master PIMG units must have the same firmware version installed.

• The primary master PIMG unit is connected to power, while the secondary master PIMG unit is
disconnected from power.

• You have a Windows workstation that has access to the PIMG units.

Do the following procedure to make the configuration of the secondary master PIMG unit match the
configuration of the primary master PIMG unit.

Configuring the Secondary Master PIMG Unit

SUMMARY STEPS

1. On a Windows workstation, in a web browser, sign in to the primary master PIMG unit.
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2. On the Configuration menu, select Import/Export.
3. On the Import/Export page, under Export Files, select Export All Settings.
4. In the File Download dialog box, select Save.
5. In the Save As dialog box, browse to the Windows workstation, browse to a directory where you want

to save the file, and select Save.
6. Exit the PIMG web interface.
7. Disconnect power from the primary master PIMG unit.
8. Connect power to the secondary master PIMG unit.
9. On the Windows workstation, in a web browser, sign in the secondary master PIMG unit by entering

the following case-sensitive settings.
10. Select OK.
11. On the Configuration menu of the secondary master PIMG unit, select Import/Export.
12. On the Import/Export page, under Import File, select Browse.
13. In the Choose File dialog box, browse to the file Config.ini that you saved from the primary master

PIMG unit in Step 5.
14. Select Config.ini, and select Open.
15. On the Import/Export page, select Import File.
16. When prompted to restart the PIMG unit, select OK.
17. Disconnect power from the secondary master PIMG unit.
18. Connect power to the primary master PIMG unit.

DETAILED STEPS

Step 1 On a Windows workstation, in a web browser, sign in to the primary master PIMG unit.
Step 2 On the Configuration menu, select Import/Export.
Step 3 On the Import/Export page, under Export Files, select Export All Settings.
Step 4 In the File Download dialog box, select Save.
Step 5 In the Save As dialog box, browse to the Windows workstation, browse to a directory where you want to save the file,

and select Save.
Step 6 Exit the PIMG web interface.
Step 7 Disconnect power from the primary master PIMG unit.
Step 8 Connect power to the secondary master PIMG unit.
Step 9 On the Windows workstation, in a web browser, sign in the secondary master PIMG unit by entering the following

case-sensitive settings.

Table 492: Default Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 10 Select OK.
Step 11 On the Configuration menu of the secondary master PIMG unit, select Import/Export.
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Step 12 On the Import/Export page, under Import File, select Browse.
Step 13 In the Choose File dialog box, browse to the file Config.ini that you saved from the primary master PIMG unit in Step 5.
Step 14 Select Config.ini, and select Open.
Step 15 On the Import/Export page, select Import File.
Step 16 When prompted to restart the PIMG unit, select OK.
Step 17 Disconnect power from the secondary master PIMG unit.
Step 18 Connect power to the primary master PIMG unit.
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A P P E N D I X B
Application Note for the Ericsson MD-110 Serial
PIMG Integration

This is an application note for programming the EricssonMD-110 phone system for a serialMD-110 integration
with Cisco Unity Connection using analog PIMG units. For instructions on setting up the PIMG units and
creating the integration in Unity Connection, see the Setting Up a Serial (SMDI, MCI, or MD-110) PIMG
Integration with Cisco Unity Connection , on page 249 chapter.

• Application Note for the Ericsson MD-110 Serial PIMG Integration, on page 417

Application Note for the Ericsson MD-110 Serial PIMG
Integration

Introduction
This is an application note for programming the EricssonMD-110 phone system for a serialMD-110 integration
with Cisco Unity Connection using analog PIMG units. For instructions on setting up the PIMG units and
creating the integration in Unity Connection, see the Setting Up a Serial (SMDI, MCI, or MD-110) PIMG
Integration with Cisco Unity Connection , on page 249chapter.

Network Topology
Figure B-1 shows the required connections for a serial MD-110 integration using analog PIMG units.

For more information about this integration, see Chapter 1, “Introduction.”
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Figure 11: Figure B-1 Connections for a Serial MD-110 Integration by Using Analog PIMG Units

Requirements
The Ericsson MD-110 phone system met the following requirements:

• The Ericsson MD-110 phone system.

• Software level BC6 or later.

Programming Ericsson MD-110 Phone System for Serial Integration
The following programming instructions are provided as an example of a functioning integration. The specific
programming for your phone system may vary depending on its configuration.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Perform Message Notification, do not send calls to it.

Caution

1. Check the software version on the phone system and the country variant that is configured. This
information may be useful for troubleshooting problems with the integration. For example:

<cadap; ==> Check the software version and Country variant
CALENDAR DATA

IDENTITY=ACM1
VERSION=CXP1010101/4/TSWSP02/R3A ==> 01 == Standard Application

2. Configure the analog extensions for the voice messaging ports similarly to the following example:

<excap:dir=1063&1064; ==> print analog extension
EXTENSION CATEGORY FIELDS

DIR TRAF SERV CDIV ROC TRM ADC BSEC
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1063 00151515 0201120600 000151000 000001 0 010001701 0
1064 00151515 0201120600 000151000 000001 0 010001701 0

3. Configure the hunt group number for the voice messaging ports on the PIMG units similarly to the
following example:

<vmpop:grp=all; ==> print VM HuntGroup number
VOICE MAIL GROUP DATA
GRP IFCIND
4500 1

4. Associate the voice messaging port extensions with the hunt group number similarly to the following
example:

<vmpop:dir=all; ==> print VM port DN associated with the HuntGroup
number
VOICE MAIL PORT DATA
DIR PORT IFCIND
1063 1063 1
1064 1064 1

5. Configure the voice mail function information similarly to the following:

<vmfup:ifcind=1; ==> print VM function information
VOICE MAIL FUNCTION DATA
IFCIND VMF POFMT
1 EXTN3 4

6. Configure the I/O device interface for voice mail similarly to the following:

<ioddp; ==> print I/O Device interface
I/O DEVICE DATA
NODE IODEV/SUBFS BPOS/EQU I/O-BUS TYPE/USAGE STATUS AUTH
SYSN V-MAIL 001-0-60-3 - OUT IN SERVICE

7. Configure the I/O device function for voice mail similarly to the following example:

<iofdp; ==> print I/O Device Function
I/O FUNCTIONS DEFINITION
IODEV TRD NDC CALLS WAIT DELAY SUPER
V-MAIL BOTH 2 30 5 YES

8. Configure the serial connection parameters for voice mail similarly to the following example:

<ioifp; ==> print I/O Device serial interface parameters VM
I/O INTERFACE CHARACTERISTICS
IODEV IFACE BAUDR WORDL PARITY STPBIT PROC
SYSTERMINAL V24 ALL 8 NONE 1 ECHO
V-MAIL V24 9600 8 NONE 1 ECHO

9. Configure MWIs to be sent over the serial cable similarly to the following example:

<icmwp:sid=1; ==> print MWI ext using on serial interface
INFORMATION COMPUTER MESSAGE WAITING DATA
SID DTXT KFCN DIG
1 4500 MWC 4500

10. Configure the filler information similarly to the following example:

PIMG Integration Guide for Cisco Unity Connection Release 12.X
419

Application Note for the Ericsson MD-110 Serial PIMG Integration
Application Note for the Ericsson MD-110 Serial PIMG Integration



<ICFUP:ifcind=1; ==> print the filler information
INFORMATION COMPUTER COMMON FUNCTIONS DATA

MESSAGE WAITING FUNCTIONALITY IS ALL

INFORMATION COMPUTER EQUIPMENT DATA

IFCIND IODEV EQU RATE DFMT UPDFCN PARITY CCHECK
1 V-MAIL 4 YES

FILLER=48 ICEXG=NONE USER=NONE

11. Configure the hookflash timer similarly to the following example:

<aspap:parnum=253; ==> print Hookflash timer
APPLICATION SYSTEM PARAMETERS
PARNUM PARVAL

253 110

12. Configure the on-hook timer similarly to the following example:

<aspap:parnum=252; ==> print On-hook timer
APPLICATION SYSTEM PARAMETERS
PARNUM PARVAL

252 225
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A P P E N D I X C
Application Note for the Nortel SL-100 Serial
SMDI TIMG Integration

This is an application note for programming the Nortel SL-100 phone system for a serial SMDI integration
with Cisco Unity Connection using TIMG units. For instructions on setting up analog PIMG units and creating
the serial PIMG integration in Unity Connection, see the Setting Up a Serial (SMDI, MCI, or MD-110) PIMG
Integration with Cisco Unity Connection , on page 249 chapter.

• Application Note for the Nortel SL-100 Serial SMDI TIMG Integration, on page 421

Application Note for the Nortel SL-100 Serial SMDI TIMG
Integration

Introduction
This is an application note for programming the Nortel SL-100 phone system for a serial SMDI integration
with Cisco Unity Connection using TIMG units. For instructions on setting up analog PIMG units and creating
the serial PIMG integration in Unity Connection, see the "Setting Up a Serial (SMDI, MCI, or MD-110) PIMG
Integration with Cisco Unity Connection " chapter.

Network Topology
Figure C-1 shows the required connections for a serial SMDI integration using TIMG units.

For more information about this integration, see the chapterIntroduction, on page 1.
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Figure 12: Figure C-1 Connections for a Serial SMDI Integration Using TIMG Units

Requirements
The phone system was as follows:

• Nortel SL-100.

• Software version SE-06 or later.

• Line Side T1 Card (NT5D11 or equivalent) to terminate the T1 line.

Programming Nortel SL-100 Phone System for Serial Integration
The following programming instructions are provided as an example of a functioning integration. The specific
programming for your phone system may vary depending on its configuration.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Perform Message Notification, do not send calls to it.

1. On the MAP terminal, enter table mpc and press Enter.

2. Enter add and press Enter.

3. On Table MPC, enter the following settings.

Caution

Table 493: Settings for Table MPC

SettingField

Enter the MPC number used for SMDI.MPCNO
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SettingField

Enter the number associated with the MPC (SMDI)
card.

MPCIOC

Enter the slot position on the IOC shelf multiplied by
4, from 0 to 32.

IOCCCT

Enter the NT product engineering code for the MPC
card in the format 1X89zz or FX30zz, where zz are
the two letters at the end of the product code.

EQ

In the format MPCAxxyy, enter the name of the
8-character download file for SMDI and MPCA.

DLDFILE

1. Enter table mpclink and press Enter.

2. Enter add and press Enter.

3. On Table MPCLINK, enter the following settings.

Table 494: Settings for Table MPCLINK

SettingSubfieldField

Enter the MPC number used for
SMDI (the same number entered in
Table MPC).

MPCNOLINKKEY

Enter the MPC link number for
SMDI application with ASYNC
protocol.

LINKNO

Enter Y to activate the MPCLINK
alarm for system busy (SYSB)
MPC links. Enter N if you do not
want to activate the MPCLINK
alarm for system busy (SYSB)
MPC links.

If you enter N, the
system does not
generateMPC908 (MPC
link state transition)
logs.

Note

LINKALM

Enter ASYNC.PROTOCOL

Enter 765.LINKNABL

Enter APLDEFN.PARM

Enter SMDI.ADEFN
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SettingSubfieldField

Enter BAUDRATE.PARM

Enter B9600.RATE

Enter PARITY.PARM

Enter EVEN.PRTY

The following are among the
optional parameters: L1IDLY,
L2IDLY, LNKDOWN. If you enter
a parameter, you are then prompted
to enter a value for it.

L1IDLY and L2IDLY timers can
be used in offices with heavy
SMDI/VMS traffic to shorten the
amount of time the MPC can delay
sending anMWI to the switch. (The
default is 3 seconds.)

The LNKDOWN timer adjusts the
length of time the switch takes to
recognize LINK failure and sets the
LINK to SYSB. (The default is 2
seconds.)

PARM

Enter BIT7.CHARBITS

1. Enter table sllnkdev and press Enter.

2. Enter add and press Enter.

3. On Table SLLNKDEV, enter the following settings.

Table 495: Settings for Table SLLNKDEV

SettingField

Enter a unique device name.DEVNAME

Enter 1X89.DEVICE

Enter the value MPC number that was specified in
Table MPC.

MPCNO

Enter the value for the MPC link number that was
specified in Table MPCLINK.

LINKNO

Enter NONE.XLATION

Enter NONE.PROTOCOL
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SettingField

Enter INOUTLK.DIRECTION

Enter SMDIDATA.XFER

Enter NUMOFDIGS.OPTION

Enter the number of digits sent by the phone system
to the voice messaging system through the SMDI link.

The entry value selected should match the
dialing plan configured on the phone
system.

Note

NUMDIGS

Enter CGNADDRDN.OPTION

Enter $.OPTION

1. Enter table ofrt and press Enter.

You use Table OFRT to set up a treatment for unanswered calls. The following example shows settings for
routing unanswered calls back to the voice messaging system.

1. Enter add and press Enter.

2. On Table OFRT, enter the following settings.

Table 496: Settings for Table OFRT

SettingField

If the record is the first in the route list, enter the route
reference number assigned to the route list. Otherwise,
leave this field blank.

RTE

Enter the route selector.RTESEL

Enter the serving NPA (area code) of the DN.SNPA

Enter the type of call:

• DD

• NP

• OA

TYPCALL

Enter LCL (for local) or NLCL (for non-local).ORIGSCRE

Enter up to 11 replace digits.REPLDIGS

Enter Y or N to indicate whether to cancel normal
change.

CANCNORC
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SettingField

Enter the billing code. If there is no billing number,
enter N.

BILLCODE

1. Enter table digcol and press Enter.

You use Table DIGCOL to set up the action that the line module must take with the first digit that is dialed.

1. Enter add and press Enter.

2. On Table DIGCOL, enter the following settings.

Table 497: Settings for Table DIGCOL

SettingSubfieldField

Enter the character assigned to the
block of data in Table DIGCOL.

DATNAMEDGKEY

Enter a numeric value from 0–9,
STAR (*), or OCT (#) to specify
the digit that is applicable to the
record.

DIGIT

Enter COL for the collection of
more digits.

DGCOLSELDGDATA

Enter S for short timing mode.TMODECOLDATA

Number of digits. If the TMODE
value is S, specify the number of
digits for which short timing is
required after the receipt of each
digit. The number of digits
specified, which does not include
the initial digit, must be no greater
than three for short timing.

NUMDIGS

1. Enter table ucdgroup and press Enter.

You use Table UCDGRP to set up the UCD group.

The UCD group must have a unique primary DN.

1. Enter add and press Enter.

2. On Table UCDGRP, enter the following settings.

Note
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Table 498: Settings for Table UCDGRP

SettingField

This is the name of the UCD group. It can be up to
16 characters in length. The first eight characters must
be unique.

UCDNAME

Enter N.ACD

Name of the customer group to which the UCD group
belongs.

CUSTGRP

Ringing threshold, in one-second intervals, after which
an unanswered call to a UCD agent is forwarded to
the route specified in the THROUT field. The range
is 0–63.

UCDRNGTH

Enter OFRT.TABNAME

Enter the number assigned to the route list in Table
OFRT (1–1023).

INDEX

Enter OFRT for the table to which translations are
routed.

TABNAME

Enter the number assigned to the route list in Table
OFRT (1–1023).

INDEX

Enter Maximum time, in seconds, a call can wait in
a UCD group (0–255).

PRIOPRO

Enter the maximum number of UCD agent positions
that can be active at one time. This number should be
the number of ports on the all TIMG units that are
connected to the phone system.

MAXPOS

Delayed billing. EnterY if billing starts when the call
is answered by a UCD agent. Enter N if billing starts
when the caller receives a recorded announcement.

DBG

Enter 0.DEFPRIO

Enter 0.RLSCNT

Enter the maximum time, in seconds, that a call waits
in the incoming call queue before being answered
(0–1800).

MAXWAIT

Enter the maximum number of calls that can be in the
incoming queue waiting for an idle channel (0–511).

MAXCQSIZ

Enter UCD_SMDI.OPTION

PIMG Integration Guide for Cisco Unity Connection Release 12.X
427

Application Note for the Nortel SL-100 Serial SMDI TIMG Integration
Application Note for the Nortel SL-100 Serial SMDI TIMG Integration



SettingField

Enter the terminal designation defined in Table
SLLNKDEV.

SMDI_LINK

Enter the message desk number (1–63). If you have
more than one UCD group, one of them must be set
to 63. We recommend that the first UCD group on a
data link be set to 63. The second is set to 62, and so
on.

If CRR (Call Request Retrieval) is used,
all requests are made to the UCD group
with SMDI_DSK_NO = 63.

Note

SMDI_ DESK_NO

1. Enter table dnroute and press Enter.

You use Table DNROUTE to set up the UCD group.

The UCD group must have a unique primary DN.

1. Enter add and press Enter.

2. On Table DNROUTE, enter the following settings.

Note

Table 499: Settings for Table DNROUTE

SettingSubfieldField

Enter the DN for the UCD group
specified as the UCDGRP.

The UCD DNmust be a
dialable number from an
agent on the phone
system so that dialing
plans and translation
tables do not conflict.

Note

AREACODEDNNM

OFCCODE

STNCODE

Enter FEAT.DN_SEL

Enter UCD.FEATURE

Enter the value for the UCDNAME
field that is defined in Table
UCDGROUP.

UCDGRP

Enter PRIM.DNTYPE

Enter 0.TOLLPRIO
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1. Enter table lninv and press Enter.

You use Table LNINV to assign card slots on the line or remote line module.

1. Enter add and press Enter.

2. On Table LNINV, enter the following settings.

Table 500: Settings for Table LNINV

SettingField

Enter the line equipment number of the card slot.LEN

Enter 5d11ae.CARDCODE

Enter the name of the appropriate pad group that
appears in the PADDATA table.

PADGRP

EnterWORKING.STATUS

Enter Y.GND

Enter NL.BNV

Enter Y.MNO

Enter NIL.CARDTYPE

1. Enter servord and press Enter.

You can add agents to the UCD group by entering the following inputs at the prompts.

Table 501: Inputs for Adding Agents to the UCD Group

DescriptionInputPrompt

NEWSO:

When to invoke this service.
Pressing Enter starts the service at
the current date and time.

Press Enter.SONUMBER:

The Directory Number of the line.
Use ten-digit DNs.

DN:

The line class code of service.IBNLCC_ACC:

The name of the IBN customer
group to which the line belongs.
For example, covm.

GROUP:

The subgroup number. For
example, 0.

SUBGRP:
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DescriptionInputPrompt

The network class of service. For
example, 1.

NCOS:

The serving NPA (area code) of the
DN.

SNPA:

The line equipment number of the
line. For example, 4 0 1 0
(separated by spaces).

LEN_OR_LT D:

The cut-off on disconnect.CODOPTION:

Uniform call distribution.UCDOPTION:

Digitone.DGTOPTION:

Three-way calling.3WCOPTION:

Call Transfer.CXROPTION:

Call Transfer Type. CTALL =
transfer all calls.

CTALLCXFERTYP:

Call Transfer Recall.NCXRRCL:

Method of Call Transfer: Std = Std
Call Transfer method.

STDMETHOD:

Simplified message desk interface.SMDIOPTION:

The UCD terminal number. This is
the line number associated with the
SMDI channel. This parameter
must be unique for each agent in
the associated UCDGRP.

LINENO:

The UCDNAME from the
UCDGRP table. This is the UCD
group to which you are adding the
agent.

UCDGRP:

Autologon capability required.YAUTO_LOG:

The data you have entered appears.$OPTION:

Enter Y.Y

1. Enter servord and press Enter.

You can add a pilot number (UCD group DN) for the ports on the TIMG units by entering the following inputs
at the prompts.
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Table 502: Inputs for Adding Agents to the UCD Group

DescriptionInputPrompt

NEWSO:

When to invoke this service.
Pressing Enter starts the service at
the current date and time.

Press Enter.SONUMBER:

The directory number of the line.
This is the DN that you enter in the
SDN table.

DN:

The line class code of service.IBNLCC:

The name of the IBN customer
group to which the line belongs.

GROUP:

The subgroup number.SUBGRP:

The network class of service.NCOS:

Serving NPA (area code) of the
DN.

SNPA:

Line equipment number of the line.
For example, 4 0 1 0.

LEN:

Call Forward Busy.

This input is optional.Note

cfbOPTION:

Normal assignment for CFB.

This input is optional.Note

NCFBCNTL:

The primary UCD DN.

This input is optional.Note

CFBDN:

Call Forward Fixed.CFFOPTION:

The primary UCD DN.CFFDN:

Call Forward Universal.CFUOPTION:

Override Automatic Callback.NOVRDACR:

The data you entered appears.$OPTION:

Enter Y to confirm the data.Y

1. Connect a phone to the line.

2. Pick up the handset.
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3. Dial the call forward activation code followed by the pilot number (UCD DN). For example, dial *80
5551234.

If you do not know this code, look it up in Table IBNXLA. The code is in the CFWP field.Note

4. Confirm that you hear the confirmation tone, which indicates that the line has been forwarded.

If the phone system is restarted, you must repeat Step 27. through Step 30. for each line DN that CFUs to the
UCD group.

Note

5. Enter table ibnxla and press Enter.

You use Table IBNXLA to set up and message waiting indicators (MWIs).

1. Enter add and press Enter.

2. On Table IBNXLA, enter the following settings.

Table 503: Settings for Table DNROUTE

SettingSubfieldField

Enter the name of the translator,
1–8 characters, for the MWI
feature.

XLANAMEKEY

Enter the access code for the MWI
feature.

DGLIDX

Enter FEAT.TRSELRESULT

Enter N.ACR

Enter N.SMDR

Enter the following features:

CRA CRR CRDS CRDA UCDD
UCDA CFWP CFWC

FEATURE
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A P P E N D I X D
Settings for PIMG Firmware Version 5.x

• Settings for PIMG Firmware Version 5.x, on page 433

Settings for PIMG Firmware Version 5.x

Digital PIMG Settings (Firmware Version 5.x)
Do the following steps to set up the Digital PIMG units

SUMMARY STEPS

1. On a Windows workstation, sign in to a PIMG unit.
2. In the Configure menu, select System.
3. On the System page, enter the following settings.
4. Select Apply Changes.
5. On the Configure menu, select Gateway.
6. On the Gateway page, select the Gateway Routing tab.
7. On the Gateway Routing tab, Unity Connection without a cluster, skip to Step 8. If Unity Connection

has a cluster configured, do the following substeps:
8. Under VoIP Endpoint ID, enter the following settings.
9. Select Apply Changes.
10. Select the Gateway Advanced tab.
11. On the Gateway Advanced tab, enter the following settings.
12. Select Apply Changes.
13. Select the Gateway Capabilities tab.
14. Depending on how you have planned to use the voice messaging ports, select the applicable setting for

each port in the Telephony Port Capability column.
15. Select Apply Changes.
16. On the Configure menu, select SIP.
17. On the SIP page, enter the following settings.
18. Select Apply Changes.
19. On the Configure menu, select IP.
20. On the IP page, enter the following settings.
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21. Select Apply Changes.
22. On the Configure menu, select Tones.
23. On the Tones page, select the Learn tab.
24. On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and

leave the Destination Address field blank.
25. On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and

do the following substeps to verify that the tone is correct.
26. On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed

in Step 25c. from the third phone.
27. On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is

checked and do the following substeps to verify that the tone is correct.
28. On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that

you dialed in Step 27a.
29. On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked

and do the following substeps to verify that the tone is correct.
30. On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you

dialed in Step 29a.
31. Select Learn.
32. When the process is complete, check the check box for each newly learned tone and select Apply.
33. Hang up the phones that you used in Step 25.
34. On the Configure menu, select Restart.
35. On the Restart page, select Restart Unit Now.
36. When the PIMG unit has restarted, in the View menu, select Refresh.
37. Repeat Step 1 through Step 36 on all remaining PIMG units.

DETAILED STEPS

Step 1 On a Windows workstation, sign in to a PIMG unit.
Step 2 In the Configure menu, select System.
Step 3 On the System page, enter the following settings.

Table 504: System Page Settings

SettingField

Select SIP.Operating Mode

Select the applicable setting:

• For Avaya phone systems, select Lucent.

• For NEC phone systems, select NEC_NEAX.

• For Nortel phone systems, selectM1.

• For Siemens phone systems, selectOptiset_300ECS.

PBX Type

Select uLaw.PCM Coding
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Step 4 Select Apply Changes.
Step 5 On the Configure menu, select Gateway.
Step 6 On the Gateway page, select the Gateway Routing tab.
Step 7 On the Gateway Routing tab, Unity Connection without a cluster, skip to Step 8. If Unity Connection has a cluster

configured, do the following substeps:
a) In the Fault Tolerance Enabled field, select Yes.
b) In the Load Balancing Enabled field, select No.

Step 8 Under VoIP Endpoint ID, enter the following settings.

To add endpoints, select Add New Endpoint.Note

Table 505: Gateway Routing Tab Settings

VoIP Endpoint IDCount

(Unity Connection without a cluster)Enter the server name
of the Unity Connection server.

(Unity Connection with a cluster configured) Enter the
server name of the subscriber Unity Connection server.

1

(Unity Connection without a cluster)Enter the server name
of the Unity Connection server.

(Unity Connection with a cluster configured) Enter the
server name of the publisher server.

2

Step 9 Select Apply Changes.
Step 10 Select the Gateway Advanced tab.
Step 11 On the Gateway Advanced tab, enter the following settings.

Table 506: Gateway Advanced Tab Settings

SettingsField

Select OnAnswer.Call Connect Mode

Enter the extension of an attendant who receives calls to
Cisco Unity Connection that are unanswered.

Destination for Unroutable PBX Calls

Enter 500.Minimum Call Party Delay (msecs)

For Siemens Hicom 300 E (North American) phone
systems, enter Enter #*1. Otherwise, leave this field blank.

Turn MWI On FAC

For Siemens Hicom 300 ECS phone systems, enter Enter
#*8. Otherwise, leave this field blank.

Turn MWI Off FAC

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension
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SettingsField

Select the preferred codec for audio compression:

• G.711

• G.729AB

Audio Compression

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Enter 104 (equivalent to DSCP AF31).Call Control QOS Byte

Enter 184 (equivalent to DSCP EF).RTP QOS Byte

Step 12 Select Apply Changes.
Step 13 Select the Gateway Capabilities tab.
Step 14 Depending on how you have planned to use the voice messaging ports, select the applicable setting for each port in the

Telephony Port Capability column.

Table 507: Gateway Capabilities Tab Settings

Voice Messaging Port UsageTelephony Port Capability Settings

The port answers incoming calls only and cannot dial out
(for example, to set MWIs or send message notifications).

Calls-Only

The port dial out only (for example, to set MWIs or send
message notifications) and cannot answer incoming calls.

MWIs-Only

The port answers incoming calls and also dial out (for
example, to set MWIs or send message notifications).

Both

In setting up the PIMG unit, do not send calls to ports in Unity Connection that cannot answer calls (voice messaging
ports that are not set to Answer Calls). For example, if a voice messaging port is set only to Send MWI Requests, do
not send calls to it. Otherwise the integration cannot function correctly.
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If a port in Unity Connection is disabled, select No in the Telephony Port Enabled column for the corresponding port
on this tab. Note that changing a setting in the Telephony Port Enabled column requires restarting the PIMG unit.

Step 15 Select Apply Changes.
Step 16 On the Configure menu, select SIP.
Step 17 On the SIP page, enter the following settings.

Table 508: SIP Page Settings

SettingField

Enter the domain name of the PIMG unit.Host and Domain Name

Enter 5060.Server Port

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Enter 400.T1 Time

Enter 3000.T2 Time

Step 18 Select Apply Changes.
Step 19 On the Configure menu, select IP.
Step 20 On the IP page, enter the following settings.

Table 509: IP Page Settings

SettingField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

Step 21 Select Apply Changes.
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Step 22 On the Configure menu, select Tones.
Step 23 On the Tones page, select the Learn tab.

Destination addresses cannot be duplicated in the same session. Otherwise, the process for learning tones cannot succeed.
If you do not have enough available phones to learn all the tones at one time, you can run multiple sessions to learn
tones individually by checking or unchecking the applicable Acquire Tone check boxes.

Step 24 On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and leave the Destination
Address field blank.

Step 25 On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and do the following
substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.

Step 26 On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed in Step 25c.
from the third phone.

Step 27 On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is checked and do the
following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 28 On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that you dialed in
Step 27a.

Step 29 On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked and do the
following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 30 On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you dialed in Step 29a.
Step 31 Select Learn.

When running learn tones, the PIMG unit restarts after learning the first tone.Note

Step 32 When the process is complete, check the check box for each newly learned tone and select Apply.
Step 33 Hang up the phones that you used in Step 25.
Step 34 On the Configure menu, select Restart.
Step 35 On the Restart page, select Restart Unit Now.
Step 36 When the PIMG unit has restarted, in the View menu, select Refresh.
Step 37 Repeat Step 1 through Step 36 on all remaining PIMG units.
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Analog PIMG Settings for DTMF Integration (Firmware Version 5.x)
Do the following steps to set up the analog PIMG units for a DTMF integration

SUMMARY STEPS

1. On a Windows workstation, sign in to a PIMG unit.
2. On the Configure menu, select System.
3. On the System page, enter the following settings.
4. Select Apply Changes.
5. On the Configure menu, select Gateway.
6. On the Gateway page, select the Gateway Routing tab.
7. On the Gateway Routing tab, Unity Connection without a cluster, skip to Step 8. If Unity Connection

has a cluster configured, do the following substeps:
8. Under VoIP Endpoint ID, enter the following settings.
9. Select Apply Changes.
10. Select the Gateway Advanced tab.
11. On the Gateway Advanced tab, enter the following settings.
12. Select Apply Changes.
13. Select the Gateway Capabilities tab.
14. Depending on how you have planned to use the voice messaging ports, select the applicable setting for

each port in the Telephony Port Capability column.
15. Select Apply Changes.
16. On the Configure menu, select SIP.
17. On the SIP page, enter the following settings.
18. Select Apply Changes.
19. On the Configure menu, select IP.
20. On the IP page, enter the following settings.
21. Select Apply Changes.
22. On the Configure menu, select Tones.
23. On the Tones page, select the Learn tab.
24. On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and

leave the Destination Address field blank.
25. On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and

do the following substeps to verify that the tone is correct.
26. On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed

in Step 25c. from the third phone.
27. On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is

checked and do the following substeps to verify that the tone is correct.
28. On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that

you dialed in Step 27a.
29. On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked

and do the following substeps to verify that the tone is correct.
30. On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you

dialed in Step 29a.
31. Select Learn.
32. When the process is complete, check the check box for each newly learned tone and select Apply.
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33. Hang up the phones that you used in Step 25.
34. On the Configure menu, select Restart.
35. On the Restart page, select Restart Unit Now.
36. When the PIMG unit has restarted, in the View menu, select Refresh.
37. Repeat Step 1 through Step 36 on all remaining PIMG units.

DETAILED STEPS

Step 1 On a Windows workstation, sign in to a PIMG unit.
Step 2 On the Configure menu, select System.
Step 3 On the System page, enter the following settings.

Table 510: System Page Settings

SettingsField

Select SIP.Operating Mode

Select None.PBX Type

Select uLaw.PCM Coding

Step 4 Select Apply Changes.
Step 5 On the Configure menu, select Gateway.
Step 6 On the Gateway page, select the Gateway Routing tab.
Step 7 On the Gateway Routing tab, Unity Connection without a cluster, skip to Step 8. If Unity Connection has a cluster

configured, do the following substeps:
a) In the Fault Tolerance Enabled field, select Yes.
b) In the Load Balancing Enabled field, select No.

Step 8 Under VoIP Endpoint ID, enter the following settings.

To add endpoints, select Add New Endpoint.Note

Table 511: Gateway Routing Tab Settings

VoIP Endpoint IDCount

(Unity Connection without a cluster)Enter the server name
of the Unity Connection server.

(Unity Connection with a cluster configured) Enter the
server name of the subscriber server.

1

(Unity Connection without a cluster)Enter the server name
of the Unity Connection server.

(Unity Connection with a cluster configured) Enter the
server name of the publisher server.

2

PIMG Integration Guide for Cisco Unity Connection Release 12.X
440

Settings for PIMG Firmware Version 5.x
Settings for PIMG Firmware Version 5.x



Step 9 Select Apply Changes.
Step 10 Select the Gateway Advanced tab.
Step 11 On the Gateway Advanced tab, enter the following settings.

Table 512: Gateway Advanced Tab Settings

SettingsField

Select OnAnswer.Call Connect Mode

Leave this field blank.Destination for Unroutable IP Calls

Leave this field blank.Destination for Unroutable PBX Calls

Select No.Monitor Call Connections

Enter 500.Minimum Call Party Delay (msecs)

Enter 2000.Maximum Call Party Delay (msecs)

Enter 100.Dial Digit on Time (msecs)

Enter 100.Dial Inter-Digit Time (msecs)

Enter 2000.Dial Pause Time (msecs)

Enter the code that turns MWIs on.Turn MWI On FAC

Enter the code that turns MWIs off.Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (msecs)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Select the preferred codec for audio compression:

• G.711

• G.729AB

Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size
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SettingsField

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Enter 104 (equivalent to DSCP AF31).Call Control QOS Byte

Enter 184 (equivalent to DSCP EF).RTP QOS Byte

Select No.SNMP Traps Enabled

Select No.E-mail Alarms Enabled

Step 12 Select Apply Changes.
Step 13 Select the Gateway Capabilities tab.
Step 14 Depending on how you have planned to use the voice messaging ports, select the applicable setting for each port in the

Telephony Port Capability column.

Table 513: Gateway Capabilities Tab Settings

Voice Messaging Port UsageTelephony Port Capability Settings

The port answers incoming calls only and cannot dial out
(for example, to set MWIs or send message notifications).

Calls-Only

The port dial out only (for example, to set MWIs or send
message notifications) and cannot answer incoming calls.

MWIs-Only

The port answers incoming calls and also dial out (for
example, to set MWIs or send message notifications).

Both

In setting up the PIMG unit, do not send calls to ports in Unity Connection that cannot answer calls (voice messaging
ports that are not set to Answer Calls). For example, if a voice messaging port is set only to Send MWI Requests, do
not send calls to it. Otherwise the integration cannot function correctly.

If a port in Unity Connection is disabled, select No in the Telephony Port Enabled column for the corresponding port
on this tab. Note that changing a setting in the Telephony Port Enabled column requires restarting the PIMG unit.

Step 15 Select Apply Changes.
Step 16 On the Configure menu, select SIP.
Step 17 On the SIP page, enter the following settings.

Table 514: SIP Page Settings

SettingsField

Enter the domain name of the PIMG unit.Host and Domain Name
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SettingsField

Enter 5060.Server Port

Select UDP.Transport Type

Select No.Call as Domain Name

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Enter 400.T1 Time (msecs)

Enter 3000.T2 Time (msecs)

Enter 120.Invite Expiration (sec)

Step 18 Select Apply Changes.
Step 19 On the Configure menu, select IP.
Step 20 On the IP page, enter the following settings.

Table 515: IP Page Settings

SettingsField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

Step 21 Select Apply Changes.
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Step 22 On the Configure menu, select Tones.
Step 23 On the Tones page, select the Learn tab.

Destination addresses cannot be duplicated in the same session. Otherwise, the process for learning tones cannot succeed.
If you do not have enough available phones to learn all the tones at one time, you can run multiple sessions to learn
tones individually by checking or unchecking the applicable Acquire Tone check boxes.

Step 24 On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and leave the Destination
Address field blank.

Step 25 On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and do the following
substeps to verify that the tone is correct.
a) From an available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.

Step 26 On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed in Step 25c.
from the third phone.

Step 27 On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is checked and do the
following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 28 On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that you dialed in
Step 27a.

Step 29 On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked and do the
following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 30 On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you dialed in Step 29a.
Step 31 Select Learn.

When running learn tones, the PIMG unit restarts after learning the first tone.Note

Step 32 When the process is complete, check the check box for each newly learned tone and select Apply.
Step 33 Hang up the phones that you used in Step 25.
Step 34 On the Configure menu, select Restart.
Step 35 On the Restart page, select Restart Unit Now.
Step 36 When the PIMG unit has restarted, in the View menu, select Refresh.
Step 37 Repeat Step 1 through Step 36 on all remaining PIMG units.
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Analog PIMG Settings for Serial Integration (Firmware Version 5.x)
Do the following steps to set up the analog PIMG units for a Serial integration

SUMMARY STEPS

1. On a Windows workstation, sign in to a PIMG unit.
2. On the Configure menu, select System.
3. On the System page, enter the following settings.
4. Select Apply Changes.
5. On the Configure menu, select Gateway.
6. On the Gateway page, select the Gateway Routing tab.
7. On the Gateway Routing tab, Unity Connection without a cluster, skip to Step 8. If Unity Connection

has a cluster configured, do the following substeps:
8. Under VoIP Endpoint ID, enter the following settings.
9. Select Apply Changes.
10. Select the Gateway Advanced tab.
11. On the Gateway Advanced tab, enter the following settings.
12. Select Apply Changes.
13. Select the Gateway Capabilities tab.
14. Depending on how you have planned to use the voice messaging ports, select the applicable setting for

each port in the Telephony Port Capability column.
15. Select Apply Changes.
16. On the Configure menu, select Serial Protocol.
17. On the Serial Protocol page, enter the following settings.
18. Select Apply Changes.
19. On the Configure menu, select SIP.
20. On the SIP page, enter the following settings.
21. Select Apply Changes.
22. On the Configure menu, select IP.
23. On the IP page, enter the following settings.
24. Select Apply Changes.
25. On the Configure menu, select Tones.
26. On the Tones page, select the Learn tab.
27. On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and

leave the Destination Address field blank.
28. On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and

do the following substeps to verify that the tone is correct.
29. On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed

in Step 28c. from the third phone.
30. On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is

checked and do the following substeps to verify that the tone is correct.
31. On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that

you dialed in Step 30a.
32. On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked

and do the following substeps to verify that the tone is correct.
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33. On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you
dialed in Step 32a.

34. Select Learn.
35. When the process is complete, check the check box for each newly learned tone and select Apply.
36. Hang up the phones that you used in Step 28.
37. On the Configure menu, select Restart.
38. On the Restart page, select Restart Unit Now.
39. When the PIMG unit has restarted, in the View menu, select Refresh.
40. Repeat Step 1 through Step 39 on all remaining PIMG units.

DETAILED STEPS

Step 1 On a Windows workstation, sign in to a PIMG unit.
Step 2 On the Configure menu, select System.
Step 3 On the System page, enter the following settings.

Table 516: System Page Settings

SettingField

Select SIP.Operating Mode

Select uLaw.PCM Coding

Select the setting that is configured on the phone system.

The default setting is 9600.

Serial Port Baud Rate

Select the setting that is configured on the phone system.

The default setting is None.

Serial Port Parity

Select the setting that is configured on the phone system.

The default setting is 8.

Serial Port Data Bits

Select the setting that is configured on the phone system.

The default setting is 1.

Serial Port Stop Bits

Step 4 Select Apply Changes.
Step 5 On the Configure menu, select Gateway.
Step 6 On the Gateway page, select the Gateway Routing tab.
Step 7 On the Gateway Routing tab, Unity Connection without a cluster, skip to Step 8. If Unity Connection has a cluster

configured, do the following substeps:
a) In the Fault Tolerance Enabled field, select Yes.
b) In the Load Balancing Enabled field, select No.

Step 8 Under VoIP Endpoint ID, enter the following settings.

To add endpoints, select Add New Endpoint.Note
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Table 517: Gateway Routing Tab Settings

VoIP Endpoint IDCount

(Unity Connection without a cluster)Enter the server name
of the Unity Connection server.

(Unity Connection with a cluster configured) Enter the
server name of the subscriber server.

1

(Unity Connection without a cluster)Enter the server name
of the Unity Connection server.

(Unity Connection with a cluster configured) Enter the
server name of the publisher server.

2

Step 9 Select Apply Changes.
Step 10 Select the Gateway Advanced tab.
Step 11 On the Gateway Advanced tab, enter the following settings.

Table 518: Gateway Advanced Tab Settings

SettingsField

Advanced Call Routing

Select OnAnswer.Call Connect Mode

Leave this field blank.Destination for Unroutable IP Calls

Leave this field blank.Destination for Unroutable PBX Calls

Select No.Monitor Call Connections

Telephony

Enter 500.Minimum Call Party Delay

Enter 2000.Maximum Call Party Delay

Enter 100.Dial Digit on Time

Enter 100.Dial Inter-Digit Time

Enter 2000.Dial Pause Time

Leave this field blank.Turn MWI On FAC

Leave this field blank.Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension
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SettingsField

Audio

Select the preferred codec for audio compression:

• G.711

• G.729AB

Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Quality of Service

Enter 104 (equivalent to DSCP AF31).Call Control QOS Byte

Enter 184 (equivalent to DSCP EF).RTP QOS Byte

Traps and Alarms

Select No.E-mail Alarms Enabled

Select No.SNMP Traps Enabled

Step 12 Select Apply Changes.
Step 13 Select the Gateway Capabilities tab.
Step 14 Depending on how you have planned to use the voice messaging ports, select the applicable setting for each port in the

Telephony Port Capability column.
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Table 519: Gateway Capabilities Tab Settings

Voice Messaging Port UsageTelephony Port Capability Settings

The port answers incoming calls only and cannot dial out
(for example, to set MWIs or send message notifications).

Calls-Only

The port dial out only (for example, to set MWIs or send
message notifications) and cannot answer incoming calls.

MWIs-Only

The port answers incoming calls and also dial out (for
example, to set MWIs or send message notifications).

Both

In setting up the PIMG unit, do not send calls to ports in Unity Connection that cannot answer calls (voice messaging
ports that are not set to Answer Calls). For example, if a voice messaging port is set only to Send MWI Requests, do
not send calls to it. Otherwise the integration cannot function correctly.

If a port in Unity Connection is disabled, select No in the Telephony Port Enabled column for the corresponding port
on this tab. Note that changing a setting in the Telephony Port Enabled column requires restarting the PIMG unit.

Step 15 Select Apply Changes.
Step 16 On the Configure menu, select Serial Protocol.
Step 17 On the Serial Protocol page, enter the following settings.

Table 520: Serial Protocol Page Settings

SettingField

Select the applicable setting:

• Master—Select this setting when this PIMG unit is
connected to the data link serial cable from the phone
system. There can be only one master PIMG unit in
a phone system integration.

• Slave—Select this setting when this PIMG unit is not
connected to the data link serial cable from the phone
system. There can be multiple slave PIMG units in a
phone system integration.

Serial Mode

Select the serial protocol that your phone system uses:

• SMDI

• MCI

• MD-110

Serial Interface Protocol

Select the applicable setting. Typically, the settings are 7
or 10.

Cpid Len
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SettingField

Enter the applicable string or leave this field blank.
Typically, the setting is one of the following:

• A string of zeros, where the number of zeros matches
the setting of the Cpid Len field.

• A prefix that is provided by the Centrex service.

Cpid Padding String

If the setting of the Serial Interface Protocol field is
MD-110, enter 2. Otherwise, accept the default of 7.

Voice Mail Port Len

Enter the applicable setting. Typically, the setting is 1.System Number

Enter 2000.MWI Response Timeout

If the PIMG unit is the master, leave this field blank.

If the PIMG unit is a slave, enter the IP address of the
master PIMG unit (the PIMG unit that is connected to the
data link serial cable from the phone system).

IP Address of Serial Server

Enter 2000.Serial Cpid Expiration

If the setting of the Serial Interface Protocol field is MCI
or MD-110, enter the extension number for each port on
the PIMG unit.

If the setting of the Serial Interface Protocol field is SMDI,
enter the logical port number. Typically, the setting is 1
for port 1, 2 for port 2, and so on beginning with the master
PIMG unit and continuing through each of the slave PIMG
units.

Logical Extension Number

Step 18 Select Apply Changes.
Step 19 On the Configure menu, select SIP.
Step 20 On the SIP page, enter the following settings.

Table 521: SIP Page Settings

SettingField

Enter the domain name of the PIMG unit.

This setting must match the name of the port group in
Cisco Unity Connection Administration that has the voice
messaging ports connecting to the PIMG unit.

Host and Domain Name

Enter 5060.Server Port

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port
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SettingField

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Enter 400.T1 Time

Enter 3000.T2 Time

Step 21 Select Apply Changes.
Step 22 On the Configure menu, select IP.
Step 23 On the IP page, enter the following settings.

Table 522: IP Page Settings

SettingField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

Step 24 Select Apply Changes.
Step 25 On the Configure menu, select Tones.
Step 26 On the Tones page, select the Learn tab.

Destination addresses cannot be duplicated in the same session. Otherwise, the process for learning tones do not succeed.
If you do not have enough available phones to learn all the tones at one time, you can run multiple sessions to learn
tones individually by checking or unchecking the applicable Acquire Tone check boxes.

Step 27 On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and leave the Destination
Address field blank.

Step 28 On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and do the following
substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.
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Step 29 On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed in Step 28c.
from the third phone.

Step 30 On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is checked and do the
following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 31 On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that you dialed in
Step 30a.

Step 32 On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked and do the
following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist.
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 33 On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you dialed in Step 32a.
Step 34 Select Learn.

When running learn tones, the PIMG unit restarts after learning the first tone.Note

Step 35 When the process is complete, check the check box for each newly learned tone and select Apply.
Step 36 Hang up the phones that you used in Step 28.
Step 37 On the Configure menu, select Restart.
Step 38 On the Restart page, select Restart Unit Now.
Step 39 When the PIMG unit has restarted, in the View menu, select Refresh.
Step 40 Repeat Step 1 through Step 39 on all remaining PIMG units.

Digital Mitel PIMG Settings (Firmware Version 5.x)
Do the following steps to set up the digital Mitel PIMG units

SUMMARY STEPS

1. On a Windows workstation, sign in to a PIMG unit.
2. On the Configure menu, select System.
3. On the System page, enter the following settings.
4. Select Apply Changes.
5. On the Configure menu, select Gateway.
6. On the Gateway page, select the Gateway Routing tab.
7. On the Gateway Routing tab, Unity Connection without a cluster, skip to Step 8. If Unity Connection

has a cluster configured, do the following substeps:
8. Under VoIP Endpoint ID, enter the following settings.
9. Select Apply Changes.
10. Select the Gateway Advanced tab.
11. On the Gateway Advanced tab, enter the following settings.
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12. Select Apply Changes.
13. Select the Gateway Capabilities tab.
14. Depending on how you have planned to use the voice messaging ports, select the applicable setting for

each port in the Telephony Port Capability column.
15. Select Apply Changes.
16. On the Configure menu, select SIP.
17. On the SIP page, enter the following settings.
18. Select Apply Changes.
19. On the Configure menu, select IP.
20. On the IP page, enter the following settings.
21. Select Apply Changes.
22. On the Configure menu, select Tones.
23. On the Tones page, select the Learn tab.
24. On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and

leave the Destination Address field blank.
25. On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and

do the following substeps to verify that the tone is correct.
26. On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed

in Step 25c. from the third phone.
27. On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is

checked and do the following substeps to verify that the tone is correct.
28. On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that

you dialed in Step 27a.
29. On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked

and do the following substeps to verify that the tone is correct.
30. On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you

dialed in Step 29a.
31. Select Learn.
32. When the process is complete, check the check box for each newly learned tone and select Apply.
33. Hang up the phones that you used in Step 25.
34. On the Configure menu, select Restart.
35. On the Restart page, select Restart Unit Now.
36. When the PIMG unit has restarted, in the View menu, select Refresh.
37. Repeat Step 1 through Step 36 on all remaining PIMG units.

DETAILED STEPS

Step 1 On a Windows workstation, sign in to a PIMG unit.
Step 2 On the Configure menu, select System.
Step 3 On the System page, enter the following settings.

Table 523: System Page Settings

SettingField

Select SIP.Operating Mode
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SettingField

(This setting does not apply.)PBX Type

Select uLaw.PCM Coding

Step 4 Select Apply Changes.
Step 5 On the Configure menu, select Gateway.
Step 6 On the Gateway page, select the Gateway Routing tab.
Step 7 On the Gateway Routing tab, Unity Connection without a cluster, skip to Step 8. If Unity Connection has a cluster

configured, do the following substeps:
a) In the Fault Tolerance Enabled field, select Yes.
b) In the Load Balancing Enabled field, select No.

Step 8 Under VoIP Endpoint ID, enter the following settings.

To add endpoints, select Add New Endpoint.Note

Table 524: Gateway Routing Tab Settings

VoIP Endpoint IDCount

(Unity Connection without a cluster)Enter the server name
of the Unity Connection server.

(Unity Connection with a cluster configured) Enter the
server name of the subscriber server.

1

(Unity Connection without a cluster)Enter the server name
of the Unity Connection server.

(Unity Connection with a cluster configured) Enter the
server name of the publisher server.

2

Step 9 Select Apply Changes.
Step 10 Select the Gateway Advanced tab.
Step 11 On the Gateway Advanced tab, enter the following settings.

Table 525: Gateway Advanced Tab Settings

SettingsField

Select OnAnswer.Call Connect Mode

Enter the extension of an attendant who receive calls to
Unity Connection that are unanswered.

Destination for Unroutable PBX Calls

Enter 500.Minimum Call Party Delay (msecs)

Enter the code that turns MWIs on.Turn MWI On FAC

Enter the code that turns MWIs off.Turn MWI Off FAC
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SettingsField

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Select the preferred codec for audio compression:

• G.711

• G.729AB

Audio Compression

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Enter 104 (equivalent to DSCP AF31).Call Control QOS Byte

Enter 184 (equivalent to DSCP EF).RTP QOS Byte

Step 12 Select Apply Changes.
Step 13 Select the Gateway Capabilities tab.
Step 14 Depending on how you have planned to use the voice messaging ports, select the applicable setting for each port in the

Telephony Port Capability column.

Table 526: Gateway Capabilities Tab Settings

Voice Messaging Port UsageTelephony Port Capability Settings

The port answer incoming calls only and cannot dial out
(for example, to set MWIs or send message notifications).

Calls-Only

The port dial out only (for example, to set MWIs or send
message notifications) and cannot answer incoming calls.

MWIs-Only
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Voice Messaging Port UsageTelephony Port Capability Settings

The port answers incoming calls and also dial out (for
example, to set MWIs or send message notifications).

Both

In setting up the PIMG unit, do not send calls to ports in Unity Connection that cannot answer calls (voice messaging
ports that are not set to Answer Calls). For example, if a voice messaging port is set only to Send MWI Requests, do
not send calls to it. Otherwise the integration cannot function correctly.

If a port in Unity Connection is disabled, select No in the Telephony Port Enabled column for the corresponding port
on this tab. Note that changing a setting in the Telephony Port Enabled column requires restarting the PIMG unit.

Step 15 Select Apply Changes.
Step 16 On the Configure menu, select SIP.
Step 17 On the SIP page, enter the following settings.

Table 527: SIP Page Settings

SettingField

Enter the domain name of the PIMG unit.Host and Domain Name

Enter 5060.Server Port

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Enter 400.T1 Time

Enter 3000.T2 Time

Step 18 Select Apply Changes.
Step 19 On the Configure menu, select IP.
Step 20 On the IP page, enter the following settings.

Table 528: IP Page Settings

SettingField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address
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SettingField

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

Step 21 Select Apply Changes.
Step 22 On the Configure menu, select Tones.
Step 23 On the Tones page, select the Learn tab.

Destination addresses cannot be duplicated in the same session. Otherwise, the process for learning tones cannot succeed.
If you do not have enough available phones to learn all the tones at one time, you can run multiple sessions to learn
tones individually by checking or unchecking the applicable Acquire Tone check boxes.

Step 24 On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and leave the Destination
Address field blank.

Step 25 On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and do the following
substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.

Step 26 On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed in Step 25c.
from the third phone.

Step 27 On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is checked and do the
following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 28 On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that you dialed in
Step 27a.

Step 29 On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked and do the
following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist.
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 30 On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you dialed in Step 29a.
Step 31 Select Learn.

When running learn tones, the PIMG unit restarts after learning the first tone.Note

Step 32 When the process is complete, check the check box for each newly learned tone and select Apply.
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Step 33 Hang up the phones that you used in Step 25.
Step 34 On the Configure menu, select Restart.
Step 35 On the Restart page, select Restart Unit Now.
Step 36 When the PIMG unit has restarted, in the View menu, select Refresh.
Step 37 Repeat Step 1 through Step 36 on all remaining PIMG units.

Digital Rolm PIMG Settings (Firmware Version 5.x)
Do the following steps to set up the digital Rolm PIMG units

SUMMARY STEPS

1. On a Windows workstation, sign in to a PIMG unit.
2. On the Configure menu, select System.
3. On the System page, enter the following settings.
4. Select Apply Changes.
5. On the Configure menu, select Gateway.
6. On the Gateway page, select the Gateway Routing tab.
7. On the Gateway Routing tab, Unity Connection without a cluster, skip to Step 8. If Unity Connection

has a cluster configured, do the following substeps:
8. Under VoIP Endpoint ID, enter the following settings.
9. Select Apply Changes.
10. Select the Gateway Advanced tab.
11. On the Gateway Advanced tab, enter the following settings.
12. Select Apply Changes.
13. Select the Gateway Capabilities tab.
14. Depending on how you have planned to use the voice messaging ports, select the applicable setting for

each port in the Telephony Port Capability column.
15. Select Apply Changes.
16. On the Configure menu, select SIP.
17. On the SIP page, enter the following settings.
18. Select Apply Changes.
19. On the Configure menu, select IP.
20. On the IP page, enter the following settings.
21. Select Apply Changes.
22. On the Configure menu, select Tones.
23. On the Tones page, select the Learn tab.
24. On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and

leave the Destination Address field blank.
25. On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and

do the following substeps to verify that the tone is correct.
26. On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed

in Step 25c. from the third phone.
27. On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is

checked and do the following substeps to verify that the tone is correct.
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28. On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that
you dialed in Step 27a.

29. On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked
and do the following substeps to verify that the tone is correct.

30. On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you
dialed in Step 29a.

31. Select Learn.
32. When the process is complete, check the check box for each newly learned tone and select Apply.
33. Hang up the phones that you used in Step 25.
34. On the Configure menu, select Restart.
35. On the Restart page, select Restart Unit Now.
36. When the PIMG unit has restarted, in the View menu, select Refresh.
37. Repeat Step 1 through Step 36 on all remaining PIMG units.

DETAILED STEPS

Step 1 On a Windows workstation, sign in to a PIMG unit.
Step 2 On the Configure menu, select System.
Step 3 On the System page, enter the following settings.

Table 529: System Page Settings

SettingField

Select SIP.Operating Mode

Depending on your phone system, select one of the
following:

• Rolm_9751_SW9005

• Rolm_9751_SW9006

PBX Type

Select uLaw.PCM Coding

Step 4 Select Apply Changes.
Step 5 On the Configure menu, select Gateway.
Step 6 On the Gateway page, select the Gateway Routing tab.
Step 7 On the Gateway Routing tab, Unity Connection without a cluster, skip to Step 8. If Unity Connection has a cluster

configured, do the following substeps:
a) In the Fault Tolerance Enabled field, select Yes.
b) In the Load Balancing Enabled field, select No.

Step 8 Under VoIP Endpoint ID, enter the following settings.

To add endpoints, select Add New Endpoint.Note
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Table 530: Gateway Routing Tab Settings

VoIP Endpoint IDCount

(Unity Connection without a cluster)Enter the server name
of the Unity Connection server.

(Unity Connection with a cluster configured) Enter the
server name of the subscriber server.

1

(Unity Connection without a cluster)Enter the server name
of the Unity Connection server.

(Unity Connection with a cluster configured) Enter the
server name of the publisher server.

2

Step 9 Select Apply Changes.
Step 10 Select the Gateway Advanced tab.
Step 11 On the Gateway Advanced tab, enter the following settings.

Table 531: Gateway Advanced Tab Settings

SettingsField

Select OnAnswer.Call Connect Mode

Enter the extension of an attendant who receives calls to
Unity Connection that are unanswered.

Destination for Unroutable PBX Calls

Enter 500.Minimum Call Party Delay (msecs)

Leave this field blank.Turn MWI On FAC

Leave this field blank.Turn MWI Off FAC

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Select the preferred codec for audio compression:

• G.711

• G.729AB

Audio Compression

Select Off.Signaling Digit Relay Mode

Select Off.Voice Activity Detection
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SettingsField

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in recorded
messages containing nothing but silence.

Frames Per Packet

Enter 104 (equivalent to DSCP AF31).Call Control QOS Byte

Enter 184 (equivalent to DSCP EF).RTP QOS Byte

Step 12 Select Apply Changes.
Step 13 Select the Gateway Capabilities tab.
Step 14 Depending on how you have planned to use the voice messaging ports, select the applicable setting for each port in the

Telephony Port Capability column.

Table 532: Gateway Capabilities Tab Settings

Voice Messaging Port UsageTelephony Port Capability Settings

The port answers incoming calls only and cannot dial out
(for example, to set MWIs or send message notifications).

Calls-Only

The port dial out only (for example, to set MWIs or send
message notifications) and cannot answer incoming calls.

MWIs-Only

The port answers incoming calls and also dial out (for
example, to set MWIs or send message notifications).

Both

In setting up the PIMG unit, do not send calls to ports in Unity Connection that cannot answer calls (voice messaging
ports that are not set to Answer Calls). For example, if a voice messaging port is set only to Send MWI Requests, do
not send calls to it. Otherwise the integration cannot function correctly.

If a port in Unity Connection is disabled, select No in the Telephony Port Enabled column for the corresponding port
on this tab. Note that changing a setting in the Telephony Port Enabled column requires restarting the PIMG unit.

Step 15 Select Apply Changes.
Step 16 On the Configure menu, select SIP.
Step 17 On the SIP page, enter the following settings.
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Table 533: SIP Page Settings

SettingField

Enter the domain name of the PIMG unit.Host and Domain Name

Enter 5060.Server Port

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Enter 400.T1 Time

Enter 3000.T2 Time

Step 18 Select Apply Changes.
Step 19 On the Configure menu, select IP.
Step 20 On the IP page, enter the following settings.

Table 534: IP Page Settings

SettingField

Enter the new IP address you want to use for the PIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the PIMG units use.

Default Network Gateway Address

Select No.BOOTP Enabled

Step 21 Select Apply Changes.
Step 22 On the Configure menu, select Tones.
Step 23 On the Tones page, select the Learn tab.

Destination addresses cannot be duplicated in the same session. Otherwise, the process for learning tones cannot succeed.
If you do not have enough available phones to learn all the tones at one time, you can run multiple sessions to learn
tones individually by checking or unchecking the applicable Acquire Tone check boxes.
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Step 24 On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and leave the Destination
Address field blank.

Step 25 On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and do the following
substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.

Step 26 On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed in Step 25c.
from the third phone.

Step 27 On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is checked and do the
following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 28 On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that you dialed in
Step 27a.

Step 29 On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked and do the
following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist.
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 30 On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you dialed in Step 29a.
Step 31 Select Learn.

When running learn tones, the PIMG unit restarts after learning the first tone.Note

Step 32 When the process is complete, check the check box for each newly learned tone and select Apply.
Step 33 Hang up the phones that you used in Step 25.
Step 34 On the Configure menu, select Restart.
Step 35 On the Restart page, select Restart Unit Now.
Step 36 When the PIMG unit has restarted, in the View menu, select Refresh.
Step 37 Repeat Step 1 through Step 36 on all remaining PIMG units.
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